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Walk-Through Examples
The AFT Impulse Walk-Through Examples are designed to get new users trained to use AFT Impulse 
correctly in the shortest amount of time. If you are using AFT Impulse for the first time, start with the 
Beginner - Valve Closure example because it offers an in-depth explanation of how to use AFT Impulse. 
Otherwise, choose an example from the table below that you wish to learn more about. For examples 
using the AFT Impulse Add-on Modules, see the AFT Impulse Modules Overview.

Completed versions of the example model files are included with the default installation: C:\AFT Product-
s\AFT Impulse 10\Examples

Example Fluid Pipes Pumps Description

Beginner - Valve Closure Water 4 -
In-depth discussion of model build-
ing in AFT Impulse. Solves a simple 
valve closure problem.

Ammonia Transfer with 
Cavitation Ammonia 3 -

Three valve closure rates on a fluid 
transfer system are evaluated with 
respect to maximum pressure. Cavit-
ation occurs in two cases.

Tank Farm with Infinite 
Pipes Gasoline 5 -

A long supply pipeline flows into a 
gasoline tank farm. The transient 
occurs when flow is switched from 
one storage tank to another. Two 
scenarios compare the results with 
and without an infinite pipe bound-
ary, and also compares the run 
times.

Pump Trip With Check 
Valve Water 2 1

A system pumping water uphill loses 
power to the pump. This model pre-
dicts the system response and pump 
speed decay.

Check Valve Modeling Water 3 1

A check valve needs to be selected 
to prevent reverse flow trough a 
pump in the case of a power failure. 
Different check valve modeling 
options are explored.

Relief Valve Modeling Crude Oil 6 1

A relief valve is considered to reduce 
pressure in a pipeline after an 
unplanned valve closure and pump 
trip. A back pressure relief valve and 
a rupture disk relief valve are com-
pared.

Pump Trip With Accu-
mulator Water 3 1

Same system as Pump Trip With 
Check Valve, except an accumulator 
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Example Fluid Pipes Pumps Description

is used to minimize the downsurge 
due to the pump trip to keep all pres-
sures above atmospheric.

Pump Startup With Event 
Transients Water 11 2

Transients from different pump star-
tup scenarios are evaluated. A valve 
opening transient is initiated based 
on system events.

Pump Trip With Four 
Quadrant Modeling Water 13 2

Two pumps supplying cooling 
towers lose power. Valves close, but 
not before the pumps start to spin 
backwards. Four-quadrant pump 
modeling is used to evaluate the 
pump reaction and system tran-
sients.

Selecting a Pump Four 
Quadrant Curve Water 9 1

Provides the engineer with a deeper 
understanding of how to select four 
quadrant data sets for a water-
hammer analysis, and how to eval-
uate the transient results predicted 
by the four quadrant curves.

Pump With Variable 
Speed Flow Control Water 8 1

A pump with a variable speed drive 
for flow control supplies water to two 
heat exchangers. The flow to one of 
the exchangers is turned off, and the 
controlled pump flow rate is reduced 
by half over five seconds.

Positive Displacement 
Pump Water 5 1 Models of a duplex and triplex pos-

itive displacement pump

Pipe Forces from Valve 
Closure Water 2 -

Determines the transient forces that 
occur after a valve closure in a grav-
ity drain system that transfers water 
from one tank to another through a 
valve in the connecting pipeline. 

Beginner - Valve Closure

Summary

This example is designed to give you the big picture of AFT Impulse's layout and structure. Some of the 
more basic concepts will be used to build a four pipe, five junction model of the waterhammer transients 
that result when a valve is closed.
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Topics Covered

 l Building a basic model
 l Entering pipe and junction data
 l Entering transient data
 l Graphing output results

Required Knowledge

This example assumes the user has not used AFT Impulse previously. It begins with the most basic ele-
ments of laying out the pipes and junctions and solving the transient/waterhammer system hydraulics via 
the Method of Characteristics (MOC).

Model File

 l US - Beginner - Valve Closure.imp

 Step 1. Start AFT Impulse

ØTo start AFT Impulse, click Start on the Windows taskbar and open AFT Impulse 10. (This refers to 
the standard menu items created by setup. You may have chosen to specify a different menu item).

As Impulse is started, the Impulse Startup Window, as shown in Figure 1 appears and provides you with 
several options before you start building a model. You can open a model that was recently worked on or 
browse to a different Impulse file or the Impulse Example files. If the Impulse SSL or PFA add-on mod-
ule is owned, it can be activated here. The Unit System can also be specified to use US Only, Metric 
Only, Both with US Defaults, or Both with Metric Defaults and they can be set as the user default at this 
time as well. You can also set the working fluid to AFT Standard Water (liquid) or another recently used 
AFT fluid. You can click the link to Check for Latest Release to go to the AFT website to see if you have 
the latest release of AFT Impulse. You can also Subscribe to Receive Notifications of when product main-
tenance releases are available, receive the AFT newsletter, etc. Finally, you can select from several 
options available in our Learning Center.

Note: If you are working through the Metric Units version of the Examples, be sure to specify either 
Metric Only or Both with Metric Defaults as the unit sets and check the box to Set As My Default.
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Figure 1: AFT Impulse Startup window

Begin by clicking Start Building Model in the AFT Impulse Startup window. The Workspace window is ini-
tially be active, as seen in Figure 2. The five tabs in the AFT Impulse window represent the five primary 
windows. Each Primary Window contains its own toolbar that is displayed directly beneath the Primary 
Window tabs.

AFT Impulse supports dual monitor usage. You can click and drag any of the primary window tabs off of 
the main Impulse window. Once you drag one of the primary windows off of the Impulse window, you can 
move it anywhere you like on your screen, including onto a second monitor in a dual monitor con-
figuration. To add the primary window back to the main Impulse primary tab window bar, simply click the 
X button in the upper right of the primary window.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

The Workspace window

The Workspace window is the primary vehicle for building your model. This window has three main 
areas: the Toolbox, the Quick Access Panel, and the Workspace itself. The Toolbox is the bundle of tools 
on the far left. 

The Quick Access Panel is on the right. It is possible to minimize the Quick Access Panel by clicking on 
the thumbtack pin in the upper right of the Quick Access Panel in order to allow for greater Workspace 
area. 

The Workspace takes up the rest of the window.

Quick-Access-Panel.html
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You will build your pipe flow model on the Workspace using the Toolbox tools. At the top of the Toolbox is 
the Pipe Drawing Tool and Annotation Tool. The Pipe Drawing tool, on the upper left, is used to draw new 
pipes on the Workspace. The Annotation tool allows you to create annotations and auxiliary graphics.

Below the two drawing tools are twenty-five icons that represent the different types of junctions available 
in AFT Impulse. Junctions are objects that connect pipes and also influence the pressure or flow beha-
vior of the pipe system. The twenty-five junction icons can be dragged from the Toolbox and dropped 
onto the Workspace.

When you pass your mouse pointer over any of the Toolbox tools, a tooltip identifies the tool's function.

Figure 2: The Workspace window is where the model is built

 Step 2. Complete the Analysis Setup

ØNext, click Analysis Setup on the Toolbar that runs across the top of the AFT Impulse window. This 
opens Analysis Setup (see Figure 3). The Analysis Setup contains nine groups (an additional group will 
display if the PFA module is active). Each group needs to be completed (indicated with a green check-
mark next to the group name) before AFT Impulse allows you to run the Solver.

Analysis Setup can also be accessed by clicking on the Model Status Light on the Quick Access Panel 
found in the lower right corner. Once all of the groups in Analysis Setup are defined, the Model Status 
Light will turn from red to green.
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Figure 3: The Analysis Setup tracks the model’s status and allows users to specify required parameters

A. Define the Modules Group

The first group, Modules, will always have a green check when you start AFT Impulse because there are 
no modules activated by default. No further input is required here.

B. Define the Fluid Properties Group

Next is the Fluid Properties group. This group allows you to specify you fluid properties (density, dynamic 
viscosity, bulk modulus, and vapor pressure), viscosity model, and fluid corrections. Start by clicking on 
the Fluid item to open the Fluid panel (see Figure 4).

You can model the fluid properties in one of following ways. 

 1. AFT Standard: This fluid model accesses fluid data from the AFT Standard library. These fluid 
properties are either temperature dependent or dependent on the solids concentration. Type in 
the desired condition (e.g., temperature) and the required properties are calculated. 

 2. User Specified Fluid: This fluid model allows you to directly type in the density, viscosity, bulk 
modulus, and vapor pressure. 

 3. User Library Fluid: This fluid model allows you to select custom made fluids included in the 
user's library.

 4. Chempak Fluid: This fluid model allows you to select a single fluid or create a mixture of fluids 
from the Chempak fluid library. These fluid properties are pressure and temperature dependent, 
although some are temperature dependent only. Chempak is an optional add-on to AFT Impulse.

 5. NIST REFPROP: This fluid model allows you to select a single fluid or create a mixture of fluids 
from the REFPROP fluid library. These fluid properties are pressure and temperature dependent.
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 6. ASME Steam/Water: As its name implies, this fluid model calculates water properties from the 
built-in ASME Steam Tables. This model is pressure and temperature dependent. 

ØSelect AFT Standard, by clicking the radio button next to the name. Then choose Water (liquid) from 
the list and click Add to Model. The properties for AFT Standard water are given only as a function of tem-
perature. Enter 70 deg. F in the temperature box.

ØCheck the groups on the left side of Analysis Setup and you should now see the second group is 
checked off. 

Figure 4: The Fluid panel lets you enter physical properties

On the Viscosity Model panel, users can specify how AFT Impulse will treat viscosity. By default, New-
tonian is the viscosity model selected. AFT Impulse offers a variety of non-Newtonian models. However, 
for this example, the default selection will suffice.

On the Variable Fluids panel, users can specify constant or variable fluid properties. For models with vari-
able fluid properties, the values for density and viscosity are default fluid properties. You can then enter 
different property values, if desired, for any pipe in the Pipe Properties window. By default, Constant 
Fluid Properties is selected.

On the Laminar and Non-Newtonian Corrections panel, users can specify the type of corrections that the 
solver will apply when flow is laminar or if a non-Newtonian viscosity model is selected. The default selec-
tions are applicable for most cases, so no input is required for this example.

C. Define the Pipes and Junctions Group

In order to fully define this group, there needs to be pipes and junctions on the Workspace. To lay out the 
valve closure model, you will place the three reservoir junctions, a valve junction, and a branch junction 
on the Workspace. Then you will connect the junctions with pipes.

To go back to the Workspace and save the inputs made in Analysis Setup, click OK.
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I. Place the first reservoir

ØTo start, drag a reservoir junction from the Toolbox and drop it on the Workspace. Figure 5 shows 
the Workspace with one Reservoir.

Objects and ID numbers

Items placed on the Workspace are called objects. All objects are derived directly or indirectly from the 
Toolbox. AFT Impulse uses three types of objects: pipes, junctions, and annotations. 

All pipe and junction objects on the Workspace have an associated ID number. For junctions, this num-
ber is, by default, placed directly above the junction and prefixed with the letter J. Pipe ID numbers are 
prefixed with the letter P. You can optionally choose to display either or both the ID number and the name 
of a pipe or junction. You also can drag the ID number/name text to a different location to improve vis-
ibility.

The reservoir you placed on the Workspace will take on the default ID number of 1. You can change this 
to any desired number greater than zero and up to 99,999.

Editing on the Workspace

Once on the Workspace, junction objects can be moved to new locations and edited with the features on 
the Edit menu. Cutting, copying, and pasting are all supported. Multiple levels of undo are available for 
most editing operations.

Note: The relative location of objects in AFT Impulse is not important. Distances and heights are 
defined through dialog boxes. The relative locations on the Workspace establish the con-
nectivity of the objects, but have no bearing on the actual length or elevation relationships.
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Figure 5: Valve Closure Model with one reservoir placed

II. Place the second reservoir

The second reservoir can be created the same way as the first one or can be derived from the existing 
reservoir.

ØTo create a second reservoir from the existing one, select junction J1 by clicking it with the mouse. 
A red outline will surround the junction to show it is selected. Choose Duplicate from the Edit menu (or 
use CTRL+D on the keyboard). Your Workspace should appear similar to that shown in Figure 6.

If you like, you can undo the Duplicate operation and then redo it to see how these editing features work. 
To undo an operation, click on the undo button on the Toolbar or choose Undo from the Edit menu. To 
redo an operation, choose Redo from the Edit menu. 
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Figure 6: Valve Closure Model with two reservoirs placed

III. Place a Branch junction

ØTo add a Branch junction, select a Branch from the Toolbox and place it on the Workspace as shown 
in Figure 7. The Branch will be assigned the default number J3.
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Figure 7: Valve Closure Model with Branch placed

IV. Place a valve and a final reservoir junction

ØTo add a valve junction, click and drag a Valve junction from the Toolbox and place it on the Work-
space as shown in Figure 8. The Valve will be assigned the default number J4. Add a third Reservoir junc-
tion, number J5, also shown in Figure 8.

ØBefore continuing, save the work you have done so far. Choose Save As from the File menu and 
enter a file name (Valve Closure, perhaps) and AFT Impulse will append the .imp extension to the file 
name.
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Figure 8: Valve Closure Model with all junctions placed

V. Draw a pipe between J1 and J3

Now that you have five junctions, you need to connect them with pipes.

ØTo create a pipe, click the Pipe Drawing tool icon. The pointer will change to a crosshair when you 
move it over the Workspace. Draw a pipe above the junctions, similar to that shown in Figure 9.

The pipe object on the Workspace has an ID number (P1), shown near the center of the pipe. 
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Figure 9: Valve Closure Model with first pipe drawn

ØTo place the pipe between J1 and J3, use the mouse to grab the pipe in the center, drag it so that its 
left endpoint falls within the J1 Reservoir icon, then drop it there (see Figure 10). Next, grab the right end-
point of the pipe and stretch the pipe, dragging it until the endpoint terminates within the J3 Branch icon 
(see Figure 11).
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Figure 10: Valve Closure Model with first pipe inlet end connected
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Figure 11: Valve Closure Model with first pipe fully connected

Reference positive flow direction

Located on the pipe is an arrow that indicates the reference positive flow direction for the pipe. AFT 
Impulse assigns a flow direction corresponding to the direction in which the pipe is drawn. You can 
reverse the reference positive flow direction by choosing Reverse Direction from the Arrange menu or 
selecting the reverse direction button on the Workspace Toolbar.

The reference positive flow direction indicates which direction is considered positive. If the reference pos-
itive direction is the opposite of that obtained by the Solver, the output will show the flow rate as a neg-
ative number.

VI. Add the remaining pipes

A faster way to add a pipe is to draw it directly between the desired junctions.

ØActivate the pipe drawing tool again. Position the cursor on the J2 Reservoir. Press and hold the left 
mouse button. Stretch the pipe up to the J3 Branch then release the mouse button. Then draw a third 
pipe from the J3 Branch to the J4 Valve. Finally, draw a fourth pipe from the J4 Valve to the J5 Reservoir. 
Your model should now look similar to Figure 12.

At this point all the objects in the model are graphically connected. Save the model by selecting Save 
from the File menu or by clicking the Save button on the Toolbar.
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Note: It is generally desirable to lock your objects to the Workspace once they have been placed. This 
prevents accidental movement and disruption of the connections. Locking also helps prevent 
accidental deletion of your output once a solution has been completed. You can lock all the 
objects by choosing Select All from the Edit menu, then selecting Lock Object from the Arrange 
menu. The Lock Object button on the Workspace Toolbar will appear depressed indicating it is 
in an enabled state, and will remain so as long as any selected object is locked.

Figure 12: Valve Closure Model with all objects connected

VII. Define the pipes and junctions

To fully define the Pipes and Junctions Group in Analysis Setup, all pipes and junctions must be con-
nected and have the proper input data.

Object status

Every pipe and junction has an object status. The object status tells you whether the object is defined 
according to AFT Impulse's requirements. To see the status of the objects in your model, click the flood-
light on the Workspace Toolbar (alternatively, you could choose Show Object Status from the View 
menu). Each time you click the floodlight, Show Object Status is toggled on or off.
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When Show Object Status is on, the ID numbers for all undefined pipes and junctions are displayed in 
red on the Workspace. Objects that are completely defined have their ID numbers displayed in black. 
(These colors are configurable through User Options from the Tools menu.)

Because you have not yet defined the pipes and junctions in this model, all the objects' ID numbers will 
change to red when you turn on Show Object Status.

Undefined Objects window

The Undefined Objects window lists all undefined pipes and junctions and further displays the items that 
are not yet defined. This is found inside the View dropdown and selecting List Undefined Objects.

VIII. Define Reservoir J1

ØTo define the reservoir J1, open the J1 Reservoir Properties window (see Figure 13) by double-click-
ing the J1 icon. By default you will begin on the Reservoir Model tab. For Tank Model make sure Infinite 
Reservoir is selected. Enter a Liquid Surface Elevation of 50 feet. You can assign any unit of length 
found in the adjacent drop down list box of units.

Note: You can also open an object's properties window by selecting the object (clicking on it) and then 
either pressing the Enter key or clicking the Open Pipe/Jct Window icon on the Workspace Tool-
bar.

ØEnter a Liquid Surface Pressure of 0 psig and with Pipe Depth selected, enter 10 feet.

Note: You can specify preferred units for many parameters (such as meters for length) in the User 
Options from the Tools menu.

You can give the object a name, if desired, by entering it in the Name field at the top of the window. In Fig-
ure 13, the name of this reservoir is Supply Tank A. By default the junction’s name is the junction type. 
The name can be displayed on the Workspace or in the Output.

Most junction types can be entered into a custom library allowing the junction to be used multiple times or 
shared between users. To select a junction from the custom library , choose the desired junction from the 
Library Jct list. The current junction will get the properties from the library.

The Copy Data From Jct list will show all the junctions of the same type in the model. This will copy all 
the parameters from an existing junction in the model to the current junction.

The pipe table on the Pipe Depth & Loss Coefficients tab allows you to specify entrance and exit loss 
factors for each pipe connected to the reservoir (in this case there is one). You can enter standard losses 
by selecting the option buttons at the right. The default selection is the Custom option with loss factors 
specified as zero. To later change the loss factors, click within the pipe table and enter the loss. You can 
also specify a depth for the pipe.

The Transient tab can be used to specify how the liquid surface elevation changes with time. 

The Optional tab allows you to enter different types of optional data. Some junction types also allow you 
to provide a guess for initial pressure as well as other junction specific data. The junction icon graphic 
can be changed, as can the size of the icon. Design factors can be entered for most junctions, which are 
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applied to the pressure loss calculations for the junction in order to give additional safety margin to the 
model.

The Design Alerts tab shows the design alerts that are applied to the junction, which ensures that the 
model is behaving as expected.

The Notes tab allows you to enter text describing the junction or documenting any assumptions.

The Status tab lists the remaining undefined items for the junction. It should show that All Items Defined.

The highlight feature displays all the required information in the properties window in light blue. The high-
light is on by default. You can toggle the highlight off by pressing the F2 key. The highlight feature can 
also be turned on or off in the User Options window from the Tools menu. 

ØClick OK. You may be prompted to display the junction name on the Workspace, if so, click Yes. If 
Show Object Status is turned on, you should see the J1 ID number turn black again, telling you that J1 is 
now completely defined.

Figure 13: Enter the data for Reservoir J1 in the Reservoir Properties window

The Inspection feature

You can check the input parameters for J1 quickly, in read-only fashion, by using the Inspection feature. 
Position the mouse pointer on J1 and hold down the right mouse button. An information box appears, as 
shown in Figure 14.

Inspecting is a fast way of examining the input (and output if output results are available) for an object.
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Figure 14: Input data can be inspected from the Workspace by holding the right mouse button

IX. Define Reservoir J2

ØNext, open the properties window for reservoir J2 and make sure the Tank Model selection is Infin-
ite Reservoir, then enter a Liquid Surface Elevation of 45 feet, a Liquid Surface Pressure of 0 psig, and 
with Pipe Depth selected, enter 10 feet. Give the reservoir the name Supply Tank B. After you enter the 
data and click OK, and if Show Object Status is turned on, you should see the ID number on the Work-
space turn black, because the status has changed to defined. 

X. Define Branch J3

ØOpen the properties window for branch J3 (see Figure 15). In this window, all three connecting 
pipes should be displayed in the pipe table area. You could associate loss factors with each pipe by click-
ing within the pipe table and entering the data. Enter an elevation of 0 feet for the J3 Branch junction (an 
elevation must be defined for all junctions). You could also click the Optional tab then specify a flow 
source or sink at the junction; for now leave this as unedited. Click OK so that the elevation parameter is 
saved. 
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Figure 15: Enter the data for Branch J3 in the Branch Properties window

XI. Define Valve J4

ØOpen the properties window for valve J4 (see Figure 16) and enter an Inlet Elevation of 0 feet. 

ØOn the Loss Model tab, make sure the Loss Source has User Specified selected.

ØFor Loss Model, make sure Cv is selected and enter a Cv value of 1000. This represents the valve's 
Cv during steady-state.

ØClick the Transient tab and enter the data below for Cv (see Figure 17).

Time (seconds) Cv

0 1000

0.4 400

0.8 100
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Time (seconds) Cv

1 0

2 0

The first data point (Cv = 1000 at time zero) must match the steady-state value. The transient data rep-
resents the valve initially open. The valve then gradually closes over a period of one second, and stays 
closed.

The J4 Valve is the element which causes the transient in this model. The purpose of the model will be to 
understand how high the pressures can rise during the transient.

When transient data is entered for a junction, a T symbol is shown next to the junction number on the 
Workspace.

Figure 16: Enter the data for Valve J4 in the Valve Properties window
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Figure 17: Transient data is entered on the Transient tab on junction Properties windows

XII. Define reservoir J5

ØFinally, open the properties window for reservoir J5 and make sure the Tank Model selection is 
Infinite Reservoir, then enter a Liquid Surface Elevation of 5 feet, a Liquid Surface Pressure of 0 psig, 
and with Pipe Depth selected, enter 5 feet. Give the reservoir the name Discharge Tank. Click OK

ØSave the model again before proceeding.

XIII. Define pipe P1

The next step is to define all the pipes. To open the Pipe Properties window, double click the pipe on the 
Workspace.

ØFirst open the Pipe Properties window for Pipe P1 (see Figure 18). For Pipe P1, enter a length of 
200 feet and select the Pipe Material as Steel - ANSI, Size of 10 inch, and make sure the Type is STD 
(schedule 40). 

The wavespeed is a very important parameter in a waterhammer analysis. The wavespeed can be cal-
culated with reasonable accuracy from fluid and pipe data, or it may be available from test data or 
industry publications. If the wavespeed is not known (which is typical), then the Calculated Wavespeed 
option is preferred option. In this case, data is required for pipe wall thickness, modulus of elasticity, 
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Poisson Ratio, and pipe support details. Data for pipe wall thickness, modulus of elasticity, Poisson Ratio 
are built into the pipe material libraries supplied with AFT Impulse, and is automatically obtained when 
the pipe material, size, and type are chosen. The calculated wavespeed is 4328 feet/sec.

The Pipe Properties window offers control over all important flow system parameters that are related to 
pipes. Click OK.

Figure 18: Enter the data for Pipe P1 in the Pipe Properties window

The Inspect feature also works within the Pipe Properties window. To inspect a connected junction, pos-
ition the mouse pointer on the connected junction's ID number and hold down the right mouse button. 
This is helpful when you want to quickly check the properties of connecting objects. (You can also use 
this feature in junction Properties windows for checking connected pipe properties.)

By double-clicking the connected junction number, you can jump directly to the junction's Properties win-
dow. Or you can click the Jump button to jump to any other part of your model.

XIV. Define pipes P2, P3, and P4

Define pipes P2 - P4 as Steel - ANSI using the sizes and lengths shown below. Use the STD for the type. 
All pipes should use Thick-Walled Anchored Upstream for the Pipe Support model.

The data for the pipes should be as follows:

Pipe Size (inches) Length (feet)

1 10 200

2 10 150
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Pipe Size (inches) Length (feet)

3 12 50

4 12 40

After entering the data for all the pipes, the Pipes and Junctions Group should be completed. If it is not, 
see if the Show Object Status is on. If it is not turned on, select Show Object Status from the View menu 
or Workspace Toolbar. If the Pipes and Junctions Group in Analysis Setup does not have a green check-
mark next to it, see if any of the pipes or junctions have their number displayed in red. If so, you did not 
enter all the data for that item.

ØBefore running the model, save it one more time. It is also a good idea to review the input using the 
Model Data window.

Reviewing input in the Model Data window

The Model Data window is shown in Figure 19. To change to this window, you can select it from the 
Primary Window tabs or the Window menu, or by pressing CTRL+M. The Model Data window gives you 
a text based perspective of your model. Selections can be copied to the clipboard and transferred into 
other Windows programs, or printed out for review. Figure 20 shows an expanded view of the Transient 
Data tab from Figure 19. Here all transient input data for the model is shown.

The Model Data window allows access to all Properties windows by double-clicking anywhere in the row 
associated with the appropriate ID number in the far left column of the table. You may want to try this right 
now.

Figure 19: The Model Data window displays pipe and junction data in text format
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Figure 20: The Transient data tab in the Model Data window displays transient input data

D. Define the Pipe Sectioning and Output Group

After completing the first three Analysis Setup Groups, sufficient information exists to run the model in 
steady-state. The next two groups are for transient modeling. To run the model in steady-state, open the 
Analysis menu, select Simulation Mode/Duration, then choose Steady Only. By doing this, all needed 
information has been entered and the model can be run. In general, it is a good idea to always run your 
model in steady-state first before running the full transient analysis to make sure the model is giving reas-
onable results.

The Pipe Sectioning and Output group allows the user to define pipe sectioning and how much inform-
ation to save to the output file. This is useful for running transient scenarios and animations relying on 
stored results.

I. Define the Sectioning Panel

The only item in the Pipe Sectioning and Output Group in Analysis Setup that needs user input is the Sec-
tioning panel. This panel cannot be defined until the Fluid Properties group and Pipes and Junctions 
group are defined.  The Sectioning panel divides the pipes into computation sections in a manner which is 
consistent with the Method of Characteristics (MOC).

ØOpen the Sectioning panel in Analysis Setup  (Figure 21). The pipes will automatically be sectioned 
without user input. For this model the controlling pipe is P4. This is the pipe with the shortest end-to-end 
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communication time (i.e., L/a – the length divided by the wavespeed). To satisfy the MOC, the following 
equation must be applied:

where n is the number of sections in pipe i, L is the length, and a is the wavespeed. The Δt is the time 
step. Since all pipes in the network must be solved together, the same time step must be used for each 
pipe. With a given length and wavespeed for each pipe, it can be seen from the above equation that it is 
unlikely that the number of required sections, n, for each pipe will be a whole number. 

To address this situation, it is helpful to recognize that the wavespeed, a, is the least certain input para-
meter. It is therefore commonly acceptable to allow up to a 15% uncertainty in wavespeed, though AFT 
Impulse by default only allows up to 10% variance. By adjusting the wavespeed for each pipe within this 
tolerance the sectioning can be made to come out as whole numbers for each pipe. The Section Pipes 
window automates this process by searching for sectioning which satisfies the required tolerance. 

You can customize the Section Pipes search criteria by clicking the arrow next to Advanced Settings. In 
general, the default search criteria will be sufficient for adequately sectioning the pipes throughout your 
model.

In this example, make sure the second row that will use two pipe sections in the controlling pipe is selec-
ted. The Sectioning Panel and Pipe Sectioning and Output group should now have a green checkmark 
indicating that they are fully defined.

Figure 21: The Sectioning Panel automates the sectioning process and calculates the time step
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E. Define the Transient Control Group

The final Analysis Setup group to define is the Transient Control Group. This group allows you to specify 
the time at which the transient starts and ends, the cavitation model used, and the friction method used.

ØOpen the Simulation Mode/Duration panel in Analysis Setup  (Figure 22). Zero (0) seconds should 
already be entered for Start Time. Enter two (2) for Stop Time. 

The Transient Cavitation panel allows you to enable or disable transient cavitation modeling. It is advised 
to keep Model Transient Cavitation checked and only disable it for troubleshooting purposes.

Note: The Artificial Transient Detection panel in the Miscellaneous group offers control over how AFT 
Impulse should respond to artificial transients. Artificial transients are a problem that can some-
times occur when steady-state and initial transient conditions are inconsistent.

At the bottom of the panel the projected output file size is shown. You should pay attention to this num-
ber, as the output file size can grow very large. In this case the output file will be 84 kB. If the output file 
does become excessively large, you will want to limit the number of time steps and pipe output written to 
the output file. The estimated file size and run time may vary on different computers.

ØClick OK to accept the current settings now that all groups are defined. The model is ready to be 
solved.

Figure 22: The Simulation Mode/Duration panel offers features to specify the time span for the transient and 
what output data is written

 Step 3. Run the Solver

ØClick Run Model from the toolbar or from the Analysis menu. During execution, the Solution Pro-
gress window displays (Figure 23). You can use this window to pause or cancel the Solver's activity.
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The two solvers

AFT Impulse has two solvers. The first is called the Steady-State Solver, which as its name suggests 
obtains a steady-state solution to the pipe network. The second solver is called the Transient Solver. This 
solves the waterhammer equations.

Before a transient simulation can be initiated, the initial conditions are required. These initial conditions 
are the steady-state solution to the system. After the steady-state solution is obtained by the Steady-
State Solver, AFT Impulse uses the results to automatically initialize the Transient Solver and then run it.

ØWhen the solution is obtained, click the Output button to display the text-based Output window. 
The information in the Output window can be reviewed visually on the screen, saved to file, exported to a 
spreadsheet-ready format, copied to the clipboard, and printed out on the printer.

Figure 23: The Solution Progress window displays the state of the simulation

The transient output file

When the Transient Solver runs, the transient output data is written to a file. This file is given the same 
name as the model itself with a number appended to the name, and with an .out extension appended to 
the end. For all transient data processing, graphing, etc., the data is extracted from this file. The number 
is appended because AFT Impulse allows the user to build different scenarios all within this model. Each 
scenario will have its own output file, thus the files need to be distinguishable from each other. 
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The output file will remain on disk until the user erases it or the model input is modified. This means that if 
you were to close your model right now and then reopen it, you could proceed directly to the Output win-
dow for data review without rerunning your model.

 Step 4. Examine the Output

The Output window (Figure 24) is similar in structure to the Model Data window. Three areas are shown, 
and you can minimize or enlarge each section by clicking the arrow next to the General, Pipes, and All 
Junctions tabs. The parameters displayed in the tables can be customized with the Output Control win-
dow, from the Tools drop-down menu. 

The Output window allows you to review both the steady-state and transient results. You can review the 
solutions for each time step (i.e., a time history) for which data was written to file. Also, a summary of the 
maximum and minimum transient results for each computing station is given on the Transient Max/Min 
tab in the pipe area. These two data sets are located on the Transient Output tab and Transient Max/Min 
tab in the pipe area of the Output window (see Figure 25 and Figure 26 respectively). Note that in order to 
display all pipe stations as shown in Figure 25, the model will need to be set to save data for all stations. 
By default, AFT Impulse will only save the inlet and outlet data points for each pipe. This can be changed 
on the Output Pipe Stations Panel in the Pipe Sectioning and Output Group in Analysis Setup.

Figure 24: The Output window displays steady-state and transient output in tabular form
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Figure 25: The Output window displays transient data for each time step

Figure 26: The Output window displays maximum and minimum transient data

A. Modify the output format

If you selected the default AFT Impulse Output Control, the Pipes table of steady-state results (the tab on 
the far left in the pipe area) will show volumetric flow rate in the second column with units of gal/min (gal-
lons per minute). 

ØSelect Output Control from the Tools menu or the main Toolbar. On the right side of the Pipes 
section is the list of currently selected output parameters. Click Volumetric Flow Rate and change the 
units by clicking the arrow beside the units, and then selecting gal/hr (gallons per hour) from the drop-
down list.

ØClick OK to display changes to the current results. You should see the volumetric flow rate results, 
still in the second column, in units of gal/hr. Notice the Velocity results in the third column.

ØSelect Output Control from the Tools menu one more time. The Reorder scroll bar on the far right 
allows you to reorder parameters in the list. You may also reorder parameters by dragging and dropping 
the icon just to the left of each parameter within the list of currently selected parameters.

ØSelect the Velocity parameter and use the Reorder scroll bar to move it up to the top of the para-
meter list.
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ØClick OK to display the changes to the current results. You will see in the Pipes table that the first 
column now contains velocity and the third column contains the volumetric flow rate. The Output Control 
window allows you to obtain the parameters, units and order you prefer in your output. This flexibility will 
help you work with AFT Impulse in the way that is most meaningful to you, reducing the possibility of 
errors.

ØLastly, double-click the column header Velocity in the Output window Pipes Table. This will 
open a window in which you can change the units once again if you prefer. These changes are extended 
to the Output Control parameter data you have previously set.

B. Graph the results

For transient analyses, the Graph Results window will usually be more helpful than the Output window 
because of the more voluminous data.

ØBrowse to the Graph Results window by clicking the Graph Results tab, choosing it from the Win-
dows menu, or by pressing CTRL+G. The Graph Results window offers full-featured Windows plot pre-
paration.

The Graph Parameters menu will automatically be displayed in the Quick Access Panel on the far right of 
the Graph Results Window, and be where you are to specify which graphs to generate. On the Transient 
Pipe tab under Select Pipe Stations, expand P3 pipe stations and double-click Outlet, which is the pipe 
computing station at the valve inlet. Also add the inlet of pipe P4 which is the valve exit. Select the Graph 
Parameter as Pressure Static and set the units to psig (see Figure 27).

ØClick Generate. The graph shows the static pressure at the valve inlet and outlet over the duration of 
the simulation (See Figure 28).

You can use the other buttons in the Graph Results window to change the graph appearance and to save 
and import data for cross-plotting. The Graph Results window can be printed, saved to file, copied to the 
clipboard, or printed to an Adobe PDF file. The graph's x-y data can be exported to file or copied to the 
clipboard.

Note that the graph guide, located at the top right of the Graph Results window and represented with the 
What Would You Like to Do? icon, can guide you through the development of your graph. This feature 
can be hidden by clicking on the icon.
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Figure 27: The Select Graph Parameters window controls the Graph Results content

Figure 28: The Graph Results window offers full-featured plot generation. Here the static pressure at valve J4 
over time is shown

Further review of the valve graph results in Figure 28 shows that at time zero the difference between the 
curves is about 16 psid. This is the steady-state pressure difference across the valve, which can also be 
found in the Output window to be 15.70 psid.

As time increases one sees that the pressure drop across the valve increases as it closes. Finally at 1 
second, the valve closes entirely and the pipes upstream and downstream of the valve are isolated from 
each other and will decay to the steady-state conditions which exist for a closed valve.

In the Graph Parameters window on the Quick Access Panel click  (Clear button). Expand Pipe 1 
and select the Inlet of Pipe 1 by double-clicking or clicking the Add button. This is the pipe computing 
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station at the reservoir J1. Also add the inlet of Pipe 2 which is the reservoir J2. Select the Graph Para-
meter as Volumetric Flowrate Upstream and set the units to gal/min. Click Generate. A graph of these sta-
tions shows the flow rates out of the two supply reservoirs. Note that after the valve closes, the fluid in 
reservoir J1 flows to reservoir J2 (see Figure 29).

Figure 29: Transient flow rates out of the reservoirs

C. View the Workspace Layers

ØChange to the Workspace window by clicking the Workspace tab or by choosing it from the Window 
menu.  Workspace Layers allow you to integrate your text results with the graphic layout of your pipe net-
work from within the Workspace itself.

ØClick the Workspace Layers tab in the bottom right of the Quick Access Panel to view the Work-
space Layers interface. Pipe and junction parameters can be added to new layers and applied to the 
labels of specified pipes or junctions as desired, or they can be added to the All Objects Layers. The All 
Objects Layer is a special default layer that displays all pipes, junctions, and annotations, and therefore 
any pipe and junction parameters added to this layer will be applied to all applicable pipes and junctions.

Note: It is typically preferable to create a new layer when adding a parameter to labels on the Work-
space, but for the sake of simplicity, this example adds the parameters to the All Objects Layer.

Select the All Objects Layer and open its Layer Settings menu by clicking the gear icon in the Layers Tool-
bar (or to the right of the All Objects Layer's visibility icon) or by double clicking on the layer title (Figure 
30).

Navigate to the Pipe Parameters panel within the Label Control group. Both input and output parameters 
are listed, though output parameters will only be displayed on the Workspace when output exists to do 
so. When no output exists, the output pipe label parameters in the right hand list will be gray. You can 
hover over each parameter to see a description of the parameter and whether it is an input or output para-

Workspace-Layers.html#Layer-Settings-Label-Control
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meter. Expand the Pipe Parameters category and find the item Velocity Outlet. You can also use the 
parameter filter to search for desired parameters.

Note: Some parameter categories are contextual and may only appear in certain circumstances 
(when certain modules are active, when certain junctions are present, etc.).

Figure 30: The Layer Settings window specifies content to be superimposed on the Workspace

ØSelect Max Pressure Stagnation in the list with units of psig and add it to the right pane by either 
double-clicking the parameter, or selecting the parameter and clicking the arrow between the panes. 
Repeat the process to add the Min Pressure Stagnation parameter.

ØAdd the Junction Names as labels by selecting Junction Parameters, expanding either Commonly 
Junction Parameters or Junction Parameter sections, and double-clicking the Junction Name parameter.

ØAdd additional clarity by repositioning the labels and adding a legend. It is common for the text 
on the Workspace Layers to overlap with objects when first generated. Labels can be dragged to a new 
area or a smaller font can be selected using the Font Decrease icon on the Workspace Toolbar. Para-
meter units can be consolidated in a legend which can be added via the Global Layer Settings. In the Lay-
ers Toolbar, click the double gear icon to open the Global Layer Settings. Then, enable the checkbox for 
Show Units in Legend. The result of these adjustments is shown in Figure 31.
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Figure 31: Results are superimposed on the model layout via Workspace Layers

The Workspace Layers also provides the ability to animate the transient results as a qualitative tool to 
visualize the behavior in a network. This option can be accessed from the Color Maps/Animations layer 
type.

ØCreate a new Color Map/Animation layer using the green plus icon (+) on the Layers Toolbar in the 
Quick Access Panel. Give the new layer a name and press OK.

ØOpen the Layer Settings window and select the Animation option under the Layer Type. The 
other Workspace Layers will be visible, but the animation can only be applied to a single parameter. The 
parameter can be animated using absolute values, values relative to the steady-state, or a static map of 
all maximum/minimum transient values can be generated.

ØSelect Pressure Static as the parameter for the animation using units of psig. The model setup 
for animating static pressure can be seen in Figure 32.

ØClose the Layer Settings and add additional clarity by repositioning the legend and time 
counter. By default the legend will be drawn in the top-left corner of the Workspace. You can click and 
drag the legend and time counter to new positions on the Workspace.

ØWatch the animation by clicking Play on the animation playback controls at the top of the Work-
space. The sliders and plus/minus icons can be used to skip to a different time step or increase the play-
back speed. The animation can be saved to a file using the Record button.
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Figure 32: Workspace Layers provides an animation feature as an alternate way to view the transient results

Conclusion

You have now used AFT Impulse's Primary Windows to build and analyze a simple waterhammer model.
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Ammonia Transfer with Cavitation 

Summary

A ship carrying ammonia in a pressurized holding tank transfers the fluid to an onshore holding tank. The 
valve controlling flow to the holding tank must be closed as quickly as possible. Three different closing 
times are to be evaluated, and the resulting maximum pressures need to be determined.

Topics Covered

 l Observing effects of varying valve closing time
 l Evaluating systems with transient cavitation
 l Using Scenario Manager

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Ammonia Transfer with Cavitation.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 a. Fluid Library = AFT Standard
 b. Fluid = Ammonia (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 75 deg. F

This calculates the fluid properties to use in the model. Notice the high vapor pressure of 141 psia. By 
changing the temperature to 70 or 80 deg. F, it can be seen that vapor pressure is very sensitive to tem-
perature. In such a case, it would be worthwhile to find out if 75 deg. F is the highest expected tem-
perature so that the analysis can be run with the highest potential vapor pressure.

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

Figure 1: Layout of ammonia transfer system

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

Pipe Properties
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 1. Pipe P1
 a. Pipe Material = Steel - ANSI
 b. Size = Use table below
 c. Type = STD (schedule 40)
 d. Friction Model Data Set = Standard
 e. Length = Use table below

Pipe Size (inches) Length (feet)

1 8 100

2 10 300

3 10 150

Junction Properties

 1. Reservoir J1
 a. Name = Ship - Pressurized Tank
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 40 feet
 d. Liquid Surface Pressure = 250 psig
 e. Pipe Depth = 40 feet

 2. Area Change J2
 a. Inlet Elevation = 0 feet
 b. Type = Abrupt Transition (Cylindrical)

 3. Valve J3
 a. Loss Model tab
 b. Inlet Elevation = 0 feet
 c. Loss Model tab

 i. Valve Data Source = User Specified
 ii. Loss Model = Cv
 iii. Loss Source = Fixed Cv
 iv. Cv = 1000

 d. Transient tab
 i. Transient Special Conditions = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values

Time (seconds) Cv

0 1000

0.5 0
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 4. Reservoir J4
 a. Name = Onshore Holding Tank
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 20 feet
 d. Liquid Surface Pressure = 250 psig
 e. Pipe Depth = 5 feet

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and navigate to the Sectioning panel. When the Sectioning panel is first 
opened it will automatically search for the best  (least number of sections within 10% variance) option for 
one to five sections in the controlling pipe. The results will be displayed in the table at the top. Make sure 
the second row designating two sections in controlling pipe is selected.

 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel. 

 1. Enter the Stop Time as 5 seconds. 
 2. Navigate to the Transient Cavitation Panel. 
 3. Make sure that Model Transient Cavitation is checked and that the selected model is Discrete 

Vapor Cavity Model (DVCM).
 4. Click OK.

 Step 6. Create Child Scenarios

In this model we want to see the impact of using different valve closure times. We will create three scen-
arios to do the comparison. This can be done easily using the Scenario Manager on the Quick Access 
Panel. Note that the Scenario Manager can also be accessed from the Tools menu.

The Scenario Manager is a powerful tool for managing variations of a model, referred to as scenarios. 

The Scenario Manager allows you to:

 l Create, name and organize scenarios
 l Select the scenario to appear in the Workspace (the ‘current’ scenario)
 l Delete, copy and rename scenarios
 l Duplicate scenarios and save them as separate models
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 l Review the source of a scenario’s specifications
 l Pass changes from a scenario to its variants

Check that the Scenario Manager is active on the Quick Access Panel. It should appear as shown in Fig-
ure 2. 

Figure 2: The Scenario Manager window on the Quick Access Panel is used to create and manage model 
scenarios

Create a child scenario by either right-clicking on the Base Scenario and then selecting Create Child, or 
by first selecting the Base Scenario on the Scenario Manager on the Quick Access Panel and then select-

ing the Create Child icon  Enter the name 0.5 Second Closure in the Create Child Scenario window, 
as shown in Figure 3. Click OK. The new 0.5 Second Closure scenario should now appear in the Scen-
ario Manager on the Quick Access Panel below the Base Scenario.

Figure 3: Create Child Scenario window

Select the Base Scenario and create another child and call it 1 Second Closure. Finally create a third 
child called 2 Second Closure. See Figure 4.
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Figure 4: Scenario Manager on the Quick Access Panel with 3 new child scenarios

Set up scenarios

Since the Base Scenario already has the 0.5 second closure time entered, we do not need to modify that 
child. Load the 1 Second Closure scenario in the list by double clicking the scenario name.

ØOpen the J3 Valve junction and on the Transient tab change the time of valve closure from 0.5 to 1, 
then click OK. Select the 2 Second Closure scenario in the list by double-clicking the scenario name in 
the Scenario Manager. Change the J3 Valve junction here to close at 2 seconds. 

 Step 7. Run the 0.5 Second Closure scenario

ØDouble-click on the 0.5 Second Closure scenario in the Scenario Manager on the Quick Access 
Panel to make it the active scenario. Alternatively, you can select this scenario and then click on the Load 

Scenario icon  to load this scenario. 

ØClick Run Model from the toolbar. This will open the Solution Progress window, which allows you to 
watch as the Impulse Solver converges on the answer. This model runs very quickly. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 8. Examine the Output

ØGo to the Graph Results window by clicking the Graph Results tab. First create a pressure profile 
graph as follows:

 1. Select the Profile tab in the Graph Control section of the Quick Access Panel.
 2. In the Pipes section click All.
 3. Make sure Pressure Static is selected in the Parameter section.
 4. Change the units to psig.
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 5. Make sure the boxes for Mx and Mn are checked to display the maximum and minimum values.
 6. Click Generate.

Results (shown in Figure 5) indicate that the peak pressure occurs at 400 feet along the transfer line. 
This corresponds to the valve inlet. Notice that the minimum pressure is flat along almost the entire 
length of pipe. This value is the vapor pressure, which indicates that the liquid cavitates through most of 
the length of the pipe. 

ØSave this graph to the Graph List by selecting Add to Graph List from the toolbar, and give the graph 
an appropriate name, such as Static Pressure Profile. This will allow the graph to be quickly reloaded 
later in the other scenarios.

ØNavigate to the Transient Pipe tab on the Quick Access Panel. Add the outlet station of pipe 2 to 
the stations to be graphed. Make sure the selected graph parameter is Pressure Static with units of psig. 
Click Generate. This shows the transient pressures at the valve inlet over time (see Figure 6). Here you 
can see that the low pressure reaches the vapor pressure repeatedly. Save this graph to the Graph List 
as well.

From Figure 5 and Figure 6 you can see that the maximum pressure is about 570 psig. There are several 
ways to see the actual numerical value. Here is one way:

 1. Change to the Output window by selecting the Output tab.
 2. In the Pipes section the Transient Max/Min tab should be selected.
 3. By default the maximum static pressure is not displayed, but the maximum stagnation pressure is. 

Typically these values are fairly close. Looking at the Maximum Stagnation Pressure for pipe 2 
shows that it is about 570.2 psig (see Figure 7). If you want to see the maximum static pressure, 
you can add it to the Output window using the Output Control window.

Figure 5: Profile of the maximum and minimum pressures
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Figure 6: Transient pressures at the valve inlet

Figure 7: Numerical value of maximum pressure can be found in the Output window

 Step 9. Run the Second and Third Scenarios

ØUse Scenario Manager to load and run the 1 and 2 second closure cases. Use the techniques in Step 
8 to find the maximum pressure for these cases. A tabulation of the results is shown in Table 1. If the res-
ults for the 2 second case are graphed, one can see that there is no cavitation. The results corresponding 
to Figure 6 appear much different.

To see the difference in results with and without cavitation, you can turn the transient cavitation model off 
in the Transient Control window.

Table 1: Max Stagnation pressures with different closure rates

Closure Time (seconds) Max Pressure (psia)

0.5 630.9

1 562.3

2 382.5
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 Step 10. Compare DVCM Output with DGCM

As a verification of the cavitation results, you can change the Transient Cavitation model in the Transient 
Control window to use the Discrete Gas Cavity Model. Do this for the 0.5 Second Closure scenario as fol-
lows:

 1. Create a child of the 0.5 Second Closure scenario and name it With DGCM
 2. Open Analysis Setup and go to the Transient Cavitation panel in the Transient Control group
 3. Under Model Transient Cavitation change the Model to Discrete Gas Cavity Model
 4. Click OK

Run the model, then go to the Graph Results window.

Load the Static Pressure Profile graph by double-clicking the name in the Graph List Manager at the top 
of the Quick Access Panel. This will load the Pressure Profile with the results for the current scenario. In 
order to compare the DGCM results to the results using DVCM we can select both scenarios to be 
graphed using the Multi-scenario graphing feature.

ØIn the Graph Parameters Section of the Quick Access panel click the Multi-Scenario button to 
select the scenarios to graph. Check the box next to the 0.5 Second Closure scenario to include it in the 
graph, and ensure that the With DGCM scenario is still selected, then click OK. Click Generate to update 
the graph.

Figure 8 shows the multi-scenario graph. Notice that the maximum pressure at the valve is nearly 
identical for both cavitation models, though there is some deviation in the maximum pressures upstream 
of the valve.

Repeat the process above to generate a multi-scenario graph of the Valve Inlet Pressure over time that 
was shown in Figure 6 above. The resulting multi-scenario plot is shown below in Figure 9. Notice that 
the models produce very similar results for the first pressure spike after cavitation begins at around 1.2 
seconds, after which the results begin to diverge. This provides high confidence in the validity of the first 
pressure spike, as two separate calculation methods produced the same conclusion.

A similar analysis can be performed with the 1 Second Closure scenario, which results in slightly more 
deviation in the results. Performing this comparison with the 2 Second Closure scenario would produce 
no differences, as the minimum pressure never reaches vapor pressure in that scenario.
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Figure 8: Multi-scenario graph comparing DVCM and DGCM results for the 0.5 Second Closure scenario

Figure 9: Multi-scenario graph comparing DVCM and DGCM results at the valve inlet for the 0.5 Second Clos-
ure scenario
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Summary

Table 2 provides a summary of the maximum pressure in each of the scenarios using each of the cavit-
ation models. Lengthening the closure time reduced the maximum pressure with both cavitation models.

Table 2: Max Stagnation pressures with different closure rates

Closure Time (seconds) Max Pressure DVCM (psia) Max Pressure DGCM (psia)

0.5 630.9 640.1

1 562.3 551.0

2 382.5 382.5
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Tank Farm with Infinite Pipes 

Summary

A long supply pipeline flows into a gasoline tank farm. The transient occurs when flow is switched from 
one storage tank to another. Two scenarios compare the results with and without an infinite pipe bound-
ary, and also compares the run times.

Topics Covered

 l Using infinite pipes

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Tank Farm with Infinite Pipes.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = User Specified Fluid
 b. Name = Gasoline

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 c. Density = 0.759 S.G. water
 d. Dynamic Viscosity = 0.000321 lbm/s-ft
 e. Bulk Modulus = 150000 psia
 f. Vapor Pressure = 9 psia

Figure 1: Fluid panel defined for gasoline

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.
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Figure 2: Model lay out on Workspace for the tank farm model

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

Pipe size and lengths, as well as junction elevation data are given below. Here we see that the inlet 
assigned flow junction represents the flow coming from a pumping station that is 30 miles away. If the 
pumps in the pump station interact with the tank farm transients, then the pumps must be modeled in 
detail. We will find out later that they do not, and thus we can simplify the model by using an assigned 
flow junction at the pump discharge. The WEB Valve is initially closed. The way we represent this in 
steady-state is using a Special Condition to close it. As for the transient, the initial data point for Cv must 
be zero.

Junction Properties

 1. Assigned Flow J1
 a. Name = Pump Station Discharge
 b. Elevation = 966 feet
 c. Type = Inflow
 d. Flow Specification = Volumetric Flow Rate
 e. Flow Rate = 13500 barrels/hr

 2. Reservoir J2
 a. Name = Desert Petroleum
 b. Liquid Surface Elevation = 1029 feet
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 c. Liquid Surface Pressure = 0 psig
 d. Pipe Depth = 40 feet

 3. Valve J3
 a. Name = Desert Pet Valve
 b. Elevation = 966 feet
 c. Loss Model tab

 i. Loss Source = User Specified
 ii. Loss Model = Cv
 iii. Cv = 15700

 d. Transient tab
 i. Transient Special Condition = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values

Time (seconds) Cv

0 15700

19 15700

19.2 12400

22 12400

22.2 9400

26 9400

28 200

34 0

35 0



Tank Farm with Infinite Pipes

- 54 -

Figure 3: Valve J3 transient data

 4. Branch J4
 a. Elevation = 966 feet

 5. Valve J5
 a. Name = WEC Valve
 b. Elevation = 966 feet
 c. Loss Model tab

 i. Loss Source = User Specified
 ii. Loss Model = Cv
 iii. Cv = 4000

 d. Transient tab
 i. Transient Special Condition = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values

Time (seconds) Cv

0 0

10 150

11 800
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Time (seconds) Cv

12 4000

35 4000

 e. Optional tab
 i. Special Condition = Closed

Figure 4: Valve J5 transient data

 6. Reservoir J6
 a. Name = West Coast Energy
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 1023 feet
 d. Liquid Surface Pressure = 0 psig
 e. Pipe Depth = 0 feet

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Size = Use table below



Tank Farm with Infinite Pipes

- 56 -

 c. Type = schedule 40
 d. Friction Model Data Set = Standard
 e. Length = Use table below

Pipe Size (inches) Length

1 20 30 miles

2 20 300 feet

3 12 200 feet

4 12 30 feet

5 20 1000 feet

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel. Enter the Stop Time as 35 seconds.

 Step 6. Create Child Scenarios

In this model we want to see the impact of using an infinite pipe boundary. We will do the comparison 
between two scenarios. In the Scenario Manager on the Quick Access Panel, create a child scenario by 
either right-clicking on the Base Scenario and then selecting Create Child, or by first selecting the Base 
Scenario on the Scenario Manager on the Quick Access Panel and then selecting the Create Child icon. 
Enter the name Without Infinite Pipe. A new scenario will appear below the Base Scenario in the list. 
Select the Base Scenario and create another child and call it With Infinite Pipe.

ØDouble-click the Without Infinite Pipe scenario in the list to load it as the current scenario, as 
shown by the green check mark icon, as shown in Figure 5.
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Figure 5: Scenario Manager window with two child scenarios

 Step 7. Run the First Scenario

This scenario models pipe P1 as 30 miles in length, which is its true length. Select Run Model from the 
toolbar or Analysis menu. The Waterhammer Assistant may open to inform you that using an Assigned 
Flow junction may not be appropriate. For our purposes it is appropriate, so click OK to dismiss the cau-
tion and to see the Solution Progress. This window allows you to watch the progress of Impulse Steady-
State and Transient Solvers. Depending on the speed of your PC, this model may take several minutes 
to run. Note how long it takes so you can compare that to the other scenario later. Once finished, go to 
the Graph Results window.

 Step 8. Graph the Results

On the Graph Control tab of the Quick Access panel go to the Transient Jct tab. Add valves J3 and J5 to 
the junctions to be graphed (see Figure 6). Select as Pressure Static Inlet parameter and set the units to 
psig. Click Generate. This graphs the pressures at the valve inlets over time (see Figure 7). Save this 
graph to the Graph List by using the Add to Graph List button.
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Figure 6: Select Graph Data window specified to plot the pressures at the valve inlets
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Figure 7: Transient pressures at the valve inlets

Now change the parameter to Vol. Flow Rate Inlet and set the units to barrels/hr. Click Generate. This 
graph shows the flowrates through the valves to each tank during the transient. Save this graph to the 
Graph List also.

Figure 8: Transient flow rates at the valve inlets
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 Step 9. Consider an Infinite Pipe

The longest pipe in the system is the 30-mile pipe P1. If you open the Section Pipes window you will see 
it has over 5,000 computing sections, which is over 100 times as many as all the other computing sec-
tions combined. Thus the computation time for this model is dominated by pipe P1.

The wavespeed for pipe P1 is 3579 feet/sec, and the time frame for the simulation is 35 seconds. During 
the simulation any transients in the tank farm can propagate 125,265 feet (about 23.7 miles) up pipe P1 
and thus never reach junction J1. For the J1 boundary to have any impact on the tank farm, it would have 
to receive the transient wave and then reflect its response back down pipe P1 to the tank farm. Thus the 
wave would have to travel 60 miles (i.e., up the pipe and then back), which would take 88.5 seconds.

The conclusion here is that any transients at the tank farm that take place in less than 88.5 seconds will 
not be affected by pipe P1 or junction J1. But one cannot neglect pipe P1, because flow is coming in from 
that pipe and transients are propagating up that pipe. This is an excellent opportunity to use an infinite 
pipe boundary. Infinite pipe boundaries accept all pressure waves but reflect none. If we use an infinite 
pipe boundary in this system, we will get virtually identical results for the first 88.5 seconds. If we let the 
model run longer than this, then the results will differ after that point in time. Since we are not interested in 
what happens after 88.5 seconds but only what happens up to 35 seconds, we can save a lot of com-
putation time.

 Step 10. Specify the Second Scenario

Load the With Infinite Pipe scenario and make the following changes:

 1. Open the J1 Assigned Flow junction window.
 2. Select the Transient tab.
 3. In the Transient Special Conditions section, select No Reflections (Infinite Pipe).
 4. Click OK.
 5. Open the Pipe Properties window for pipe P1.
 6. Change the length to 60 feet. The 60 feet length is somewhat arbitrary, and was chosen because 

the shortest pipe in the system (P4) is 30 feet long, and the pipe adjacent to the junction using the 
infinite pipe transient needs to have 2 sections. Thus modeling P1 as 60 feet does not affect the 
time step. 

 7. Click OK.
 8. Open Analysis Setup and open the Sectioning panel.
 9. Notice how pipe P1 now has two sections instead of over 5000.

 10. Click OK.

 Step 11. Run the Second Scenario

ØSelect Run Model from the toolbar or Analysis menu. This scenario runs much faster than the first one 
(about 1/60th as long).
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 Step 12. Graph the Results

Use the Graph List Manager to create the same graphs as before to compare results to the previous 
scenario. This can be done by loading the graphs from the Graph List Manager, then selecting both scen-
arios from the Multi-Scenario button in the Graph Parameters section and regenerating the graph. The 
results are practically identical for the two scenarios.

Figure 9: Multi-scenario graph of the transient pressures at the valve inlets
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Figure 10: Multi-scenario graph of the transient flow rates at the valve inlets

Conclusion

Using an infinite pipe boundary on the J1 Assigned Flow junction allowed us to obtain the same quality 
results at the tank farm with 1/60th of the computation time. While in this case the difference was 
between a few seconds versus a few minutes, a more complicated system could mean the difference 
between a one-hour run and a sixty-hour run.

Infinite pipe boundaries can also be employed on the Assigned Pressure junction type. The only dif-
ference is that during the steady-state the junction models a known pressure rather than a known flow. 
During the transient they function identically.

Finally, note that once the transient solution starts, the flow rate from an Assigned Flow junction and the 
pressure from an Assigned Pressure junction are no longer used. Both the flow rate and pressure at the 
junction will change over time, in a matter consistent with the fact that no reflections are occurring at that 
junction.
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Pump Trip with Check Valve 

Summary

A system pumping water uphill loses power to the pump. A check valve is near the pump discharge. This 
model predicts the system response and pump speed decay. Uses pump curve and efficiency data.

Topics Covered

 l Specifying a pump curve and power curve in the Pump Properties Window
 l Using one of the transient pump models which accounts for pump inertia
 l Using fittings and losses lumped into a pipe

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Pump Trip with Check Valve.fth

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial


Pump Trip with Check Valve

- 64 -

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 70 deg. F

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

Figure 1: Workspace for pump trip with check valve example

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

Junction Properties

 1. Reservoir J1
 a. Name = Lower Reservoir
 b. Liquid Surface Elevation = 10 feet
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 c. Liquid Surface Pressure = 0 psig
 d. Pipe Depth = 10 feet

 2. Pump J2
 a. Inlet Elevation = 0 feet
 b. Pump Model tab (Figure 2)

 i. Pump Model = Centrifugal (Rotodynamic)
 ii. Performance Curve Used in Simulation = Standard Pump Curve
 iii. Model Combined Check Valve and Pump = Checked
 iv. Forward Velocity to Close = 0 feet/sec
 v. Delta Head to Re-Open = 0 feet
 vi. Rated Pump Speed = 1760 rpm
 vii. Enter Curve Data  = (Figure 3)

Volumetric Head Power

gal/min feet hp

0 400 25

250 390 33

500 380 60

1000 340 130

 viii. Curve Fit Order = 2
 c. Transient tab (Figure 4)

 a. Transient = Trip
 b. Transient Special Condition = None
 c. Initiation of Transient = Single Event
 d. Event Type = Time Absolute
 e. Condition = Greater Than or Equal To
 f. Value = 0 seconds

 g. Total Rotating Inertia = User Estimated
 h. Value = 25 lbm-ft2
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Figure 2: Pump J2 Pump Model tab input
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Figure 3: Pump J2 performance data
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Figure 4: Transient input data for Pump J2

 3. Reservoir J3
 a. Name = Upper Reservoir
 b. Liquid Surface Elevation = 200 feet
 c. Liquid Surface Pressure = 0 psig
 d. Pipe Depth = 10 feet

Pipe Properties

 1. Pipe P1 
 a. Pipe Material = Steel - ANSI
 b. Size = 4 inch
 c. Type = STD (schedule 40)
 d. Friction Model Data Set = Standard
 e. Lengths = Use table below

Pipe Length (feet)

1 10

2 990
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The pipe model also allows for fittings and losses like valves or elbows. Select the Fittings & Losses tab 
for P2 and type in 25 for the Total K Factor. Now click OK to close the Pipe Properties window and accept 
your changes.

Note: Unless specified otherwise, pipe elevation is assumed to vary linearly between junctions. Thus 
the pipe P2 inlet elevation is 0 feet, and the exit elevation is 190 feet (because the J3 reservoir is 
10 feet deep). In between the elevation is linear. If another profile is desired, this can be entered 
on the pipe’s Optional tab in the Intermediate Pipe Elevations section.

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 30 seconds for 
the Stop Time. 

All groups should now be complete and the model is ready to run. If all groups in Analysis Setup have a 
green checkmark then Click OK and proceed. Otherwise, enter the missing information.

 Step 6. Run the Model

Click Run Model from the toolbar or from the Analysis menu. This will open the Solution Progress win-
dow. This window allows you to watch the progress of the Steady-State and Transient Solvers. When 
complete, click the Output button at the bottom of the Solution Progress window.

 Step 7. Examine the Output

The Output window will display any warnings if they exist. There should not be any warnings here. The 
Graph Results window will be more useful in understanding the results. Go to the Graph Results window.

First, graph the static pressure.

 1. On the Quick Access Panel,  on the Transient Pipe tab, add the Pipe 1 Outlet and Pipe 2 Inlet (see 
Figure 5). These represent the pump suction and discharge locations. 

 2. For Parameter, select the Pressure Static.
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 3. Set the units to psig. 
 4. Click Generate. 

The resulting pressure transients are shown in Figure 6. Here one can see that the transient pressure at 
the pump discharge does not rise above the initial steady-state pressure. This is not always the case.

Figure 5: Data selection to view the transient pump suction and discharge pressures
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Figure 6: Predicted transient pump suction and discharge pressures

Next, graph the pipeline transient pressure profile

 1. On the Quick Access Panel, select the Profile tab (Figure 7). 
 2. In the Pipes area select All to select both pipes 1 and 2. 
 3. In the Parameter area make sure Pressure Static is selected. 
 4. Set the static pressure units to psig. 
 5. Make sure boxes are checked for Mx and Mn which will plot the maximum and minimum values.
 6. Click Generate. 

Profile type graphs that show maximum and minimum values can be very helpful. In Figure 8 we see that 
the maximum transient pressure occurs at the pump discharge, and that the minimum pressure occurs 
600-700 feet downstream of the pump. Also note that minimum pressure goes below atmospheric pres-
sure for almost 400 feet of pipe. For some applications this may not be acceptable.
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Figure 7: Data selection to view the max/min pressure profile
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Figure 8: Predicted max/min pressure profiles

Finally, graph the pump speed decay.

 1. Select the Transient Jct tab on Quick Access Panel. 
 2. Add J2 (Pump) to the Graph These Junctions list on the Transient Jct tab (see Figure 9). 
 3. For the parameter to graph, make sure Speed is selected.
 4. Click Generate. 

The predicted pump speed is then shown (Figure 10).
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Figure 9: The pump speed is selected on the Transient Jct tab
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Figure 10: The pump speed decay is shown. The speed decays quickly at first, and then slows down after the 
check valve closes and the flow goes to zero
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Check Valve Modeling 

Summary

This example models the closure of the check valve in three ways for a system pumping water uphill 
loses power to the pump. The check valve is near the pump discharge. Results will be graphed to illus-
trate pressure on each side of the check valve, and animation features will be used to show the system 
pressure profile after the valve is closed.

Topics Covered

 l Modeling a check valve and fluid velocity at valve closure
 l Observing the differences between check valve models
 l Creating a system pressure profile animation

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Check Valve Modeling.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 70 deg. F

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

Figure 1: Workspace for Check Valve Example

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

For the first scenario, the simplest User Specified check valve type will be used. The Forward Velocity to 
Close Valve and Delta Head to Reopen should be obtained either from measured data, or from the data 
provided by the manufacturer. If no information is known, an estimate of 0 for both parameters may be 
used to represent an ideal check valve. However, a velocity to close of zero is not realistic, and should 
not be used for final engineering estimates. A more conservative engineering estimate would be 
achieved if some reverse flow is allowed through the check valve before it fully closes.
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Pipe Properties

 1. Pipe P1 
 a. Pipe Material = Steel - ANSI
 b. Size = 8 inch
 c. Type = STD (schedule 40)
 d. Friction Model Data Set = Standard
 e. Length = Use table below

Pipe Length (feet)

1 10

2 10

3 1000

Junction Properties

 1. Reservoir J1
 a. Name = Lower Reservoir 
 b. Liquid Surface Elevation = 10 feet
 c. Liquid Surface Pressure = 100 psig
 d. Pipe Depth = 10 feet

 2. Pump J2
 a. Inlet Elevation = 0 feet
 b. Pump Model tab (Figure 2)

 i. Pump Model = Centrifugal (Rotodynamic)
 ii. Performance Curve Used in Simulation = Standard Pump Curve
 iii. Rated Pump Speed = 1760 rpm
 iv. Enter Curve Data  = (Figure 3)

Volumetric Head Power

gal/min feet hp

0 400 36

225 375 50

450 330 64

900 260 90

 v. Curve Fit Order = 2
 c. Transient tab (Figure 4)
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 a. Transient = Trip
 b. Transient Special Condition = None
 c. Initiation of Transient = Single Event
 d. Event Type = Time Absolute
 e. Condition = Greater Than or Equal To
 f. Value = 0 seconds

 g. Total Rotating Inertia = User Estimated
 h. Value = 25 lbm-ft2

Figure 2: Pump J2 Properties Input
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Figure 3: Pump J2 Configuration Data
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Figure 4: Transient Input Data for Pump J2

 3. Check Valve J3
 a. Inlet Elevation = 0 feet
 b. Valve Model = User Specified
 c. Loss Model = Cv
 d. Full Open Cv = 1515
 e. Forward Velocity to Close Valve = -0.2 feet/sec
 f. Delta Pressure/Head to Reopen = Pressure

 g. Delta Pressure = 0 psid
 4. Reservoir J4

 a. Name = Upper Reservoir 
 b. Liquid Surface Elevation = 295 feet
 c. Liquid Surface Pressure = 100 psig
 d. Pipe Depth = 10 feet

Note: Unless specified otherwise, pipe elevation is assumed to vary linearly between junctions. There-
fore, the pipe P2 inlet elevation is 0 feet, and the exit elevation is 285 feet (because the reservoir 
is 10 feet deep). In between the elevation is linear. If another profile is desired, this can be 
entered on the pipe’s Optional tab in the Intermediate Pipe Elevations section.
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ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 30 seconds for 
the Stop Time. 

Navigate to the Transient Cavitation panel and select Discrete Gas Cavity Model, the default values that 
populate will suffice for this example.

All groups should now be complete and the model is ready to run. If all groups in Analysis Setup have a 
green checkmark then Click OK and proceed. Otherwise, enter the missing information.

 Step 6. Run the Model

Click Run Model from the toolbar or from the Analysis menu. This will open the Solution Progress win-
dow. This window allows you to watch the progress of the Steady-State and Transient Solvers. When 
complete, click the Output button at the bottom of the Solution Progress window.

 Step 7. Examine the Output

In the Output window there will be a warning shown stating that reverse flow occurs at the pump. If there 
is a high magnitude of reverse flow at the pump or the reverse flow occurs for a long duration, then we 
might want to update the pump to use four quadrant data. In this model the magnitude and duration of 
reverse flow is relatively small, so this warning will be dismissed. 

Often when a check valve is present downstream of the pump reverse flow will be negligible and reverse 
flow warnings can be dismissed; However, it is always good practice to check the volumetric flow rate res-
ults at the pump to confirm. The Selecting a Pump Four Quadrant Curve example provides more inform-
ation on how to perform a sensitivity analysis with four quadrant data if reverse flow is significant at the 
pump.

Now go to the Graph Results window by clicking the Graph Results tab.

A. Graph the check valve Cv
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To confirm the check valve's behavior create a plot of the check valve Cv over time as follows:

 1. Select the Transient Jct tab in the Graph Parameter section
 2. Add J3 (Check Valve) to be graphed
 3. Make sure Check Valve Cv is the Parameter to graph
 4. Click Generate

The check valve Cv plot can be seen in Figure 5 below. As is shown in the plot, the check valve closes 
instantly at about one second, which is the time when the velocity reaches zero at the check valve. The 
exact closure time can be seen in the Output window by selecting the Event Messages tab in the top third 
of the window. To model a slower closure a different check valve model will need to be chosen. This will 
be shown later in the example.

ØRight click on the graph and select Add Graph to List. Name this graph Check Valve Cv. Your 
graphing parameters will be saved to the Graph List Manager in the top right corner of the Graph Results 
Window. This enables you to quickly graph these same parameters in different scenarios. We will create 
scenarios for comparison later in this example.

Figure 5: Check Valve Cv vs time using the user specified check valve model

B. Graph the transient pressures at the check valve 

 1. Still on the Graph Results window, go to the Transient Pipe tab, add the Pipe 2 Outlet and Pipe 3 
Inlet. These represent each side of the check valve. 

 2. Make sure the selected parameter is Pressure Static. 
 3. Set the units to psig. 
 4. Click Generate. 

The resulting pressure transients are shown in Figure 6. It should be shown that after the valve closes, 
pressure between the pump and the check valve is brought to equilibrium while pressure after the check 
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valve will experience water hammer. The maximum and minimum values can be shown by the Show 
Cross Hair tool in the Graph Results toolbar.

ØRight click on the graph and select Add Graph to List. Name this graph Check Valve Inlet/Outlet 
Pressure.

Figure 6: Predicted transient pressures at check valve inlet and outlet

C. Graph the pipeline transient pressure profile

This animation will illustrate the static pressure throughout the pipe system over time.

 1. Select the Profile tab on the Quick Access Panel (Figure 7). 
 2. In the Pipes area click All to select pipes 1-3. 
 3. Animate Using: Solver
 4. In the Parameter area make sure Pressure Static is selected. 
 5. For units select psig. 
 6. Click Generate.

Once the graph has been generated, press the Play button on the Graph Results animation controls as is 
shown in Figure 8 to observe how the pressure profile varies over time. At around 1 second the check 
valve closes, causing the maximum pressure spike observed in the system. The resulting pressure wave 
can then be seen moving along the pipe to the reservoir and being reflected back.

Right click on the graph and select Add Graph to List. Name this graph System Pressure Profile.
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Figure 7: System Pressure Profile Parameters



Check Valve Modeling

- 86 -

Figure 8: System Pressure Profile Animation Snapshot

 Step 8. Create Child Scenarios

Often the forward velocity to close and delta pressure to reopen the check valve are not directly known 
for the system as was shown above. However, data such as a reverse velocity vs deceleration chart, or 
information on the valve dimensions may be provided. In that case either the Estimate From Fluid Decel-
eration or Force Balance check valve model may be more appropriate.

The Estimate From Fluid Deceleration model type for a check valve requires that reopening is not pos-
sible. In order to model this scenario accurately, you will need valve performance data for the maximum 
reverse velocity vs fluid deceleration. If you model a valve with a preset that does not accurately rep-
resent your system, this could yield inaccurate results.

Modeling a check valve with the force balance model is ideal for either swing check valves or nozzle/plug 
check valves where you know the weight and dimensions of your check valve.

We will create scenarios to model each of the check valve types.

Open the Scenario Manager on the Quick Access Panel. Create a child scenario by right-clicking on the 
Base Scenario and then selecting Create Child. Do this four times, naming each one after the following 
check valve model types:

 1. User Specified
 2. Estimate from Fluid Deceleration - Dimensional
 3. Estimate from Fluid Deceleration - Non-dimensional
 4. Force Balance

Load the Estimate from Fluid Deceleration - Dimensional scenario by double-clicking the scenario name.
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 Step 9. Define and Run the Estimate from Fluid Deceleration Scenarios

This modeling method is ideal for when you have Valve Performance Data / Fluid Deceleration to help 
define your check valve, or if you are using a check valve which is geometrically similar to the valves 
which have deceleration data provided in AFT Impulse (Figure 9). The valves from Ballun's data set were 
ANSI Class 125 size 8-inch valves. The data sets for Thorley were obtained using 4-inch and 12-inch 
valves. For more information on the test setups used by Ballun and Thorley see the check valve topic in 
the main help file.

A. Define the Estimate from Fluid Deceleration - Dimensional Scenario

Open J3 Check Valve properties window. Under Fluid Velocity at Valve Closure select Estimate from 
Fluid Deceleration (no reopen), as shown in Figure 9.

There are several Valve Performance Data Type options which can be selected. If you have a Decel-
eration vs Maximum Reverse Velocity chart provided by the valve manufacturer, the User Defined option 
should be selected, and the data entered. Otherwise, one of the data sets provided by Impulse can be 
used with either the Non-dimensional or Dimensional option. The dimensional option should be used if 
the valve in your system is similar in both geometry and size to the data set valve type. If your valve has 
similar geometry but is a different size than the valves tested to obtain the data set, then the Non-dimen-
sional option should be used.

The dimensional model is applicable for this example because the check valve being modeled is an 8-
inch swing-flex check valve, which is similar in both geometry and size to the Resilient Hinge DN 200 
check valve used in the Ballun data set.

Define the check valve as follows:

 1. Valve Performance Data Type = Dimensional
 2. Valve Type = Resilient Hinge DN 200 (B)
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Figure 9: Estimate From Fluid Deceleration Properties

B. Define the Estimate from Fluid Deceleration - Non-dimensional Scenario

Load the Estimate from Fluid Deceleration - Non-dimensional scenario by double-clicking the scenario 
name in the Scenario Manager.

Define the check valve as follows:

 1. Fluid Velocity at Valve Closure = Estimate from Fluid Deceleration (no reopen)
 2. Valve Performance Data Type = Non-dimensional
 3. Minimum Velocity Required to Fully Open Valve (Vo) = 6.5 feet/sec
 4. Valve Type = Resilient Hinge (B)

Note that there is a new parameter which is required to be entered when the non-dimensional valve type 
is used, the Minimum Velocity Required to Fully Open Valve (Vo). The Vo can be calculated through test-
ing, or by consulting the valve manufacturer. For the purpose of this example the Vo was obtained by 
using the dimensional and non-dimensional deceleration charts provided by the manufacturer.

C. Run and Compare Results
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Run the two Estimate from Fluid Deceleration scenarios and go to the Output window. Note that a warn-
ing is once again given for reverse flow at the pump. We will again dismiss this warning as the magnitude 
of reverse flow is low.

Next go to the Graph Results window. Regenerate each of the graphs for this scenario using the Graph 
List items by double-clicking the graph names in the Graph List Manager.

Notice that using the given information for the check valve these two models produce practically identical 
results to the user specified check valve model, since the check valve closes at a reverse velocity of 
about -0.2 feet/sec in all three scenarios. On the Event Messages by Jct tab in the Output window it can 
be seen that the forward velocity to close was actually calculated as about -0.1690 feet/sec for the dimen-
sional case and -0.1772 feet/sec for the non-dimensional case. Figure 10 below shows the Event Mes-
sages tab for the non-dimensional case.

Similar to the user specified model, the Estimate from Fluid Deceleration valve model closes the valve 
instantaneously once the calculated forward velocity to close has been reached. However, unlike the 
User Specified valve model, the fluid deceleration option will never allow the check valve to reopen, so 
this option should be used carefully.

Figure 10: The event message tab provides additional information on the fluid deceleration calculations at 
the check valve. The non-dimensional case is shown here.

 Step 10. Define the Force Balance Scenario

This modeling method is useful when you have information on the dimensions of the check valve in your 
system. This information may be available from the valve manufacturer, though in many cases it must be 
approximated. You can model swing check valves or translating nozzle check valves with the Force Bal-
ance method.

For this example we will use approximations of the valve dimensions from a schematic provided by the 
manufacturer to model the 8-inch Resilient Hinge swing check valve.

A. Enter the Check Valve Properties Data

Double click on J3 Check Valve.

 1. Fluid Velocity at Valve Closure = Force Balance
 2. Enter Force Balance Data = 

 a. Valve Type = Swing Check
 b. Distance to CG (L) = 6.45 inches
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 c. Area (A) = 108 inches2
 d. Weight (submerged, W) = 20.6 lbf
 e. Inertia (I) = 8.38 lbm-ft2
 f. Mass of Displaced Fluid = Sphere (disk diameter, recommended)

Note: Equations to approximate the submerged weight and inertia of the disk can be found in the AFT 
Impulse Help file, accessed from the ? buttons.

 e. θ when Fully Open = 10 deg
 f. θ when Fully Closed = 45 deg

 g. Valve Loss vs. Position (θ) = 

θ (deg) Cv

10 1515

45 0

Note: For this example the Valve Loss vs. Position (θ) profile was assumed to be linear. For a more 
realistic force balance detailed information should be obtained and entered for the Cv profile 
from the valve manufacturer.

Figure 11: Force Balance Data

B. Run and Compare Results
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Run the model and go to the Graph Results window.

Regenerate the pressure Check Valve Inlet/Outlet Pressure graph, as can be seen in Figure 12. Com-
pared to the other three scenarios, the force balance check valve closure produces slightly larger pres-
sure oscillations, with the amplitude of the oscillations increased by about 3 psi.

It can be seen from the check valve Cv graph (Figure 13) which displays the first 1.5 seconds of the run, 
that the check valve does not close over a single time step like in the previous scenarios, but instead 
closes rapidly over 1 second. Using a realistic Cv profile for the force balance input will allow for the most 
realistic calculation of this closing profile.

A comparison of the velocity at the check valves over the first 1.5 seconds can be seen in Figure 14. 
From the velocity graph it can be seen that the force balance check valve calculated a maximum reverse 
velocity of about -0.5 feet/sec. The higher reverse velocity when using the force balance model can likely 
be attributed to the assumptions made when entering the geometry data for the check valve. Some of the 
primary assumptions made for this example were that the Cv vs open percent profile was linear, and that 
the check valve disk was a perfect cylinder. 

Figure 12: Pressure at check valve inlet/outlet for Force Balance Model
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Figure 13: Check Valve Cv for Force Balance Model

Figure 14: Velocity at the check valve outlet for each of the check valve types plotted for the first 3 seconds

Summary

Check Valves can be modeled in multiple ways depending on the information you have available to you. 
They can be modeled as combined with the pump outlet, with user specified fluid velocity, with estimated 
fluid velocity from fluid deceleration data, or with a force balance calculation. With enough reliable data, 
you should be able to get similar results with any modeling method. 



- 93 -

Relief Valve Modeling 

Summary

A system pumping crude oil over a long distance experiences a sudden valve closure. The pump is not 
able to stop before the valve is completely closed. A relief valve will be considered for surge mitigation.

Topics Covered

 l Modeling  relief valve profiles during pressure surges
 l Examining the effect of valve rate limits on a system
 l Observing differences between relief valve profiles

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Impulse installation:

 l US - Relief Valve Modeling.imp
 l Relief Valve Modeling Pump.dat

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 a. Fluid Library = User Specified Fluid
 b. Name = Crude Oil
 c. Density = 0.85 S.G. water
 d. Dynamic Viscosity = 4 centipose
 e. Bulk Modulus = 200000 psia
 f. Vapor Pressure = 10 psia

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

We will first evaluate the system without a relief valve to see if the maximum pressure of 350 psi is 
exceeded.

Figure 1: Workspace with no relief valve added

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

Pipe Properties
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 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Size = 24 inch
 c. Type = STD (schedule 20)
 d. Friction Model Data Set = Standard
 e. Length = Use table below

Pipe Length (feet)

1 20

2 10000

3 20

4 20

Junction Properties

To define the pump, a pre-built library will be used. We will need to first connect the library as follows

 a. From the Library menu select Library Manager.
 b. At the bottom, click Add Existing Library.
 c. Browse to the Relief Valve Modeling.dat library file in the Impulse Examples folder and click 

Open. The library should now appear in the Library Browser under the name Relief Valve Model-
ing. Make sure the box is checked next to this library.

 d. Click OK to exit the Library Manager.

Now proceed with defining the junctions.

 1. J1 Reservoir
 a. Tank Model = Infinite Reservoir
 b. Liquid Surface Elevation = 10 feet
 c. Liquid Surface Pressure = 10 atm
 d. Pipe Depth = 10 feet

 2. J2 Pump
 a. Library Jct = US - Crude Oil Pump
 b. Inlet Elevation = 0 feet

Note: The Model Combined Check Valve and Pump Option is used in this example to simplify the 
model. For higher accuracy it is generally recommended to model a check valve at the pump dis-
charge using a Check Valve junction instead. See the Check Valve Modeling example for more 
information.
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Figure 2: Pump Model tab with pump information from library
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Figure 3: Pump Properties Transient Data

 3. J3 Branch
 a. Elevation = 0 feet

 4. J4 Valve
 a. Inlet Elevation = 0 feet
 b. Loss Model tab

 i. Loss Source = User Specified
 ii. Loss Model = Cv
 iii. Cv = 10000

 c. Transient tab
 i. Transient Special Condition = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values

Time (seconds) Cv

0 10000

1 2000

2 0
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Time (seconds) Cv

30 0

Figure 4: Valve Properties Transient Data

 5. J5 Assigned Pressure
 a. Elevation = 0 feet
 b. Pressure = 12 atm
 c. Pressure Specification = Stagnation

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 
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 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 30 seconds for 
the Stop Time. 

All groups should now be complete and the model is ready to run. If all groups in Analysis Setup have a 
green checkmark then Click OK and proceed. Otherwise, enter the missing information.

 Step 6. Run the Model

Click Run Model from the toolbar or from the Analysis menu. This will open the Solution Progress win-
dow. This window allows you to watch the progress of the Steady-State and Transient Solvers. When 
complete, click the Output button at the bottom of the Solution Progress window.

 Step 7. Examine the Output

The maximum pressure requirement for the line is 350 psia. A profile graph should be created to review 
the maximum pressure along the line as follows:

 1. Go to the Workspace and select all of the pipes
 2. Right-click the Workspace and select Generate Profile Graph for Pipes > Pressure Static
 3. Click Add Graph to List and name it Static Pressure Profile

The maximum/minimum pressure profile graph can be seen in Figure 5. The pressure during the tran-
sient simulation goes above the maximum pressure requirements outlined above for the majority of the 
line. To decrease the maximum pressure we will add a relief valve to the line near to the closing valve, 
which is the source of the pressure surge.
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Figure 5: Maximum/minimum pressure profile along the pipeline

 Step 8. Create Child Scenarios

We will create two scenarios to compare the model with and without a relief valve.

ØIn the Scenario Manager right-click the Base Scenario and click Create Child. Name the scenario 
No Relief Valve. Repeat this process to create a second scenario, Passive Relief Valve.

Now we will add the relief valve to the Passive Relief Valve scenario. Make sure the relief valve scenario 
is active in the Workspace by double-clicking the scenario name, then add a relief valve line as shown in 
Figure 6.
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Figure 6: Workspace with relief valve and vessel added to the line

The crude oil will need to be contained in a closed vessel at the exit of the relief valve. For this example 
we will assume that the transient is fast, thus the pressure in the closed vessel will not change during the 
transient. The surge tank junction will be used to represent the closed, pressurized vessel. If the pressure 
in the closed vessel were to change significantly during the transient, then the surge tank would not be a 
good representation of this.

Define the additional junctions and pipes as follows.

Pipe Properties

 3. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Size = 12 inch
 c. Type = STD
 d. Length = 20 feet

Junction Properties

 1. J6 Relief Valve
 a. Inlet Elevation = 0 feet
 b. Valve Model tab



Relief Valve Modeling

- 102 -

 a. Valve Model = Internal
 b. Profiles = Passive
 c. Pressure Type = Pressure
 d. Constant Backpressure (Balanced) = Checked
 e. Overpressure = 325 psia
 f. Set Pressure = 300 psia

 g. Blowdown Pressure = 250 psia
 c. Loss Model tab

 a. Loss Model = Cv (Variable)
 b. Variable Data = Linear based on setpoints
 c. Full Open Cv = 500

Note: The Ignore Relief Valve option on the Optional tab can be used to keep the relief valve closed. 
This is useful for running cases with no relief valve in the system, or where the relief valve fails 
to open without deleting the relief valve junction.

Figure 7: Relief Valve Model Properties
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 2. J7 Surge Tank
 a. Cross-Sectional Area = Constant
 b. Value = 1000 feet2
 c. Initial State of Liquid Height = Liquid Height Known (Possible Inflow/Outflow)
 d. Surface Pressure = 11 atm
 e. Initial Liquid Height = 0 feet
 f. Junction Elevation = 0 feet

Figure 8: Surge Tank Properties

 Step 9. Define the Pipe Sectioning and Output Group

New pipes were added to the model, so the model needs to be sectioned again.

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe.
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 Step 10. Run the Model

Click Run Model from the toolbar or from the Analysis menu. When complete, click the Graph Results but-
ton at the bottom of the Solution Progress window.

 Step 11. Examine the Output

Note that there is a warning about the surge tank draining because the surge tank starts with no liquid. 
Normally, this can result in liquid unrealistically entering the system since the fluid flowing out of the 
surge tank is assumed to be liquid rather than air. However, there is no reverse flow that would admit air 
into the system in this case and the results are still meaningful.

Reload the Static Pressure Profile graph item by double-clicking the graph item in the Graph List Man-
ager. The pressure profile should now appear as shown in Figure 9 below.

With the relief valve the maximum pressure reached in the pipeline is about 319 psia, which is below the 
required maximum pressure of 350 psia.

Now create a Transient Jct graph for the relief valve, and select Cv as the parameter to be graphed (Fig-
ure 10). Save this graph as Relief Valve Cv in the Graph List Manager. 

Taking a closer look at the graph it can be seen that the valve opens over about 0.2 seconds, and closes 
over about 1.7 seconds (time from maximum Cv to zero). This is by design - the relief valve should open 
quickly to reduce pressure, but close more gradually to avoid creating a pressure wave. When defining 
the relief valve for this model we did not take into account the actual closing time that will occur at the 
relief valve. We will add rate limits to the model to better account for the closing time at the valve.

Figure 9: Maximum/minimum pressure profile along the pipeline with a passive relief valve
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Figure 10: Relief valve Cv vs time

 Step 12. Add Rate Limits to the Relief Valve

A relief valve's rate limit represents the rate at which the valve can open and close. If no rate limit is 
defined for the relief valve, it is possible for the valve to open/close nearly instantaneously. An instant 
opening for a relief valve is idealized, as the high pressures can be instantly alleviated in the pipeline 
once the valve setpoint is reached. Instant closure of the relief valve would represent the worst case scen-
ario, as the rapid closure would produce the maximum pressure rise at the relief valve. In reality it is not 
physically possible for the relief valve to close in one time step. In addition, relief valve manufacturer's 
often design the valves to close slowly to avoid surge events that could occur due to a sudden closure. 
Adding rate limits allows for a more realistic representation of how fast the valve position can change 
over time.

Add rate limits to the relief valve as follows:

 1. In the Workspace window, under Scenario Manager, create a new child scenario under the 
Passive Relief Valve scenario named With Rate Limits, and load it as the active scenario.

 2. Open the properties window for Relief Valve J6.
 3. On the Loss Model tab check the boxes next to both Apply Closing Limit and Apply Opening Limit 

(Figure 11)
 4. Add a Max Closing Cv change of 150 and a Max Opening Cv change of 1500
 5. Click OK
 6. Run the Model, click on Graph Results
 7. Open your saved graph Relief Valve Cv under Graph List Manager
 8. In the Graph Parameters area in the Quick Access Panel click the Multi-scenario dropdown and 

choose Select Scenarios
 9. Select the With Rate Limits and Passive Relief Valve scenarios.
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 10. Click Generate to create the graph as shown in Figure 12.
 11. Repeat steps 7 and 8 above for the Static Pressure Profile graph, as shown in Figure 13.

In Figure 12 it can be seen that though the relief valve still opens in about 0.2 seconds, the relief valve 
now closes at a slower rate of about 3.1 seconds.

From Figure 13 it can be seen that the slower opening speed results in a higher maximum pressure in the 
pipeline since the relief valve takes longer to fully open. The longer closing time practically eliminates 
surge waves caused by the closure of the relief valve, which causes a slightly lower minimum pressure 
along the pipeline.

Figure 11: Relief Valve Loss Model tab with opening and closing rate limits defined
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Figure 12: Relief valve Cv profile with and without rate limits

Figure 13: Comparison of maximum and minimum pressures along the pipeline when the passive relief valve 
is defined with and without rate limits

 Step 13. Rupture Disk

We are now going to compare the passive valve above to a rupture disk relief valve. A rupture disk will 
burst open when the set pressure is met, and will remain open after that. The rupture disk will still relieve 
to a closed tank to keep the crude oil contained.
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Update the model as follows:

 1. In the Workspace window, under Scenario Manager, right click on the Passive Relief Valve scen-
ario and choose Clone Without Children. Name the new scenario Rupture Disk.

 2. Double click on the Relief Valve J6.
 3. In the Profiles list select Rupture Disk (Figure 14)
 4. Set Pressure (dP) = 150 psid

Note: The rupture disk will open on a pressure difference, unlike the passive relief valve which was 
defined using a fixed setpoint at which the relief valve would open. This is because the passive 
relief valve modeled previously had a mechanism to maintain a constant back-pressure on the 
valve, which is not used with the rupture disk. The pressure difference setpoint for the rupture 
disk was found by subtracting the outlet tank pressure from the desired opening pressure.

 5. In the Loss Model tab, Cv (Constant) = 300
 6. Click OK to close the window.

Figure 14: Inline Exit Rupture Disk Properties

The scenario is now complete and ready to be run.
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ØRun the Model and select Graph Results.

Load the Relief Valve Cv graph from the Graph List Manager, as is shown in Figure 15. Unlike the pass-
ive relief valve type, the rupture disk opens instantly, and remains open, as can be seen in the graph. 

Figure 15: Relief valve Cv over time for the rupture disk relief valve

Next we want to compare the pressure results for each of the relief valve types.

 1. Reload the Static Pressure Profile graph.
 2. In the Graph Parameters area in the Quick Access Panel click the Multi-scenario dropdown and 

choose Select Scenarios
 3. Select both the Rupture Disk and With Rate Limits scenarios, then click OK
 4. Click Generate to incorporate the additional scenario (Figure 16)

The rupture disk generally maintains a lower maximum pressure in the pipeline, and overall reaches a 
lower minimum pressure. This makes sense considering that the rupture disk is allowed to open instant-
aneously (over one time step), thus the pressure in the pipeline is lowered faster for that scenario. In real-
ity the rupture disk will not open instantaneously, but will still likely open faster than a passive relief valve 
type.

A lower minimum pressure occurs with the rupture disk because the rupture disk never closes.
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Figure 16: Comparison of maximum and minimum pressures with the passive and rupture disk relief valve 
types

Summary

Relief Valves provide pressure relief to systems during pressure surges. Impulse can model relief valves 
as an internal valve model, exit valve model, or inline exit valve model. An internal valve model connects 
two pipes acting as a gate providing relief from elsewhere in the system when necessary. An exit valve 
essentially models a spray nozzle at the end of a pipeline. An inline exit valve provides relief to the atmo-
sphere along the length of some piping. These valve models can be profiled in a number of ways. In this 
example we worked with graphing results with a passive profile and rupture disk profile.
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Pump Trip with Accumulator 

Summary

This example shows the effect of adding a gas accumulator to reduce the down-surge after a pump trip.

Topics Covered

 l Using accumulator junctions

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

This model is based off of the Pump Trip with Check Valve example and model, and that example should 
be worked before this one.

Model File

 l US - Pump Trip with Check Valve.imp
 l US - Pump Trip with Accumulator.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the Model

In reviewing the Pump Trip with Check Valve example it is observed that the pressure drops below atmo-
spheric pressure along about 400 feet of pipe. This example addresses the case when this is not accept-
able. To try to limit the low pressures, an accumulator will be sized and located.

From the AFT Impulse examples folder make a copy of the US - Pump Trip with Check Valve.imp 
model file and save it to a new location. This model will be used as a starting point.

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 Step 3. Define the Pipes and Junctions Group

The Pipes and Junctions group is already defined, but some modifications are warranted. The model will 
be altered to resemble Figure 1. 

Note: Instead of adding a new pipe to the Pump Trip model in order to add the accumulator, you can 
instead hold down Shift, then drag and drop the accumulator junction on the pipe to Split the 
pipe. This will allow you to add the junction, define the new length for each of the sections of 
pipe, and define which section of pipe the Fittings & Losses should be placed in.

Split pipe P2  into two pipes with a Gas Accumulator junction. For Pipe A, set the length to 50. Select Pipe 
B under Move Fittings & Losses to. Rearrange the junctions on the workspace until is resembles to figure 
below.

Figure 1: Workspace for Pump Trip With Accumulator Example

Sizing and locating accumulators is very much a trial and error method. The typical assumption is that the 
accumulator should be located as near the source of the transient as possible. In developing this 
example, the accumulator was first placed 10 feet from the pump suction. Initial gas volumes of 0.25 
feet3 up to 10 feet3 were used. The accumulator was effective in keeping the pressures in the discharge 
pipe above atmospheric, but the suction pipe, which previously had all positive pressures, now had sub-
atmospheric pressure.

Therefore the accumulator was moved further away from the pump to see if this could be avoided. It was 
therefore first located at 700 feet along pipe P2 because that was the point of minimum pressure in the 
Pump Trip With Check Valve example. Thus pipe P2 was 700 feet long and P3 was 290 feet long and the 
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pump yielded acceptable positive pressures. The accumulator was then moved closer to the pump, and 
ultimately it was discovered that placing the accumulator 50 feet downstream of the pump gave accept-
able pressures on both the pump suction and discharge piping. If this were a real system, this would have 
the added benefit of locating the accumulator near the pump, supposedly an accessible location rather 
than halfway up the side of a hill.

The system is in place but now we need to enter the input data for the Gas Accumulator junction. Double-
click the junction and enter the following data in the properties window. 

Junction Properties

 1. Gas Accumulator J4
 a. Tank Geometry = Unchecked
 b. Initial Gas Pressure = Calculate From Steady State
 c. Initial Gas Volume = Known Volume
 d. Value = 0.5 feet3
 e. Polytropic Constant in Transient = 1.2
 f. Max/Min Gas Volume = Unchecked

 g. Flow Restrictor = Unchecked
 h. Short Connector Pipe = Checked
 i. Friction Factor = 0.018
 j. Diameter = 4 inches

 k. Pipe Length = 2 feet
 l. Specify Elevation Change = Checked

 m. Elevation Change = 2 feet
 n. Junction Elevation = 10 feet
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Figure 2: Gas Accumulator window with data used for example

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

 Step 5. Run the Model

Click Run Model from the toolbar or from the Analysis menu. This will open the Solution Progress win-
dow. This window allows you to watch the progress of the Steady-State and Transient Solvers. When 
complete, click the Graph Results button at the bottom of the Solution Progress window.
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 Step 6. Examine the Output

Graph the static pressure profile for all three pipes. This is shown in Figure 3. The pressure transient at 
the pump suction and discharge are shown in Figure 4. Note that the maximum pump discharge pressure 
has increased slightly above 167 psig, the value without the accumulator. For interest, it should be men-
tioned that an initial accumulator volume of 0.5 feet3 was also used. It successfully kept all minimum pres-
sures above atmospheric, but caused the pump discharge pressure to rise up to about 180 psig. 
Although accumulators are often thought to be pressure reduction devices, they can also increase peak 
pressures. The pump speed decay is shown in Figure 5. Note how the pump speed does not decrease as 
quickly as in the Pump Trip with Check Valve example. The gas volume in the accumulator is shown in 
Figure 6.

Figure 3: Maximum and minimum pressure profile with the accumulator



Pump Trip with Accumulator

- 116 -

Figure 4: Transient pressures at pump suction and discharge

Figure 5: Pump speed decay
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Figure 6: Gas accumulator volume over time
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Pump Startup with Event Transients 

Summary

This example looks at three pump startup cases for a water transfer system. The objective is to determ-
ine the maximum pressures in the system and to assess whether the system cavitates or experiences 
sub-atmospheric pressure.

Topics Covered

 l Starting one or more pumps
 l Using steady-state and transient special condition features
 l Using event transients
 l Using Scenario Manager
 l Creating Graph Sets
 l Using animation features

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Pump Startup with Event Transient.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 60 deg. F

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

The Add/Remove Segments button on the Toolbar can be used to create the bends in pipes on the Work-
space. Note that these segments are only visual, and have no affect on the calculations.

Figure 1: Layout of water transfer system

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

For Valve J9, this valve will use what is called an event transient. This means that the time zero on the 
Transient tab is with respect to some condition occurring in the system. If the condition is never reached, 
the valve transient is never initiated. Here we want the valve to open when the pressure at J7 is sufficient 
to cause the water to flow into the J10 reservoir. Flow will occur when the pressure at J7 reaches 45 psig 
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or greater. The pressure at J7 is the same as that at the outlet of pipe P7, so we will use pipe P7 as the 
location of the event initiation.

Pipe Properties

 1. Pipe Model tab
 a. Name = Use table below
 b. Pipe Material = Steel - ANSI
 c. Size = Use table below
 d. Type = Use table below
 e. Friction Model Data Set = Standard
 f. Length = Use table below

Pipe Name Size Type Length (feet)

1 Suction Pipe Pump #1 10 inch STD (sched-
ule 40) 50

2 Discharge Pipe Pump #1 10 inch STD (sched-
ule 40) 20

3 Pipe 10 inch STD (sched-
ule 40) 20

4 Suction Pipe Pump #2 10 inch STD (sched-
ule 40) 60

5 Discharge Pipe Pump #2 10 inch STD (sched-
ule 40) 20

6 Pipe 10 inch STD (sched-
ule 40) 20

7 Pipe 16 inch STD (sched-
ule 30) 100

8 Line to Process #1 Tank 12 inch STD 250

9 Line to Process #1 Tank 12 inch STD 200

10 Line to Process #1 Tank 12 inch STD 1200

11 Line to Process #2 Tank 12 inch STD 5000

Junction Properties

 1. Reservoir J1
 a. Name = Supply Reservoir
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 20 feet



Pump Startup with Event Transients

- 121 -

 d. Liquid Surface Pressure = 0 psig
 e. Pipe Depth = 20 feet

 2. Pumps J2 & J4
 a. J2 Name = Transfer Pump #1
 b. J4 Name = Transfer Pump #2
 c. Inlet Elevation = 0 feet
 d. Pump Model tab

 i. Pump Model = Centrifugal (Rotodynamic)
 ii. Performance Curve Used in Simulation = Standard Pump Curve
 iii. Enter Curve Data = 

Volumetric Head

gal/min feet

0 150

1000 140

2000 120

 iv. Curve Fit Order = 2
 e. Configuration Data tab

 i. End of Curve Flow Rate = 4000 gal/min
 f. Optional tab

 i. Special Condition = Pump Off With Flow Through
 g. Transient tab

 i. Transient = Speed vs. Time
 ii. Transient Special Condition = None
 iii. Initiation of Transient = Time
 iv. Transient Data = Absolute Values

Time (seconds) Pump Speed (Percent)

0 0

2 100

10 100
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Figure 2: Setting up Pump Model tab for pump J2

 3. Valves J3 & J5
 a. J3 Name = Valve #1
 b. J6 Name = Valve #2
 c. Inlet Elevation = 0 feet
 d. Loss Model tab

 i. Valve Data Source = User Specified
 ii. Loss Model = Cv
 iii. Loss Source = Fixed Cv
 iv. Cv = 1000

 e. Transient tab
 i. Transient Special Condition = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values

Time (seconds) Cv

0 0

1 800
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Time (seconds) Cv

2 1000

10 1000

 f. Optional tab
 i. Special Condition = Closed

 4. Branch J6 - J8
 a. Elevation = 0 feet

 5. Valve J9
 a. Name = Valve to Process #1 Tank
 b. Inlet Elevation = 0 feet
 c. Loss Model tab

 i. Valve Data Source = User Specified
 ii. Loss Model = Cv
 iii. Loss Source = Fixed Cv
 iv. Cv = 500

 d. Optional tab
 i. Special Condition = Closed

 e. Transient tab
 i. Transient Special Condition = None
 ii. Initiation of Transient = Single Event
 iii. Event Type = Pressure Stagnation at Pipe
 iv. Condition = Greater Than
 v. Value = 45 psig
 vi. Pipe = 7 (Pipe) Outlet
 vii. Transient Data = Absolute Values

Time (seconds) Cv

0 0

2 400

3 500

10 500
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Figure 3: Specifying an event transient for valve junction

 6. Reservoir J10
 a. Name = Process #1 Tank
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 100 feet
 d. Liquid Surface Pressure = 0 psig
 e. Pipe Depth = 10 feet

 7. Reservoir J11
 a. Name = Process #2 Tank
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 10 feet
 d. Liquid Surface Pressure = 0 psig
 e. Pipe Depth = 10 feet

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 
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 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

Navigate to the Output Pipe Stations panel. To minimize run time and output file size, the default is set 
to Inlet and Outlet for all pipes. This will cause only the inlet and outlet station of each pipe to be saved to 
the output file. Data can be saved for all pipe stations or only selected stations. The selected stations are 
shown on the Stations In Output column (see Figure 4). With the list next to Change Selected Pipes To 
set to All Stations, click the All button, then click Change Selected Pipes To. This will save all pipe station 
data for all pipes, which will be useful later for animation purposes.

Figure 4: Transient Control window for water transfer system

 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 10 seconds for 
the Stop Time. 

Go to the Transient Cavitation panel and clear the check box for Model Transient Cavitation (we are 
going to ignore this until it becomes clear we need to model cavitation).

 Step 6. Create Child Scenarios

In this model we want to evaluate three pump startup cases:
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 1. Both pumps starting 
 2. One pump starts while the other pump stays off
 3. One pump starts while the other is already running

We will create three scenarios to model the three cases. Open up the Scenario Manager on the Quick 
Access Panel. Create a child scenario by either right-clicking on the Base Scenario and then selecting 
Create Child, or by first selecting the Base Scenario on the Scenario Manager on the Quick Access 
Panel and then selecting the Create Child icon. Enter the name Two Pump Start in the Create Child Scen-
ario window, and click OK. The new Two Pump Start scenario should now appear in the Scenario Man-
ager on the Quick Access Panel below the Base Scenario. Select the Base Scenario and create another 
child and call it One Pump Start. Finally create a third child called One Pump Start with One Running. 
The children scenarios should now be displayed as shown in Figure 5.

Figure 5: Scenario Manager in Quick Access Panel with three child scenarios

Since the Base Scenario already has been setup with two pumps starting, we do not need to modify the 
Two Pump Start scenario. 

Load the One Pump Start scenario by double-clicking the name in the Scenario Manager. Here we want 
to start only pump J2 and keep pump J4 off. Since pump J4 and valve J5 are off during the transient, if we 
delete their transient input data then they will stay turned off. Alternatively, we can specify that their tran-
sient data be ignored. The second option is what we will use here. 

ØOpen the J4 Pump window and on the Transient tab in the Transient Special Condition area choose 
the Ignore Transient Data option  and click OK. Do the same with the J6 Valve. This scenario is now com-
pleted.

ØLoad the Child Scenario One Pump Start with One Running. 

Here we want pump J2 to be running at 100% speed during the steady-state and transient, and to start 
pump J4. Open the properties window for J2  and select the Optional tab. Set the Special Condition to 
None. This specifies that during the steady-state the pump will be on and operate on its curve. Since this 
pump will run at 100% speed during the transient, select the Transient Data tab and set the Transient 
Special Condition to Ignore Transient Data.

We also need to change the J3 Valve junction Special Condition to None, and the Transient Special 
Condition to Ignore Transient Data.
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The third scenario is now complete.

 Step 7. Run the First Scenario

ØLoad the Two Pump Start scenario in the Scenario Manager. Select Run Model. After completion 
click Graph Results at the bottom of the Solution Progress window.

 Step 8. Examine the Output

First let's look at a pressure profile. 

 1. Select the Profile tab  on the Quick Access Panel, as shown in Figure 6.
 2. In the Pipes section click None.
 3. Select pipes 1, 2, 3, 7 and 11.
 4. Select Pressure Static as the Parameter to plot.
 5. Change the units to psig.
 6. Make sure the boxes for Mx and Mn are checked as these are the maximum and minimum values.
 7. Click Generate.

Results (shown in Figure 7) indicate that the peak pressure occurs at the pump discharge, and that the 
minimum pressure is above atmospheric at all times. 

To easily recreate this graph for the other scenarios, you can file this graph into the Graph List Manager 
at the top of the Quick Access Panel on the Graph Control tab. After the graph has been generated, click 
the Add Graph to List icon  on the Graph Results Toolbar (or by simply right-clicking on the graph itself 
and choosing Add Graph to List). Give the graph a name, such as Pressure Profile Pump #1 to Process 
Tank #2, then click OK in order to file the graph into the default My Graphs folder within the Graph List 
Manager.

The profile through the other flow paths (there are four paths altogether) can also be plotted, and similar 
conclusions are obtained. Create Graph Sets for the other three paths.
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Figure 6: Select Graph Data for creating a pressure profile
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Figure 7: Profile of the maximum and minimum pressures through Pump #1 to Process #2 Tank for Two 
Pump Start scenario

Since the maximum pressure is at the pump discharge, it is of interest here to plot the pressure vs. time 
at the pump. Go to the  Transient Jct tab on the Quick Access Panel. Add the two pumps  to the Graph 
These Junctions section. Select the Graph Parameter as Pressure Static Outlet and set the units to psig. 
Click Generate. As would be expected, both pressure transients are very similar. Results are shown in 
Figure 8. Click the Add Graph to List button on the Graph Results Toolbar (or by right-clicking on the 
graph and choosing Add Graph to List) and type the name Pump Discharge Pressures to save this graph 
to the Graph List Manager as well.

Figure 8: Pressure transient at both pump discharge locations for Two Pump Start scenario

The flow rates through the pumps are also of general interest, and can also be plotted as shown in Figure 
9 by changing the parameter being graphed to Vol. Flow Rate Outlet. Add this graph to the Graph List 
Manager as well and name it Pump Discharge Flow Rates.
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Figure 9: Flow rate transient at both pump discharge locations for Two Pump Start scenario

The flow rates into the two process tanks are of interest. On the Transient Pipe tab  add the outlet of pipes 
P10 and P11. Select to plot the Volumetric Flowrate, click Generate, and then add this graph to the 
Graph List Manager with the name Process Tank Flow Rates, then click OK. Results are shown in Figure 
10.

It should be noted that the graphs in Figure 8 and Figure 9 could also be generated by using the Tran-
sient Pipe tab to graph the static pressure and volumetric flow rate at the inlet of pipes P2 and P5.

Figure 10: Flow rate transient at process tanks for Two Pump Start scenario
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 Step 9. Animate the Results

ØLoad the pressure profile graph Pressure Profile Pump #1 to Process Tank #2 that was created in 
Step 8 from the Graph List Manager, and make the following updates, as shown in Figure 11.

 1. For Animate Using, select Output. This is where changing the output to store output data for all sta-
tions in Step 4 comes into play.

 2. Uncheck the boxes for Mx and Mn so that the maximum and minimum values will NOT be dis-
played.

Figure 11: Selecting animation in Graph Results for Two Pump Start scenario

To use the Time Animation feature in conjunction with the Use Output File option, which we are using 
here, all pipe stations need to be saved in Transient Control (Step 5). In addition, it is frequently best to 
save all time step data as well (from the Save Output to File area in the Transient Control window). We 
selected both of these. This animation option allows you to start, pause, record, restart animation and 
also allows you to slowly move forward and backward in the animation by changing one time step at a 
time.

Another animation option in Figure 11 is Solver. This option actually re-runs the Transient Solver to gen-
erate the data for animation, and thus does not need to read it from the output file. Therefore, it does not 
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require all of the data to be saved in Transient Control. This will reduce the run time of the initial sim-
ulation run, but will not have the advantage of being able to pause the animation and backup time step by 
time step to go back to the time where significant spikes start to appear.

ØClick Generate. Additional animation control features appear on the Graph Results window (Figure 
12). Press the Play button and watch the pressure waves move.

Figure 12: Animating output in Graph Results for Two Pump Start scenario

There is also animation available in the Workspace via Layers, which can be useful to see how the flow 
paths interact with each other.

ØGo to the Workspace window  and select Workspace Layers in the Quick Access Panel. Select New 
Layer, indicated by the green plus sign in the Layers section. Select Color Map/Animations and give the 
New Layer a name such as Static Pressure Animation. Open up the Layer Settings with the gear icon. 

Set the Display Mode at the top of the window to Animate, then choose the settings as follows. (Figure 
13)

 1. Color Map/Animation Layer Settings
 a. Layer Type = Animation
 b. Data Type = Absolute Values
 c. Smooth colors between pipe sections = Checked
 d. Parameter = Pressure Static
 e. Units = psig

Click Close. The Animation should now be visible on the Workspace. Note that the animation toolbar 
again appears, similar to when using Graph Animation.  It is recommended to save data for All Stations 
when creating a Workspace Layer Animation, but it is not required to do so. The Pipes to Animate section 
shows what data is being used to create the animation.

ØPress the play button to watch the pressure transients in the system.
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Figure 13: Visual Report Control settings for Visual Report Animation of static pressure

Figure 14: Visual Report Animation enabled in Visual Report window

 Step 10. Run the Other Scenarios and Graph the Results

Using Scenario manager load the other two scenarios and run them. 

In the One Pump Start With One Running scenario, it should be noted that there is a warning given for 
the pump. This is indicated by the red message in the status bar. The warning can be viewed in the top 
third section of the Output window on the Warnings tab, and states that there was reverse flow at pump 
J4. This warning message indicates that backwards flow occurred at the pump, and insufficient inform-
ation was available to perform the head calculations. It is recommended to adjust the model to better 
account for this reverse flow.

Depending on the system, there are several actions that may be appropriate. One change may be to 
adjust model inputs such as the discharge valve opening profile to prevent reverse flow to the pump. This 
is only acceptable if the changes are physically accurate for the system. Otherwise, it will be necessary to 
choose an appropriate four quadrant data set for the pump to better predict the head at reverse flow 
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conditions. See the Pump Trip With Backflow - Four Quadrant Modeling example for more information on 
specifying the pump using four quadrant data.

Note: Whenever you see caution, warning, or critical warning messages in general, you can click on 
the message itself, then hit the F1 button on the keyboard to pull up the help system in order to 
read a description of what the message means.

Results

Create graphs similar to Figure 6 through Figure 9 for each of the scenarios by double-clicking on the 
graph names in the Graph List Manager. This will reveal that the maximum pressure for the One Pump 
Start scenario occurs at the pump discharge location, similar to the first scenario, but in the One Pump 
Start With One Running scenario the maximum pressure occurs in pipe P11. Also the pressure drops 
below atmospheric, but does not reach the vapor pressure of water.

The numerical maximum pressure can be found in the Output window of each scenario and is sum-
marized in Table 1. For these cases the maximum pressures do not significantly differ from each other.

Table 1: Summary of maximum static pressure for the three cases

Case Max Pressure (psig)

Two Pumps Start 72.899

One Pump Start 71.573

One Pump Start with One Running 72.690
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Pump Trip with Four Quadrant Modeling 

Summary

This example evaluates two parallel pumps tripping in a cooling tower. Various discharge valve closure 
times are analyzed to examine the impact on the system when the valves close quickly enough to pre-
vent reverse rotation at the pump, and when the valves do not close completely before reverse rotation 
occurs in the pump.

Topics Covered

 l Specifying a pump curve and power curve in the Pump Properties window
 l Using one of the transient pump models which accounts for pump inertia
 l Using a four quadrant data set for the pump performance curve
 l Using four quadrant data to model reverse flow and reverse rotation in the pump

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Pump Trip with  Four Quadrant Modeling.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 100 deg. F

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

Figure 1: Layout of cooling system

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

Pipe Properties
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 1. Pipe Model tab
 a. Name = Use table below
 b. Pipe Material = Steel - ANSI
 c. Size = Use table below
 d. Type = Use table below
 e. Friction Model Data Set = Standard
 f. Length = Use table below

Pipe Name Size Type Length (feet)

1 Pipe 18 inch STD 40

2 Pipe 18 inch STD 40

3 Main Supply 30 inch STD 325

4 Main Return 30 inch STD 35

5 CWP-1 Suc-
tion 20 inch STD (sched-

ule 20) 10

6 CWP-1 Dis-
charge 20 inch STD (sched-

ule 20) 10

7 Pipe 20 inch STD (sched-
ule 20) 10

8 CWP-2 Suc-
tion 20 inch STD (sched-

ule 20) 10

9 CWP-2 Dis-
charge 20 inch STD (sched-

ule 20) 10

10 Pipe 20 inch STD (sched-
ule 20) 10

11 CT Return 30 inch STD 400

12 Pipe 20 inch STD (sched-
ule 20) 40

13 Pipe 20 inch STD (sched-
ule 20) 40

Junction Properties

 1. Reservoir J1 & J2
 a. J1 Name = CT #1 Basin
 b. J2 Name =  CT #2 Basin
 c. Tank Model = Infinite Reservoir
 d. Liquid Surface Elevation = 40 feet
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 e. Liquid Surface Pressure = 0 psig
 f. Pipe Depth = 4 feet

 2. Branch J3
 a. Elevation = 35 feet

 3. General Component J4
 a. Name = Surface Condenser
 b. Inlet Elevation = 0 feet
 c. Loss Model = Resistance Curve
 d. Enter Curve Data = 

Volumetric Head

gal/min feet

0 0

20000 22

40000 88

 e. Curve Fit Order = 2
 4. Branch J5 and J10

 a. Elevation = 0 feet
 5. Pumps J6 and J8

 a. J6 Name = CWP-1
 b. J8 Name = CWP-2
 c. Inlet Elevation = 0 feet
 d. Pump Model tab

 i. Pump Model = Centrifugal (Rotodynamic)
 ii. Performance Curve Used in Simulation = Standard Pump Curve
 iii. Rated Pump Speed = 1790 rpm
 iv. Enter Curve Data = 

Parameter Volumetric Head Power

Units gal/min feet hp

1 0 112 105

2 2000 108 130

3 4000 104 160

4 6000 98 190

5 8000 90 210

6 10000 78 220

7 12000 60 210
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 v. Curve Fit Order = 2

Figure 2: Pump Model tab in the Pump Properties window for J21 with a Standard Pump Curve

 v. Transient tab
 i. Transient = Trip
 ii. Transient Special Condition = None
 iii. Initiation of Transient = Single Event
 iv. Event Type = Time Absolute
 v. Condition = Greater Than or Equal To
 vi. Value = 0 seconds
 vii. Total Rotating Inertia = User Specified
 viii. Value = 140 lbm-ft2



Pump Trip with Four Quadrant Modeling

- 140 -

Figure 3: Pump Transient Data tab

Note: When reverse flow occurs at the pump, the Four Quadrant Model is recommended to obtain a 
better estimate for the head at reverse flow. To simplify the input, we will define the pump with 
the Standard Pump curve for now. We will come back later and compare these results to the 
Four Quadrant option.

 6. Valves J7 & J9
 a. J7 Name = Valve #1
 b. J9 Name = Valve #2
 c. Inlet Elevation = 0 feet
 d. Loss Model tab

 i. Valve Data Source = User Specified
 ii. Loss Model = Cv
 iii. Loss Source = Fixed Cv
 iv. Cv = 10000

 e. Transient tab
 i. Transient Special Condition = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values
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Time (seconds) Cv

0 10000

3 1000

5 0

15 0

 7. Branch J11
 a. Elevation = 50 feet

 8. Spray Discharges J12 & J13
 a. J12 Name = CT #1
 b. J13 Name = CT #2
 c. Elevation = 80 feet
 d. Loss Model = Cd Spray (Discharge Coefficient)
 e. Geometry = Spray Nozzle
 f. Exit Properties = Pressure

 g. Exit Pressure = 0 psig
 h. Cd (Discharge Coefficient) = 0.6
 i. Discharge Flow Area = 10 feet2

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 15 seconds for 
the Stop Time. 

To minimize run time and output file size, select to Save Output to File Every 10 Time Steps

 Step 6. Run the Model

Click Run Model from the toolbar or from the Analysis menu. This will open the Solution Progress win-
dow. This window allows you to watch the progress of the Steady-State and Transient Solvers. When 
complete, click the Output button at the bottom of the Solution Progress window.
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 Step 7. Examine the Output

For this model several warnings and cautions will be shown in the output. A warning is given for both 
pumps stating that the pump experienced reverse flow and was using a Standard Pump Curve, meaning 
that the zero flow head value was used to predict head and power at reverse flow. Generally if the 
reverse flow is low in magnitude and duration using the zero flow head will be a good assumption and this 
error can be dismissed. For the purpose of this example we will compare the results from this scenario to 
the results using a four quadrant curve to examine the impact on the model.

There is also a caution given that the end of curve flow was exceeded in this model. Note that in this 
model we did not explicitly define the end of curve flow, so the last flowrate entered (12,000 gal/min) was 
assumed to be the end of curve flow rate. The pump head and power curve fits will only be reliable within 
the range of data entered by the user, thus predictions at flowrates above this range will be inaccurate, 
particularly when the pump is operating at full speed. Operating beyond the end of curve is less of a con-
cern when the pump is operating at lower speeds, as is seen for the pump in this example. However, it is 
still prudent to verify that the effect of operating past the end of curve is low by using a four quadrant 
curve.

The speed of the two pumps should decay similarly. Figure 4 shows the speed decay for CWP-1. Here 
the pump speed decays quickly at first, then begins to slow after the discharge valve closes at about 5 
seconds.

The transient pressure at the pump suction and valve #1 outlet is graphed in Figure 5, with the volumetric 
flow rate at these points on the secondary axis.

Figure 4: Pump speed decay for CWP-1



Pump Trip with Four Quadrant Modeling

- 143 -

Figure 5: Transient pressures and volumetric flowrates at pump suction and discharge, and valve outlet

 Step 8. Create Child Scenarios

To check the validity of our results when using the standard pump curve with an internal check valve to 
perform the pump trip with inertia, we should now go back and run the model with the pumps specified 
using four quadrant data for comparison. We will create three children scenarios, one for the current 
pump configuration using the Standard Pump Curve, and two using a Four Quadrant Data Set.

Note: Only one four quadrant data set is chosen for this example. In an actual four quadrant analysis it 
is recommended to compare multiple four quadrant data sets to ensure that the chosen data set 
is a good fit for the pump being modeled. See the Selecting a Pump Four Quadrant Curve 
example for more information.

To do this, click Create Child on the Scenario Manager on the Quick Access Panel. Name the child Stand-
ard Pump Curve. A new scenario will appear below the Base Scenario in the scenario tree. Select the 
Base Scenario, create another child, and call it Four Quadrant BEP. We will later clone this scenario to 
create our third child scenario.

The Standard Pump Curve scenario will use the pump settings that were already defined, so no changes 
will be needed for this scenario. 

 Step 9. Define the Four Quadrant BEP Scenario

Load the Four Quadrant BEP scenario by double-clicking the item in the Scenario Manager. Open the 
Pump Properties window for pump J6.
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 1. Performance Curve Used in Simulation = Four Quadrant Curve
 2. Four Quadrant Curve = User Selected
 3. Click Specify Model
 4. Click Suggest a Data Set

 a. AFT Impulse provides multiple pre-defined Four Quadrant Data sets which are char-
acterized by specific speed. To choose a data set to use, we will first estimate the specific 
speed for the pump, which AFT Impulse will use to recommend a data set.

 5. Flow/Head Source = Calculated from Standard Pump Curve
 a. Calculated from Standard Pump Curve allows most of the data to automatically populate 

from the Pump Properties window. In this case, the pre-defined data is accurate for the 
pump.

 6. Click Calculate
 a. The Estimated Specific Speed in this case is 6,840 gpm units, and the Suggested Data Set 

is NS = 7,600 gpm units.
 7. Click Select Suggested Data Set and Close

 a. The NS = 7,600 gpm units  data set will now be selected, and the dimensionalized curve will 
be displayed against the previously entered Standard Pump Curve. (Figure 6)

Note: It is always advised to select a Preferred data set close to the pump’s specific speed when pos-
sible. An Average data set may be selected if there are no close Preferred data sets, as was 
done here.

 8. Dimensional Reference Point (DRP) = Best Efficiency Point
 h. We will select the Steady State Operating Point option later for the third scenario. 

 9. Click OK on this window, then OK on the Pump Properties window to accept the changes.
 10. Repeat the above steps for the other pump junction.
 11. The required input for this scenario is now complete.
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Figure 6: The Define Four Quadrant Model window can be used to select and view options for the dimen-
sionalized four quadrant data set
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Figure 7: The Pump Model tab defined using the Four Quadrant Curve. Note that the Flow Directional Beha-
vior section shows the pump behavior for both forwards and reverse flow and speed possibilities

 Step 10. Define the Four Quadrant SSOP Scenario

Clone the Four Quadrant BEP scenario by right-clicking the scenario name in the Scenario Manager and 
choosing Clone Without Children. Name this cloned scenario Four Quadrant SSOP. For both pumps, 
open the Pump Properties window and click Specify Model under Four Quadrant Model. Change the 
Four Quadrant Curve Dimensional Reference Point to Steady-State Operating Point, then click OK on all 
open windows to accept the changes. The required input for this scenario is now complete. 

 Step 11. Run the Model and Examine the Output

Using the Scenario Manager load each of the four quadrant scenarios and run them. In comparing the 
transient results for the two four quadrant scenarios, there are no major visible differences. Figure 8 
shows a multi-scenario graph with the pressures and volumetric flowrates for the Standard Pump Curve, 
Four Quadrant BEP and Four Quadrant SSOP scenarios. The two four quadrant scenarios produce res-
ults that are practically indistinguishable from the Standard Pump Curve results.

Comparison between the four quadrant graphs and standard pump curve graph reveals that the results 
are similar, though there is a visible difference of about 2 psig between the maximum and minimum 
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points in the four quadrant scenario graphs and the standard pump curve scenario graph. These dif-
ferences can be attributed to the larger flow oscillations that occur when the pump head is fixed to the 
zero flow head for all values of reverse flow.

Now navigate to the Output window for each of the scenarios, then select the Pump Summary tab in the 
top third section. Notice that for the Four Quadrant SSOP and standard pump curve scenarios, the 
steady-state flow rate is  10,349 gal/min, while the steady state flow rate for the BEP scenario is 10,358 
gal/min. This results from the fact that the steady state operating point option forces the four quadrant 
curve to provide the same results as the manufacturer curve during the steady state, while the BEP 
option does not. However, since the pump operates close to BEP in this scenario, the difference in 
steady state operating point is minor when compared to the Standard Pump Curve scenario.

While the difference in steady state and transient results for the two dimensional points is minor in this 
model, it may become more pronounced in other cases. This choice of dimensional reference points can 
result in a trade-off between the accuracy of steady-state and transient data, especially if the pump oper-
ates further from BEP. Further details on this topic can be found in the Selecting a Pump Four Quadrant 
Curve example, as well as the main Help file for AFT Impulse.

On the Output window Warnings tab for each four quadrant scenario, information will be given on the four 
quadrant options that are defined in the pump, as well as listing topics which provide more background 
information on four quadrant data.

Figure 8: Comparison of Pressure and volumetric flow rate transients for the Standard Pump Curve, Four 
Quadrant BEP and Four Quadrant SSOP scenarios

 Step 12. Adjust the Model

Consider the case where the valves at the discharge of the pumps cannot be closed in five seconds, but 
instead will close fully at twelve seconds. In this case the reverse flow at the pump will be significant due 
to the delay in the valve closure profile. We will need to use a four quadrant data set to analyze the 
effects of the possible reverse flow and reverse rotation in the pump, since the Standard Pump Curve 
does not have sufficient data. We will use the default selection to use the pump BEP as the dimensional 



Pump Trip with Four Quadrant Modeling

- 148 -

reference point, though using the steady state operating point as the reference point would produce sim-
ilar results.

In the Scenario Manager, select the Four Quadrant BEP scenario and create a child scenario named 12 
Sec Valve Closure. The new child scenario should now be active. The pumps will already inherit the four 
quadrant model from the Four Quadrant BEP scenario, but the valves need adjustment. For both valves, 
open the Valve Properties window, then edit the Transient Data table found on the Transient tab to reflect 
the following closure profile.

Time (seconds) Cv

0 10000

5 1000

12 0

30 0

Since the valve closure takes a longer time, it will be useful to extend the run time. 

ØOpen Analysis Setup and navigate to the Simulation Mode/Duration panel and change the Stop 
Time to 30 seconds, then click OK.

 Step 13. Run the Model

Click Run Model from the toolbar or from the Analysis menu. When complete, click the Graph Results but-
ton at the bottom of the Solution Progress window

 Step 14. Examine the Output

The pressure and flow rate results are shown in Figure 9. Note that as expected, a significant amount of 
reverse flow occurs at the pump from about 6 to 12 seconds, requiring data beyond the standard data 
which is typically used for forward flow with forward rotation at the pump. The resulting transient results 
show that the maximum pressures at the valve outlet and the pump suction have been reduced.

The pump speed decay is shown in Figure 10. Note how the pump speed decreases at a faster rate than 
Figure 4. Additionally, at about 10 seconds the pump begins to experience reverse rotation. This means 
that from 5 seconds to 10 seconds, the pump will have forward rotation with reverse flow, then from 10-
12 seconds, the pump will experience reverse flow with reverse rotation. Both of these situations can be 
accounted for using the additional information provided by the Four Quadrant Curve.
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Figure 9: Predicted transient pump suction and discharge pressures and volumetric flowrates with a 12 
second valve closure rate

Figure 10: Pump speed decay when the valves are modified to close fully at 12 seconds

Conclusion

For the valve closure of five seconds only a minimal amount of reverse flow was experienced at the 
pump. As a result, the standard pump curve was sufficient, since use of four quadrant data to accurately 
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model this reverse flow had only a small impact on the results. Additionally, the choices of using the BEP 
or Steady State Operating Point to dimensionalize the four quadrant data were shown to be very similar 
in the transient, with minor differences in the steady state operating point. Changing the valve to close 
fully at twelve seconds resulted in significant reverse flow at the pump which required four quadrant data 
to be used. It was then found that increasing the valve closure time reduced pressures at the valve and 
pump.
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Selecting a Pump Four Quadrant Curve 

Summary

During waterhammer analysis of pumping systems there is potential for the pump to operate outside of 
its normal operating region where flow, head, and speed are positive. It may be required to use a four 
quadrant pump curve in order to better predict the pump’s behavior when operating outside of this normal 
operating region. As manufacturers rarely provide four quadrant data for the pump being used, a pub-
lished four quadrant data set in dimensionless form is often chosen instead and dimensionalized to 
approximate the behavior of the actual pump being used in the system. For many cases the choice of 
four quadrant curve has a low impact on the waterhammer analysis results; however, this will not always 
be the case. This example is intended to provide the engineer with a deeper understanding of how to 
select four quadrant data sets for a waterhammer analysis, and how to evaluate the transient results pre-
dicted by the four quadrant curves.

This example considers a water transfer system for which several pump trip/valve closure cases are 
being modeled. There is a high possibility for reverse flow through the pump and reverse rotation of the 
pump impeller as the water is being pumped uphill, thus four quadrant data sets will be considered to 
model the behavior of the pump when operating with reverse flow and/or reverse rotation.

For those more interested in a quick how-to discussion and do not need in-depth discussion, consult the 
Overview of performing a sensitivity study for four quadrant analysis topic in Step 2 below.

Topics Covered

 l Selecting a four quadrant data set to analyze cases with reverse flow and/or reverse rotation at 
the pump

 l Performing sensitivity studies to assess four quadrant data selection
 l Comparison of the Best Efficiency Point (BEP) and Steady State Operating Point (SSOP) dimen-

sional reference point options

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

This example expands on the topics introduced in the Pump Trip with Backflow - Four Quadrant Model-
ing example. It is recommended to work that example first as an introduction to basic four quadrant mod-
eling concepts before working this example.

Nomenclature

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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As this is an advanced topic, a brief list of abbreviations is given here for reference.

BEP Best Efficiency Point of the standard pump curve

DRP Dimensional Reference point, reference point used to create a four quadrant curve for a 
chosen four quadrant data set

Ns Specific speed for the pump

SPC Standard pump curve – sometimes called here the Manufacturer Curve, this is the head 
and efficiency (or power) vs. flow rate curve for the actual pump in your system

SSOP Initial steady state operating point for the actual pump (from the manufacturer’s curve and 
system curve)

4QBEP Four quadrant pump curve created with reference to the BEP

4QSSOP Four quadrant pump curve created with reference to the SSOP

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Impulse installation:

 l US - Selecting a Pump Four Quadrant Curve - Initial.imp
 l US - Selecting a Pump Four Quadrant Curve - Final.imp
 l 10 Sec Valve Opening.txt
 l 10 Sec Valve Closing.txt

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the Model

Water is being provided to two different processes, represented by Tank A and Tank B, as can be seen in 
Figure 1. The system is designed to provide water to one tank at a time.

In this transfer system several pump trip scenarios will need to be analyzed which have potential to exper-
ience back flow through the pump before the emergency shut-down (ESD) valve fully closes. Different 
four quadrant data sets will be compared against the manufacturer pump curve data for each of these 
cases to help the engineer understand the sensitivity to four quadrant data set selection and the range of 
potential predictions that result. The cases are as follows:
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 1. Unplanned pump trip after the flow has been transitioned from Tank A to Tank B
 a. The pump operates far below BEP initially (about 60% BEP). Minimal reverse flow occurs 

at the pump.
 2. Unplanned pump trip after the flow has been transitioned from Tank B to Tank A

 a. The pump operates above BEP initially (about 113% BEP). Sustained reverse flow and 
reverse rotation occur at the pump.

 3. Planned pump trip and Valve B closure after Valve A fails open
 a. The pump operated at BEP initially. Sustained reverse flow and rotation occur at the pump.

Note: No pump startup cases are considered for this example, but the procedure is applicable to 
those situations as well if reverse flow does not occur during the initial steady state solution.

Figure 1: Workspace for water transfer system

We will start with a given model file that is fully defined for the transient run using the manufacturer's 
curve. Navigate to the Examples folder installed with AFT Impulse, and open the model file named US - 
Selecting a Pump Four Quadrant Curve - Initial.imp to the Case 1 - Tank A to Tank B scenario.

Note that we have four junctions with transients defined, as is denoted by the red T in the Workspace. 
These transients occur as two events. For the first event a planned switch from Tank A to Tank B occurs 
at time zero. Valve A will begin closing over ten seconds, following the transient shown in Figure 2 below. 
Valve B will begin opening at the same time over ten seconds following the reverse profile of that shown 
for Valve A. The second event happens twenty seconds into the transient run (ten seconds after the tank 
transition finishes), at which time an unplanned pump trip occurs and the ESD valve begins to close over 
seven seconds. The pump is modeled as a pump trip with inertia.
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Figure 2: Valve closure transient for Valve A

 Step 3. Understand the Need for Sensitivity Studies for Four Quadrant Analysis

When the Standard Pump Curve is used (i.e., not four quadrant data) and reverse flow occurs at a pump, 
AFT Impulse uses the zero flow value for head and power. On a graph of head vs flow this would be rep-
resented as a horizontal line for negative flows. This may be a good estimate for negative flow that either 
has a small magnitude or happens for a short duration, but using a four quadrant data set is often better 
for high magnitude or sustained reverse flow, as this method introduces less uncertainty than just assum-
ing that head and power would remain constant. Different four quadrant data sets can produce widely var-
ied results, so choosing the four quadrant data set which best fits the pump being modeled is important.

Considerations for Choosing a Four Quadrant Curve

During the four quadrant data set selection process, there are several factors that will need to be accoun-
ted for. A brief background for each metric is provided below:

 1. Pump Specific Speed: It is typically good practice to select a four quadrant data set based on the 
specific speed of the pump, as pumps with similar specific speeds will often behave similarly. 
However, the four quadrant data set with the closest reported specific speed is not always the best 
choice to represent the pump being analyzed for multiple reasons, including uncertainty in the 
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accuracy of the reported specific speed for some four quadrant data sets. Thus, comparing mul-
tiple four quadrant data sets at specific speeds close to the specific speed of the pump being ana-
lyzed is advised. Note that in Impulse, each four quadrant data set is labeled as Preferred, 
Average, or Use With Caution, indicating the apparent quality of the four quadrant data set and the 
accuracy of the reported specific speed. When possible, the Preferred data sets should be selec-
ted for use in the model, as these sets provide the most trustworthy data. Average curves may be 
used if no Preferred data sets are available at similar specific speeds to the pump being used. The 
Use With Caution data sets should only be used when there are no Preferred or Average data sets 
that have a similar specific speed to the pump in use, or if the user has previous experience with 
using that data set which gives them confidence in that data set.

 2. Comparison to Manufacturer’s Curve: The manufacturer's curve will always provide the most 
accurate prediction of the pump’s behavior while the pump is operating in the normal pumping 
zone of operation (i.e. flow in the positive direction, positive head, positive pump speed), and while 
the pump is operating within the range of flows that were tested by the manufacturer. Therefore it 
is reasonable to assume that a four quadrant data set which closely matches the manufacturer's 
curve while in the normal zone of operation will provide more accurate results than a four quadrant 
curve that shows larger differences from the manufacturer's curve in the normal pumping zone of 
operation. This comparison to the manufacturer's curve should be done for both the initial steady 
state operating point and the final operating point after all transients have died out. For this 
example we will refer to the final operating point after the transients have died out as the final 
steady state operating point. The reasoning for this will be discussed further throughout the 
example.

 3. Dimensional Reference Point (DRP): Four quadrant data is usually published as a dimen-
sionless set of data to allow it to be used for analysis with pumps besides the test pump. When 
dimensionalizing the data set for a pump, either the BEP or the SSOP may be used as the dimen-
sional reference point. Many published four quadrant data sets use the BEP as the DRP to non-
dimensionalize the data, so it seems logical that the BEP should be used as the DRP for the 
reverse transformation. However, if the pump is operating far from the BEP in the steady state, 
the initial steady state operating point predicted using the BEP as a DRP may be very different 
from the SSOP predicted from the manufacturer's curve. In that case using the SSOP as the 
DRP is useful to prevent differences from the steady state results using the manufacturer’s curve. 
However, using the SSOP as the DRP often causes large differences between the man-
ufacturer's curve and the four quadrant curve. In summary, there is often a trade-off between how 
well the four quadrant curve matches the manufacturer’s curve for the steady state and final 
steady state, so it is always advised to test both DRP options. Note that if the simulation begins 
with a significantly incorrect initial flowrate, this will impact all subsequent results in a way that may 
be difficult to assess.

Procedure for Comparing Four Quadrant Data Sets

 1. To perform the sensitivity study explained above the following steps can be taken:
 2. Create a child scenario of the scenario that is defined using the manufacturer's curve
 3. Open the Pump Properties window and select Four Quadrant Curve as the Performance Curve 

Used in Simulation
 4. Choose User Selected and click Specify Model to launch the Specify Four Quadrant Model win-

dow
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 5. Choose the desired four quadrant data set from the drop-down list at the top of the window, and 
select Best Efficiency Point as the Dimensional Reference Point. 

 6. Select OK to accept the changes
 7. Clone the current scenario and change the Dimensional Reference Point to the Steady-State 

Operating Point in the cloned scenario
 8. Repeat steps 1 - 6 for each data set to be analyzed
 9. Run all of the newly created scenarios and compare the transient results. Note that frequently res-

ults will not differ greatly among scenarios. In that case, results are not very sensitive to the spe-
cific choice of four quadrant curve. This makes the analyst’s job easier.

 10. In order to be most conservative, use the worst case predictions from among the various four 
quadrant scenarios for design purposes. 

 11. If the worst case predictions lead to excessive and/or expensive implications in design and/or 
operations, take a closer look at results. Compare each four quadrant pump curve to the man-
ufacturer’s curve at the initial steady state and, if applicable, the final steady state operating points 
to determine which scenario(s) appears to give the most accurate results. Criteria used to decide 
the most reliable four quadrant curve(s) include:

 a. Similarity of specific speed, NS – when making this comparison, be sure you have an 
accurate NS value for your pump (see discussion below for more on this)

 b. Overall agreement between the manufacturer’s curve (Standard Pump Curve) and dimen-
sionalized four quadrant curve for head and power vs. flow rate in the normal zone of pump 
operation (Impulse displays these curves for you – review the comparisons)

 c. Give more weight to the four quadrant curves which show closer agreement within the 
range of flow rates that the manufacturer tested the pump at (i.e. the range of flow rates 
that the pump curve is graphed for on the specification sheet)

 d. Give more weight to four quadrant curves which generate transient results similar to the 
Standard Pump Curve during time frames when the pump is operating in the normal zone 
of operation

 e. Give more weight to four quadrant curves Impulse categorizes as Preferred
 f. Good agreement in initial steady-state flow rates between SPC and four quadrant curve

 g. Good agreement in final steady-state flow rates between SPC and four quadrant curve – 
this not as important as agreement in initial steady-state flow rates, but should be con-
sidered

Note that there are several reasons why the engineer may choose to skip Step 10 above. One reason 
would be if the transient results for the different scenarios show only minor differences as noted in step 8 
above. In that case it would be unnecessary to determine which scenario is most accurate, as any scen-
ario will produce similar results. Another reason would be if the engineer’s analysis involves a project 
where highly conservative results are required, such as for a nuclear system. In that case the engineer 
could choose to simply use the most extreme results for the analysis for their design purposes. Note this 
means that if different scenarios produce the worst-case pressures in different areas of the model, then 
the engineer may want to use the most extreme results (e.g., highest or lowest pressure) regardless of 
scenario, rather than only using the results from one scenario.

Step 3. Run the Model with the Manufacturer's Curve

ØClick Run Model from the Toolbar or Analysis menu, then proceed to the Output window.
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Notice that two warnings are given for this scenario, one indicating that negative head rise was cal-
culated at the pump, and one indicating that reverse flow occurred at the pump. It will be easier to discuss 
these warnings by reviewing the transient head rise and flow rate at the pump.

ØGo to the Graph Results window. In the Graph List Manager on the Quick Access Panel double click 
the Head Rise and Vol Flow at Pump Outlet graph list item to load the graph shown in Figure 3. You 
should see that the flow rate remains positive for the majority of the transient, with minor reverse flow 
occurring after 27 seconds, never reaching a magnitude higher than 30 gal/min. Graphing the pump 
head rise shows that the head rise reaches zero at about 21 seconds, and is fixed at zero until around 27 
seconds. The low magnitude of reverse flow would suggest that a four quadrant curve may not be 
needed for use in this model. However, the head rise results introduce a large amount of uncertainty into 
the results, since AFT Impulse artificially fixes the head rise to zero. Using a four quadrant curve will 
allow Impulse to estimate the negative head rise which would occur at the actual pump.

Figure 3: Pump head rise and volumetric flow rate when using the manufacturer’s curve

ØReturn to the Output window and go to the Pump Summary tab (Figure 4). The BEP was calculated 
based on the user-specified power curve to be 6,115 gal/min. Note that in this case the pump is operating 
at 3,657 gal/min during the steady state, which is  59.80% of BEP. This will be an important con-
sideration when choosing a dimensional reference point for the four quadrant data set, as was discussed 
previously.

Figure 4: Steady State results for the pump calculated using the manufacturer’s curve

Quick-Access-Panel.html
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 Step 4. Choose Four Quadrant Data Sets to Analyze

A. Calculating or Estimating Specific Speed

From the first consideration above, the first step for selecting the four quadrant curve will be to determine 
the specific speed of the pump and choose a four quadrant data set accordingly. AFT Impulse has a built-
in tool to estimate the specific speed for the pump on the Specify Four Quadrant Model window if the spe-
cific speed is not available from the manufacturer.

ØCreate a child scenario of Case 1 - Tank A to Tank B named Manufacturer's Curve, this scenario 
will hold the results that were just obtained. Create another child of the Case 1 - Tank A to Tank B scen-
ario named Four Quadrant Curve. Next, open the Pump Properties window. Select Four Quadrant 
Curve, choose User Specified for the type, then click Specify Model. By clicking Suggest a Data Set 
towards the top of the window, we can see that Impulse has estimated a specific speed of 2,660 gpm 
units based on the displayed inputs (Figure 5). Looking at the specification sheet for this pump given by 
the manufacturer, the specific speed is given as 1,653 gpm units. In this case the discrepancy between 
Impulse’s calculations and the manufacturer’s calculations is due to several assumptions that were made 
in calculating each value.

The first assumption involves the impeller size for the pump. ANSI/HI 14.3.1.3.1-2019 states that the spe-
cific speed for any pump should be calculated for the pump at the maximum impeller size. Impulse will 
assume by default that the pump is untrimmed. However, for this example the impeller was trimmed. The 
specific speed estimate in Impulse can be improved by entering the trimmed and untrimmed impeller 
sizes, allowing Impulse to adjust the head and flow values using the affinity laws. 

ØSelect Trimmed under Impeller Diameter, and enter 20 inches and 18.6 inches as the maximum and 
Standard Pump Curve diameters, respectively. Click Calculate and the estimated specific speed should 
now be listed as 2,474 gpm units, as shown in Figure 6.

Another assumption contributing to this discrepancy involves the flow rate used for the calculation. 
ANSI/HI 14.3.1.3.1-2019 states that the specific speed should be calculated using the total flow through 
the pump. However, the standard does note that there is an alternate definition in industry which defines 
the specific speed as the flow rate per impeller eye. For double suction pumps (such as the pump in this 
example) this definition produces a specific speed which is reduced by 1/sqr(2), or approximately 0.707 
times the total flow definition. If the specific speed value provided by the manufacturer (1,653) is divided 
by this factor the resulting specific speed of 2,337 matches much more closely with Impulse’s estimate of 
2,474 that was just calculated, which confirms that the specific speed reported by the manufacturer was 
for the flow per impeller eye. In Impulse it is recommended to use the definition of specific speed based 
on the total flow, as this is generally more consistent with the specific speed definition used for the four 
quadrant data sets available in Impulse.

ØChoose Select Suggested Data Set and Close to accept the suggested 2,160 gpm units data set, 
which has the closest specific speed to the calculated specific speed chosen above.

Note: In cases like this where the specific speed has been provided by the manufacturer the value 
provided by the manufacturer will typically be more accurate. However, the engineer should 
verify whether the manufacturer has reported the specific speed based on the total flow or flow 
per impeller eye.
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Figure 5: Impulse can estimate the specific speed and suggest the nearest four quadrant data set in the Spe-
cify Four Quadrant window. Suggested Data sets will by default only be Preferred or Average
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Figure 6: Impulse can account for trimmed impeller pumps using the affinity laws to adjust the flow rate and 
head for calculations, as shown above

B. Setting up Four Quadrant Scenarios

We just determined that the four quadrant data set with the closest specific speed is the 2,160 gpm units 
data set. This data set is Average, so it is an acceptable candidate for use. As discussed above, it would 
also be prudent to test several other data sets with similar specific speeds. The next closest Preferred or 
Average data sets are the 1,935 gpm units and 3,300 gpm units data sets, so they will also be considered 
for use in this model.

Each of the selected data sets should now be compared to the manufacturer's curve with the data set 
dimensionalized at the BEP and the SSOP. From here on we will refer to four quadrant curves that have 
been dimensionalized using the BEP as 4QBEP curves, and four quadrant curves that have been 
dimensionalized using the SSOP as 4QSSOP curves for convenience. 

Create the scenarios for the selected four quadrant data sets as follows:

 1. In the current Four Quadrant Curve Scenario check that BEP is selected for the DRP (dimen-
sional reference point). Note that the head, efficiency, and power curves versus flow can be seen 
plotted against the Standard Pump Curve (referred to as the manufacturer’s curve for this 
example) at the bottom of this window, as shown below for head in Figure 7 and power in Figure 8.
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Note: The raw data from the graphs shown in the Specify Four Quadrant Model window (Figure 7 and 
Figure 8) can be copied using the Copy Data button at the bottom of the window to compare this 
data for all scenarios in Microsoft Excel.

 2. Select OK to accept the current settings.
 3. Rename the Four Quadrant Curve scenario in the Scenario Manager as NS 2160 4QBEP.
 4. Clone the NS 2160 4QBEP scenario to create a NS 2160 4QSSOP scenario, then change the 

Dimensional Reference Point in the cloned scenario to the Steady-State Operating Point and 
change the Sample OP value to 3657, as can be seen in Figure 9.

 5. Create cloned scenarios for the 1,935 gpm units and 3,300 gpm units four quadrant data sets, 
changing the four quadrant data set and dimensional reference points as needed. When finished 
the Scenario Manager should appear similar to Figure 10.

 6. Run all of the four quadrant scenarios so that they have results. 

Note: A batch run can be used to speed up the process of running multiple scenarios. This can be set 
up from the File menu by selecting Start Batch Run, then selecting all of the scenarios to be run 
and clicking Start Run.

Figure 7: Specify Four Quadrant window showing the Head vs Flow data for the NS = 2,160 data set dimen-
sionalized using the BEP



Selecting a Pump Four Quadrant Curve

- 162 -

Figure 8: Power vs Flow graph from the Specify Four Quadrant window for the NS = 2,160 gpm units data set 
dimensionalized using the BEP

Figure 9: Specify Four Quadrant window showing the Head vs Flow data for the NS = 2,160 data set dimen-
sionalized using the SSOP, which is 3,656 gal/min for this scenario
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Figure 10: Scenario Manager with the scenarios created for each of the four quadrant data sets dimen-
sionalized at the BEP and SSOP

C. Comparing Four Quadrant Pump Curves

If the engineer’s goal is simply to perform the most conservative analysis possible in the shortest amount 
of time, then comparing the pump curves as will be done below would be unnecessary. Instead, the 
engineer should simply proceed to compare the transient results for all four quadrant scenarios and use 
the maximum/minimum results from all cases, as was discussed at the beginning of this example.

Additionally, the below comparison may prove to be unnecessary if the transient results show negligible 
differences. However, we will compare the manufacturer’s curve and four quadrant pump curves here to 
be thorough.

Finding the actual initial and final steady state flow rates

For the next step in the sensitivity analysis we will compare all of the pump curves to the manufacturer’s 
curve at both the initial steady state operating point and the final steady state operating point, as was 
mentioned at the beginning of this example. There are two transient events that occur in this model, so in 
a sense we have two final operating points, one after each event. The final operating point for Event 1 will 
be when the flow has fully transitioned to Tank B, but Event 2 has not yet begun. The final operating point 
for Event 2 will be when the ESD valve and Valve A have fully closed, preventing flow in the system. We 
need to compare the four quadrant curves for the final operating point after Event 1, since the operating 
point at this time will affect the results for Event 2. After Event 2 the system will be at zero flow and no 
transients will occur, so this is not a point of interest for comparison.

The initial and final steady state flow rates can be found by running the manufacturer’s curve scenario, as 
was done earlier in the example. In this case we already saw that the steady state operating point for the 
pump was 3,657 gal/min (see Figure 4, actual flow rate). To find the actual final steady state after the 
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transient effects have completely dispersed create a new scenario using the manufacturer’s curve for the 
pump, and adjust the model in the workspace to reflect the final steady state. This scenario can then be 
run using Time Simulation – Steady Only from the Analysis menu, as we are only interested in determ-
ining the steady results. This predicts a flow rate of about 6,937 gal/min for the final steady state oper-
ating point.

Checking the dimensionalized curves

Each individual four quadrant curve can be compared to the manufacturer’s curve within the Specify Four 
Quadrant Model window in Impulse, as was seen above in Figure 7 and Figure 8 for the 2,160 gpm units 
data set. Each four quadrant curve will intersect the manufacturer’s curve at the dimensional reference 
point, which is shown in red (6,115 gal/min, see Figure 4 BEP). For the head, power, and efficiency 
curves we will want to check how similar the shapes of the curves are and how close they are to each 
other. Focus should be given in particular to how well the curves match near the initial and final steady 
state flow rates, as this will indicate how different those operating points will be.

When the BEP is used as the dimensional reference point, there is only one possible effective head and 
power curve for each four quadrant data set, as the BEP will not change when the system changes. 
However, if the steady state operating point is chosen then different effective head and power curves for 
each four quadrant data set will result depending on where the manufacturer’s curve operates during the 
initial steady state. Use the slider or the text box on the graph in the Specify Four Quadrant Model win-
dow to make sure that the graph is displaying the four quadrant curve for the actual steady state oper-
ating point before using the graph for comparison. The 2160 four quadrant data set dimensionalized at 
the steady state operating point identified above is shown in Figure 9.

If any four quadrant data set shows a substantial discrepancy for the initial or final steady state operating 
point, then it may be prudent to consider substituting this data set for another, in particular if the data set 
you are inspecting is marked as Average or Use With Caution. 

Pump vs System Curve Comparison

To more easily compare the curves, the operating points for the head curves are shown using a multi-
scenario pump vs. system curve that was created in Fathom 12 (Figure 11). The power curves are 
graphed in Figure 12 using Microsoft Excel. Table 1 listing the operating points shown in Figure 11 is also 
provided below for convenience. An engineer would not typically need to do this, but it is shown here to 
help reinforce the concepts discussed.

Each of the 4QBEP head curves cross the manufacturer's curve at the BEP, which is 6,115 gal/min for 
this pump as was seen in the Pump Summary in the Output window (see Figure 4, BEP). The SSOP 
curves cross the manufacturer's curve at the actual operating point (3,657 gal/min, see Figure 4 volu-
metric flow rate). Thus, the steady state flow rates will be identical between the 4QSSOP scenarios and 
the original scenario using the manufacturer's curve, unlike the 4QBEP curves. This distinction between 
the 4QSSOP and 4QBEP curves can be important because if the initial steady-state flow differs sig-
nificantly from the actual pump you are modeling, the entire simulation will be impacted. Indeed, some-
thing like a sudden valve closure which happens early in the transient can result in very different peak 
pressure predictions. For example, the BEP curve that operates furthest from the manufacturer’s curve 
for the initial steady-state is the 1935 4QBEP curve which operates at about 2,600 gal/min and 86 feet 
and is 1,000 gal/min and 7 feet below the operating point with the manufacturer’s curve.

We should also compare the final system curve to the pump curves. The final steady state will impact any 
transients that may occur later on in the simulation or after the end of the simulation, such as a sudden 
valve closure. In this case the Final System Curve represents the steady state after the first event (Valve 
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A closing and Valve B opening), but before the second event (the unplanned pump tripping while the 
ESD valve closes). Thus any large differences in the final steady state will impact the subsequent pump 
trip. It can be seen from Figure 11 below that each of the 4QBEP curves show deviations from the man-
ufacturer's curve at the Final System Curve, but the 4QSSOP curves show a much larger deviation than 
the 4QBEP curves. The 2160 4QSSOP curve differs by nearly 2,000 gal/min and 17 feet from the pre-
dicted final operating point, which could have large consequences on the peak pressures.

In Figure 12 we can see similar trends to those observed for the power curves. At the initial steady state 
the 4QSSOP curves match the manufacturer’s curve perfectly, while the 4QBEP curves deviate by vari-
ous amounts. Near the final steady state flow the 4QSSOP curves show significantly more deviation 
than the 4QBEP curves. This is likely due to the fact that the initial steady state flow is far from the final 
steady state flow.

The 2160 4QBEP curve seems to show the least overall deviation from the manufacturer’s curve in 
terms of both head and power based on these qualitative observations. However, using a 4QBEP curve 
will produce different steady state results than the manufacturer’s curve, which could be problematic. 
While the 4QSSOP curves match the steady state results perfectly, the results in the transient would 
likely provide less trustworthy results based on the large deviations they show from the manufacturer's 
curve at the final steady state system curve. To test this conclusion let's compare the transient results 
from all six four quadrant curve scenarios to the transient results using the manufacturer's curve.

Table 1: Pump head, flow, and discharge velocity at the initial and final steady state operating points as can 
be seen in Figure 11. The Manufacturer’s Curve shows the correct results, while the others are an artifact of 

the selected 4Q curve

Initial Steady-State Final Steady-State

Pump Curve Flow 
(gal/min)

Head 
(feet)

Velocity 
(feet/sec)

Flow 
(gal/min)

Head 
(feet)

Velocity 
(feet/sec)

Manufacturer's 
Curve 3,657 93.15 4.031 6,937 70.42 7.647

1935 4QBEP 2,566 86.52 2.829 7,166 72.79 7.900

1935 4QSSOP 3,657 93.15 4.031 5,465 57.14 6.025

2160 4QBEP 3,835 94.44 4.228 6,607 67.15 7.283

2160 4QSSOP 3,657 93.15 4.031 4,917 53.00 5.420

3300 4QBEP 4,320 98.25 4.763 6,740 68.45 7.430

3300 4QSSOP 3,657 93.15 4.031 5,023 53.77 5.538
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Figure 11: Pump vs. System Curve plot showing the manufacturer provided pump curve compared to pump 
curves from the NS = 1935, NS = 2160, and NS = 3300 four quadrant data sets at both the initial and final 

steady state conditions in Case 1
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Figure 12: Pump Power Curve plot showing the manufacturer provided power curve compared to power 
curves from the NS = 1935, NS = 2160, and NS = 3300 four quadrant data sets at both the initial and final 

steady state conditions in Case 1

 Step 5. Compare the Transient Results

We now want to compare the results to see how sensitive the results are to the choice of pump curve 
used for the simulation. 

First go to the Output window for any of the four quadrant scenarios. Note that when any of the four quad-
rant scenarios are run, several information items will be given in the Warnings tab of the Output window. 
These messages are meant to inform the user of the potential implications that the four quadrant curves 
may have for the model, which this example explains in detail.

Now go to the Graph Results window and generate a graph of the pump speed and the velocity at the 
pump outlet, as can be seen in Figure 13 and Figure 14 below. From Figure 13 we can see that the pump 
does not reach zero speed during the transient simulation, meaning that the pump does not experience 
reverse rotation. In Figure 14 the velocity results at the outlet of the pump are compared. Recall from 
Step 3 that reverse flow occurs at the pump at around 27 seconds, though the magnitude of reverse flow 
was minor. In addition, during Step 3 we found that negative head rise would occur at the pump starting 
at 21 seconds. Since the pump operates at positive speed, positive flow and positive head for the first 21 
seconds of the transient, the manufacturer’s curve will produce the most accurate results during this 
time. Therefore, the four quadrant curve results can be compared directly to the manufacturer’s curve res-
ults to determine the error in the four quadrant curve results up to 21 seconds into the transient run. After 
21 seconds one of the four quadrant curves will likely give more accurate results.

For this case there is a clear difference between the initial steady state velocity (at time zero) using the 
manufacturer’s curve and the steady-state velocities using the 3300 4QBEP and 2160 4QBEP curves. 



Selecting a Pump Four Quadrant Curve

- 168 -

However, as the tank transition causes the flow to increase at the pump, the velocity results for the 
4QBEP curves become closer to the results from the manufacturer’s curve, while the 4QSSOP curves 
diverge. Notice that at 20 seconds when the pump trip and ESD valve closure transients begin, the 
4QSSOP curves now show a large difference from the manufacturer’s curve. The 2160 4QSSOP 
curve shows the largest difference from the manufacturer’s curve, with a difference of about 2.5 feet/sec. 
The initial velocities in Figure 14 should and do match those shown in the Figure 11 (and Table 1) steady-
state results.

The static pressure at the ESD valve outlet is shown in Figure 15, with the maximum and minimum pres-
sures detailed in Table 2. We can see that the maximum and minimum pressures at the ESD valve occur 
once the ESD valve has fully closed after 27 seconds. The 4QSSOP pressure results experience sig-
nificantly decreased peak pressures and do not experience the low pressure peaks that are seen at 
about 27 and 28.5 seconds for the other Case 1 scenarios.

For example, consider the 2160 4QSSOP results, which we noted showed the largest difference in the 
velocity results when compared to the manufacturer’s curve at time 20 seconds. The 2160 4QSSOP 
curve has a maximum pressure of about 174 psia, as compared to the 238 psia peak pressure for the 
manufacturer’s curve (See Table 2 below). At about 27 seconds a low pressure of 80 psia is calculated 
using the manufacturer’s curve, while the 2160 4QSSOP curve remains at a pressure of 146 psia.

This difference in results makes sense based on the large differences from the manufacturer's curve at 
the final system curve, as were shown in Figure 11. Note for completeness that the Figure 11 final steady 
state values would compare most precisely to the Impulse results if the transient was run longer and the 
unplanned pump trip at 20 seconds did not occur. In other words, the waterhammer transients need to all 
die out for Impulse to find the true, final steady state. We can see in Figure 14 at 20 seconds that the tran-
sient velocity has roughly but not completely steadied out.

Overall for Case 1 where negligible reverse flow occurs at the pump, we can see that the large dif-
ferences observed between the 4QSSOP curves and the manufacturer’s curve at the final steady state 
resulted in large variation in the results, especially for the pressures at the ESD valve outlet. The dif-
ferences in the steady state results for the 4QBEP curves did not result in significant error in the tran-
sient results for this case due to the fact that the valve closures during the first transient event were not 
sensitive to the steady state results. In this case one of the 4QBEP curves would be the best choice out 
of the four quadrant curves analyzed as Case 1 is much more sensitive to the final steady state con-
ditions (i.e., at 20 seconds before the pump trips) than it is to the initial steady state.
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Table 2: Maximum and minimum static pressures at ESD valve and time at which the pressures occur for 
Case 1. Note that the results for the manufacturer’s curve are suspect after 21 seconds per the discussion 

above

Max. Static 
Pressure

Max. Static 
Pressure 

Time

Min. Static 
Pressure

Min Static 
Pressure 

Time

Pump Curve psia seconds psia seconds

Manufacturer's 
Curve 233.8 27.85 85.92 27.02

Ns 1935 
4QBEP 222.2 27.85 97.42 27.02

Ns 1935 
4QSSOP 185.0 0.00 131.0 20.85

Ns 2160 
4QBEP 218.2 27.85 101.4 27.02

Ns 2160 
4QSSOP 185.0 0.00 139.7 21.70

Ns 3300 
4QBEP 230.7 27.85 88.96 27.02

Ns 3300 
4QSSOP 185.7 27.85 134.1 27.02
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Figure 13: Pump speed vs time for Case 1 using the manufacturer's curve and each of the four quadrant 
curve scenarios

Figure 14: Velocity at pump outlet for Case 1 using the manufacturer's curve and each of the four quadrant 
curve scenarios
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Figure 15: Static pressure at ESD Valve outlet for Case 1 using the manufacturer's curve and each of the four 
quadrant curve scenarios

 Step 6. Case 2 - Tank B to Tank A

Case 1 operated in the normal pumping zone of operation (positive speed, head and flow) for the majority 
of the run, so four quadrant data was only required for the analysis of the results when the pump exper-
ienced negative head. Case 2 and Case 3 may experience more extensive negative flow, speed, and/or 
head at the pump requiring further use of four quadrant methods. 

A. Create Scenarios for Case 2

For Case 2 the system starts with flow to Tank B during the steady state. The flow then transitions from 
Tank B to Tank A over ten seconds. At twenty seconds into the transient, the pump trips and the ESD 
valve closes, as occurred in Case 1.

Let's create scenarios for Case 2 and repeat the analysis above. Do the following:

 1. Right-click the Case 1 - Tank A to Tank B scenario and select Clone With Children. Rename the 
scenario to Case 2 - Tank B to Tank A

 2. Open the Valve Properties window for Valve A (J5). We will need to set this valve to begin closed, 
and open over ten seconds.

 3. On the Optional tab set the Special Condition to Closed
 4. Go to the Transient tab. Under the Transient Data menu select Import from File from the drop-

down menu, then browse to 10 Sec Valve Opening.txt in the Impulse Examples folder
 5. Select Tab as the Separator, then click OK. The data should now start with Cv = 0 at time 0, and 

open to Cv = 6000 at 10 seconds
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 6. Now open the Valve Properties window for Valve B. This valve will need to begin open, then close 
over 10 seconds.

 7. On the Optional tab set the Special Condition to None
 8. Go to the Transient tab. Under the Transient Data menu select Import from File from the drop-

down menu, then browse to 10 Sec Valve Closing.txt in the Impulse Examples folder
 9. Select Tab as the Separator, then click OK. The data should now start with Cv = 60000 at time 0, 

and close to Cv = 0 at 10 seconds. The Cv vs. time data should be the same as shown earlier in 
Figure 2 for Case 1, Valve A.

B. Compare Four Quadrant Curves to Manufacturer's Curve

Now that the scenario is fully defined, let's examine the results for the model using the manufacturer's 
curve.

ØRun the Case 2 - Tank B to Tank A scenario from the shortcut on the toolbar, or from the Analysis 
menu, and go to the Output window.

There will be several warnings visible for this scenario. A warning is given for reverse flow at the pump. If 
we were to graph the flow rate at the pump as was done for Case 1 we would see that a significant mag-
nitude of reverse flow occurs towards the end of the transient run, thus it would be wise to use four quad-
rant data for this case. This is discussed further in Step 6-C.

Warnings are also given that the static pressure is lower than the vapor pressure at several pipe stations. 
This warning is given because cavitation modeling was disabled in the Transient Control window in order 
to decrease the run time for this model. When cavitation modeling is disabled the pressure is allowed to 
drop below an absolute pressure of zero. Though this is not realistic, we will leave cavitation modeling dis-
abled to simplify the model for the purpose of this example – as well as to better be able to see the impact 
on low pressures from different pump curve choices. This can be done as the cavitation in this model is 
minor and has a low impact on the pressure results. When modeling an actual system the cavitation mod-
eling should be turned on in Transient Control in order to obtain more realistic results.

ØGo to the Pump Summary tab. For this case the pump is operating at 6,935 gal/min, which is 113.4% 
of the BEP (Figure 16).

Figure 16: Steady State results for the pump calculated using the manufacturer’s curve for Case 2

As was done in Step 4-C for Case 1, let's compare the manufacturer's pump curve to the dimen-
sionalized four quadrant curves. It will again be useful to compare the pump curves to both the initial 
steady state, and the final steady state for the system after the tank transition and before the pump trips. 
Note that the final steady state for Case 2 will be equivalent to the initial steady state for Case 1, which 
means the final steady state operating point for Case 2 occurs at a flow rate of 3,657 gal/min.

A multi-scenario pump vs. system curve graph was generated in AFT Fathom for Case 2, as can be seen 
in Figure 17, with the operating points from Figure 17 shown in Table 3. The power curves for each of the 
scenarios can be seen in Figure 18.
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In this case the pump operates much closer to BEP, resulting in fewer differences between the 
4QSSOP curves and the 4QBEP curves. All of the four quadrant pump head curves intersect the initial 
steady state system curve close to the manufacturer's curve, though the 4QBEP curves do show minor 
differences in the steady state operating point. At the final system curve there is not a clear trend when 
comparing the 4QSSOP and 4QBEP curves. Instead the curves are grouped based on the specific 
speed, rather than dimensional operating point. Both 2160 curves appear to be closer to the final steady 
state operating point than the other curves.

Another point of interest is that the 1935 4QSSOP curve falls below the final system curve at low 
flowrates. This means that the 1935 4QSSOP curve predicts the pump provides insufficient head to 
overcome the system resistance at this time, even though the manufacturer's curve shows otherwise.

The comparison of the power curves again shows similar trends. In this case it is difficult to determine 
qualitatively which four quadrant data set best matches the manufacturer curve, though the 3300 curves 
clearly show the most deviations.

If looking for the most reliable four quadrant curve in this case, one of the 2160 data sets should be 
chosen due to the closer match that the 2160 curves show at the final steady state for the head and 
power curves. If the system is sensitive to the initial steady state then the 2160 4QSSOP curve should 
be chosen.

Table 3: Pump head, flow, and discharge velocity at the initial and final steady state operating points as can 
be seen in Figure 17

Initial Steady-State Final Steady-State

Pump Curve Flow 
(gal/min)

Head 
(feet)

Velocity 
(feet/sec)

Flow 
(gal/min)

Head 
(feet)

Velocity 
(feet/sec)

Manufacturer's 
Curve 6,935 70.44 7.645 3,658 93.14 4.033

1935 4QBEP 7,165 72.79 7.899 2,566 86.56 2.829

1935 4QSSOP 6,935 70.44 7.645 -111 80.32 -0.122

2160 4QBEP 6,605 67.19 7.281 3,836 94.43 4.229

2160 4QSSOP 6,935 70.44 7.645 3,617 92.85 3.987

3300 4QBEP 6,738 68.48 7.427 4,321 98.24 4.764

3300 4QSSOP 6,935 70.44 7.645 4,189 97.16 4.618
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Figure 17: Pump vs. System Curve plot showing the manufacturer provided pump curve compared to pump 
curves from the NS = 1935, NS = 2160, and NS = 3300 four quadrant data sets at both the initial and final 

steady state conditions in Case 2
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Figure 18: Pump Power Curve plot showing the manufacturer provided power curve compared to power 
curves from the NS = 1935, NS = 2160, and NS = 3300 four quadrant data sets at both the initial and final 

steady state conditions in Case 2

C. Examine Transient Results for Case 2

ØRun each of the four quadrant scenarios using the batch run feature from the file menu, then pro-
ceed to the Graph Results window.

From the pump speed and velocity graphs in Figure 19 and Figure 20 it can be seen that the pump will 
operate in the normal pumping zone of operation with both forwards flow and positive speed up until 
about 10 seconds into the transient. Depending on the pump curve being used, the pump experiences 
some reverse flow between 10 seconds and 27 seconds, though most (but not all) of the pump curve res-
ults return to forward flow before reversing again. From the pump speed curve we can see that all of the 
four quadrant curves predict that the pump will begin to operate at negative speeds (reverse rotation) 
between 24 - 26 seconds. This means that for the time period between 24 - 27 seconds the pump will 
likely operate with both reverse flow and rotation. There is a high level of uncertainty when using the man-
ufacturer's curve due to the magnitude and duration of reverse flow and reverse rotation, so the man-
ufacturer’s curve should not be used as a measure of accuracy once the flow becomes negative (at 
about 10 seconds), and especially during negative rotation.

Note: When the Standard Pump Curve option is used to model a pump in Impulse, the speed will not 
be allowed to go below 0%, similar to how the head rise was limited to a minimum of 0 in Case 1 
when the SPC was used.
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Further examining the velocity at the pump we can see that there is less deviation in the initial velocity for 
each of the curves. In this case this is due to the pump operating closer to the BEP than Case 1. 
However, the distribution of velocities is much broader once the tank transition has finished at around 10 
seconds, reflecting the broader distribution we observed in the pump head curves. A maximum dif-
ference of 5 feet/second occurs at 20 seconds into the run between the 3300 4QBEP and 1935 
4QSSOP curves. If a different transient than a pump trip was modeled at 20 seconds, for example a 
near instant valve closure of the ESD valve, then wildly different pressure transients would result.

Figure 21 shows the pressure results at the outlet of the ESD valve for the pump trip case, while Table 4 
details the maximum and minimum pressures shown in the graph. The range of peak pressures pre-
dicted using the four quadrant curves at 27 seconds has been reduced from about 65 psia to 50 psia 
likely as a result of the four quadrant curves being more similar when the pump operates closer to BEP. 
The highest peak pressure of 394 psia is predicted by the 1935 4QSSOP curve, and the lowest peak 
pressure of 342 psia is predicted by the 2160 4QBEP curve.

Zooming in on the minimum pressures that occur at about 28 seconds and 30 seconds into the run 
(shown in Figure 22) shows that the 2160 4QBEP curve and 3300 4QBEP curves predict a minimum 
pressure of about 20 psia, the 2160 4QSSOP and 3300 4QSSOP curves predict pressures below atmo-
spheric pressure but above vapor pressure (0.25 psia), and the manufacturer’s curve and 1935 curves' 
pressure results actually drop to vapor pressure (The Figure 22 results actually shows these pressures 
as negative absolute pressures because transient cavitation is being neglected here for exploratory pur-
poses. If this were a real analysis, other runs with transient cavitation models enabled would be highly 
recommended.) This range of pressure results highlights another reason why the choice of four quadrant 
curve to be used is important in waterhammer analysis, as this result will impact the decision of what pro-
tective equipment may be required for the system.

Be aware that the ESD valve pressures do not represent the overall maximum/minimum pressures for 
the system in this case. Many of the Case 2 scenarios actually reach vapor pressure at the outlet of Valve 
B, even the scenarios which did not drop to vapor pressure at the ESD valve. In an actual analysis the 
engineer would need to assess the impact of cavitation on the model and consider mitigation such as 
alternate valve closure times/profiles or installing protective equipment, though this will not be discussed 
further in this example.

To be conservative the engineer could simply choose the extreme case, which would be the 1935 
4QSSOP scenario. For higher accuracy results further comparison of the four quadrant data sets to the 
manufacturer’s curve could be done as was described in Step 6-B. From step 6-B the two 2160 curves 
were determined to be the best fit. The 2160 4QSSOP pump curve may be the better option since it 
gave more extreme results than the 2160 4QBEP pump curve in this case.
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Table 4: Maximum and minimum static pressures at ESD valve and time at which the pressures occur for 
Case 2 as shown in Figure 21 and Figure 22 below. Note that minimum pressures below absolute zero are not 

physically possible but are shown for comparison purposes

Max. Static 
Pressure

Max. Static 
Pressure Time

Min. Static 
Pressure

Min Static 
Pressure 

Time

Pump Curve psia seconds psia seconds

Manufacturer's 
Curve 394.4 27.01 -33.79 27.85

1935 4QBEP 379.1 27.01 -18.69 27.85

1935 4QSSOP 397.8 27.01 -37.19 27.85

2160 4QBEP 347.5 27.01 -9.90 10.00

2160 4QSSOP 360.0 27.01 -9.07 10.00

3300 4QBEP 349.0 27.02 -13.93 10.00

3300 4QSSOP 356.4 27.01 -12.86 10.00

Figure 19: Pump speed vs time for Case 2 using the manufacturer's curve and each of the four quadrant 
curve scenarios
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Figure 20: Velocity at pump outlet for Case 2 using the manufacturer's curve and each of the four quadrant 
curve scenarios

Figure 21: Static pressure at ESD Valve outlet for Case 2 using the manufacturer's curve and each of the four 
quadrant curve scenarios
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Figure 22: Static pressure at ESD Valve outlet for Case 2 using the manufacturer's curve and each of the four 
quadrant curve scenarios from 25 to 30 seconds

 Step 7. Case 3 - Valve A Fails Open

A. Create Case Scenarios for Case 3

For Case 3, consider the scenario where flow is being transitioned to Tank B, like in Case 1. However, 
Valve A malfunctions and is stuck fully open so that Valve A and Valve B are fully open. In this case the 
elevation differences between Tank A and Tank B would cause Tank A to begin draining. To prevent 
Tank A from fully draining both the ESD valve and Valve B will be closed, and the pump will be inten-
tionally tripped at the same time to bring the system to a safe stop so the Valve A malfunction can be 
investigated.

Make the following changes in the model:

 1. In the Scenario Manager right-click on the Case 2 - Tank B to Tank A scenario and choose Clone 
With Children. Rename the scenario Case 3 - Valve A Fails.

 2. Open the Properties window for Pump J2 and go to the Transient Tab. Under Initiation of Tran-
sient change the Time Absolute to 0 seconds so that the pump trip will begin at the beginning of 
the run.

 3. Repeat step 2 for the ESD Valve, junction J3.
 4. Open the Valve Properties window for Valve A, junction J5. This valve will need to be set to be 

open, and remain open throughout the transient.
 5. On the Optional Tab, set the Special Condition to None.
 6. On the Transient tab set the Transient Special Condition to Ignore Transient Data. This will allow 

us to keep the transient data entered, but prevent the transient from being used for this scenario.
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B. Compare four quadrant curves to manufacturer's curve

Now that the scenario is fully defined, let's examine the results for the model using the manufacturer's 
curve.

ØRun the Case 3 - Valve A Fails scenario from the shortcut on the toolbar, or from the Analysis menu, 
and go to the Output window.

Once more we will see a warning indicating that the pump did experience reverse flow, which suggests a 
four quadrant curve should be used. Warnings will also be given for the transient static pressure, as were 
discussed for Case 2. Lastly, cautions will be given for reverse flow through junctions 5 and 7. These cau-
tions occur since the loss factors through these junctions were entered assuming the losses were for for-
wards flow through the junctions, and may be inaccurate when reverse flow occurs. We will assume the 
difference is negligible in this case, though this should be verified for actual analysis.

In the Pump Summary at the top of the window, we can see that the pump operates at 100.2% of BEP. 

In the Pipes section of the Output click the Pipes tab to view the steady state results for the pipes. Here 
we can see that pipes P4 through P6 experience reverse flow at the beginning of the run when both 
Valve A and Valve B are open, as is expected.

For this scenario the final steady state after the transient is when the pump has tripped and both Valve A 
and Valve B are closed. This is not meaningful for comparison as all flows will be zero, so the four quad-
rant pump head curves were simply compared to the initial steady state for the system, as is shown in Fig-
ure 23. The power curves can be seen in Figure 24.

As expected the 4QBEP and 4QSSOP curves for each value of specific speed are identical when oper-
ating at BEP, so we essentially only need to compare the manufacturer’s curve to 3 four quadrant 
curves. Since the BEP stays the same in all scenarios, the BEP curves are the same as in the other 
cases. Thus our conclusions are similar to the conclusions from Case 2. It is clear that the head and 
power curves for the 1935 and 2160 data sets resemble the manufacturer’s curves better than the 3300 
head and power curve. Hence more weight should be given to the results from the 1935 and 2160 curves 
than the 3300 curve. Between the 1935 and 2160 curve, the 1935 curve seems closer to the man-
ufacturer curve than the 2160 curve in head, but the 2160 curve is a better match for the power curve. 
Since the 1935 curve is Preferred while the 2160 curve is Average, the 1935 curve may be a better 
choice, even though the qualitative comparison showed a similar match for the curves.
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Figure 23: Pump vs. System Curve plot showing the manufacturer provided pump curve compared to pump 
curves from the NS = 1935, NS = 2160, and NS = 3300 four quadrant data sets at the initial steady state con-

ditions in Case 3
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Figure 24: Pump Power Curve plot showing the manufacturer provided power curve compared to power 
curves from the NS = 1935, NS = 2160, and NS = 3300 four quadrant data sets at the initial steady state con-

ditions in Case 3

C. Examine transient results for Case 3

From Figure 25 and Figure 26 below it is clear that the four quadrant results diverge from the man-
ufacturer's curve due to backwards flow beginning at the pump at about 3 seconds, and reverse rotation 
beginning at around 6 - 7 seconds, depending on the four quadrant curve. In Figure 27 we can see a com-
parison of the pressure results at the outlet of the ESD valve.

While the pump speed results show a significant difference between the scenarios, the velocity results at 
the pump and the pressure results at the outlet of the ESD valve show relatively minor differences 
between the four quadrant scenarios. The 1935 pump curve produces the highest magnitude of reverse 
velocity out of the four quadrant curves with a minimum velocity of -3.3 feet/second (i.e. a maximum 
reverse velocity of 3.3 feet/second). This larger reverse velocity translates to a slightly larger peak pres-
sure.

When the manufacturer’s curve results are compared to the four quadrant curves, we can see that the dif-
ference in reverse velocity is between 0.5 to 0.8 feet/sec, depending on which four quadrant results are 
being compared to the manufacturer’s curve results. This difference of velocity is reflected in a 10 psi dif-
ference from the maximum and minimum pressures predicted by the four quadrant curves. 

As with Case 2 it should be noted that the ESD valve does not represent the overall maximum/minimum 
pressures for this model, which instead occur at Valve B. Cavitation is predicted at Valve B, so the engin-
eer would be required to address the low pressures at Valve B based on the requirements for this sys-
tem.
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Figure 25: Pump speed vs time for Case 3 using the manufacturer's curve and each of the four quadrant 
curve scenarios

Figure 26: Velocity at pump outlet for Case 3 using the manufacturer's curve and each of the four quadrant 
curve scenarios
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Figure 27: Static pressure at ESD Valve outlet for Case 3 using the manufacturer's curve (shown in black) 
and each of the four quadrant curve scenarios, which all overlap at the green curve

Conclusion

In this example three different pump trip scenarios were analyzed for a water transfer system in which 
there was potential for reverse flow and reverse rotation to occur at the pump. Four quadrant data was 
considered for use to accurately account for this potential reverse flow/rotation.

In situations such as with Case 1 the reverse flow was negligible, but the pump experienced negative 
head, requiring the engineer to consider four quadrant data. The manufacturer’s curve was considered 
most accurate up until 21 seconds into the run when negative head was calculated at the pump. 

In Case 2 and Case 3 where the reverse flow and reverse rotation was significant in duration and mag-
nitude, the four quadrant curves allowed for more accurate results to be found. By comparing the pump 
head and power curves to the curve data from the manufacturer four quadrant data sets could be selec-
ted for the analysis based on the initial steady state, and final steady state where applicable.

From the results above it is clear that the choice of four quadrant data set and dimensional reference 
point can have a large impact on transient results. Note that while a pump operating closer to BEP will 
typically be less impacted by the choice of dimensional reference point, this will not always be the case. 
Performing a sensitivity analysis such as what was described in this example will allow the engineer to 
determine the impact that using different four quadrant data sets and dimensional reference points will 
have on the results of the transient simulation. 
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Pump with Variable Speed Flow Control 

Summary

A pump with a variable speed drive for flow control supplies water to two heat exchangers. The flow to 
one of the exchangers is turned off, and the controlled pump flow rate is reduced by half over five 
seconds.

Topics Covered

 l Using a variable speed controller on a pump
 l Modeling a controlled flow rate transient for a pump

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Pump with Variable Speed Flow Control.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 100 deg. F

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

Figure 1: Layout of cooling system with variable speed drive

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

Pipe Properties

 1. Pipe Model tab
 a. Name = Use table below
 b. Pipe Material = Steel - ANSI
 c. Size = Use table below
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 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length = Use table below

Pipe Name Size Length 
(feet)

1 Pump Suction 
Pipe 10 inch 30

2 Pump Dis-
charge Pipe 10 inch 500

3 Pipe 8 inch 5

4 Pipe 8 inch 5

5 Pipe 8 inch 10

6 Pipe 8 inch 5

7 Pipe 8 inch 5

8 Pipe 8 inch 10

9 Pipe 10 inch 500

Junction Properties

 1. Reservoir J1
 a. Name = Cooling Pond
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 20 feet
 d. Liquid Surface Pressure = 0 psig
 e. Pipe Depth = 20 feet

 2. Pump J2
 a. Name = Main Pump
 b. Inlet Elevation = 0 feet
 c. Pump Model tab

 i. Pump Model = Centrifugal (Rotodynamic)
 ii. Performance Curve Used in Simulation = Standard Pump Curve
 iii. Enter Curve Data

Volumetric Head

gal/min feet

0 60

2000 55
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Volumetric Head

gal/min feet

4000 40

5000 30

 iv. Curve Fit Order = 2
 d. Variable Speed tab

 i. Pump Speed = Controlled Pump (Variable Speed)
 ii. Selection = Volumetric Flow Rate
 iii. Control Setpoint = 2000 gal/min

 e. Transient tab
 i. Transient = Setpoint vs. Time
 ii. Transient Special Condition = None
 iii. Initiation of Transient = Time
 iv. Transient Data = Absolute Values

Time (seconds) Vol. Flow (gal/min)

0 2000

5 1000

10 1000

 3. Branches J3 & J8
 a. Elevation = 0 feet

 4. Valve J4
 a. Name = Valve #1
 b. Inlet Elevation = 0 feet
 c. Cv = 500

 5. General Components J5 & J7
 a. J5 Name = Heat Exchanger #1
 b. J7 Name = Heat Exchanger #2
 c. Inlet Elevation = 0 feet
 d. Loss Model = Resistance Curve
 e. Enter Curve Data = 

Volumetric Head

gal/min feet

0 0

1000 20

2000 80
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 f. Curve Fit Order = 2
 6. Valve J6

 a. Name = Valve #2
 b. Inlet Elevation = 0 feet
 c. Loss Model tab

 i. Cv = 500
 d. Transient tab

 i. Transient Special Conditions = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values

Time (seconds) Cv

0 500

0.5 100

1 0

10 0

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 10 seconds for 
the Stop Time. 

 Step 6. Run the Model

Click Run Model from the toolbar or from the Analysis menu. This will open the Solution Progress win-
dow. This window allows you to watch the progress of the Steady-State and Transient Solvers. When 
complete, click the Graph Results button at the bottom of the Solution Progress window.
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 Step 7. Graph the Results

Figure 2 shows the speed history for the J2 Main Pump while it adjusts from 2,000 gal/min to 1,000 
gal/min.

Figure 3 shows the pressure history for the J2 Main Pump discharge. 

Figure 4 shows the head rise across the pump.

Choosing a flow path through the J7 Hex #2, a pressure profile is shown in Figure 5.

Figure 2: Pump speed transient for J2
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Figure 3: Transient pressures at pump discharge

Figure 4: Transient head rise across the pump
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Figure 5: Maximum and minimum pressure profile around loop through J22 Hex #2
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Positive Displacement Pump 

Summary

This example is designed to illustrate how to model the rapid cycling flow for a positive displacement 
pump with AFT Impulse. Models of a 3 head and 4 head positive displacement pump will be analyzed.

Topics Covered

 l Using Repeat Transient feature on a pump
 l Modeling submerged pumps
 l Using the Gas Accumulator junction

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Positive Displacement Pump.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 60 deg. F

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

Figure 1: Layout of positive displacement pump model

The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

Pipe Properties

 1. Pipes P1 & P2
 a. Pipe Material = Steel - ANSI
 b. Size = 1-1/2 inch
 c. Type = XS (schedule 80)
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 d. Friction Model Data Set = Standard
 e. Length = 5 feet
 f. Wavespeed = Calculated Wavespeed

 2. Pipes P3 - P5
 a. Pipe Material = (User Specified)
 b. Inner Diameter = 1.5 inches
 c. Wall Thickness = 0.15 inches
 d. Modulus of Elasticity = 3,000,000 psia
 e. Poisson Ratio = 0.3
 f. Length = 100 feet

 g. Wavespeed = Calculated Wavespeed
 h. Friction Model Data Set = User Specified
 i. Selection = Absolute Roughness
 j. Value = 0.002 inches

Junction Properties

 1. Pump J1
 a. Inlet Elevation = 0 feet
 b. Pump Model = Positive Displacement
 c. Parameter = Volumetric Flow Rate
 d. Flow Rate = Steady
 e. Steady Flow rate = 100 gal/min
 f. Submerged Pump = Checked

 g. Selection = Head (HGL)
 h. Liquid Surface HGL = 3 feet

 2. Branches J2 & J3
 a. Elevation = 0 feet

 3. Spray Discharges J4 - J6
 a. Elevation = 0 feet
 b. Loss Model = Cd Spray (Discharge Coefficient)
 c. Geometry = Spray Nozzle
 d. Exit Properties = Pressure
 e. Exit Pressure = 0 psig
 f. Cd (Discharge Coefficient) = 0.6

 g. Discharge Flow Area = 0.05 inches2

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 
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 Step 4. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

 Step 5. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 5 seconds for 
the Stop Time. 

All groups should now be complete and the model is ready to run. If all groups in Analysis Setup have a 
green checkmark then Click OK and proceed. Otherwise, enter the missing information.

 Step 6. Create Child Scenarios

In this model we want to evaluate four displacement pump cases: "3 Head PDP" and "4 Head PDP", 
each with and without an accumulator.

A. Create the 3 Head PDP Scenarios

Using the Scenario Manager on the Quick Access Panel, create a child scenario by either right-clicking 
on the Base Scenario and then selecting Create Child, or by first selecting the Base Scenario on the 
Scenario Manager on the Quick Access Panel and then selecting the Create Child icon.  Enter the name 
3 Head PDP. A new scenario will appear below the Base Scenario in the list. Select the 3 Head PDP 
scenario and create  2 childdren and call the first With Accumulator and the second  Without Accumulator. 
See Figure 2.

Figure 2: Scenario Manager in the Quick Access Panel with two child scenarios
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B. Set up the 3 Head PDP Scenario

In the Scenario Manager load the 3 Head PDP scenario.

ØOpen the J1 Pump junction and do the following:

 1. Flow Rate = Periodic (simple)
 2. Average Flow Rate = 100 gal/min
 3. Number of Heads = 3
 4. Operating Speed = 1490 rpm

The periodic flow rate for the duration of one period will be shown. Impulse will continuously repeat this 
flow rate cycle throughout the transient, using the average flow rate as the initial steady-state flow rate.

The window should appear as in Figure 3. Click OK to exit the window. This scenario is now completed.

Figure 3: Pump window with 3 head flow data entered

C. Commentary on modeling positive displacement pumps

For this example the pump flow vs. time data has been based on an idealized case, where the time vary-
ing flow may be represented as half sine waves for each pump cylinder (half is discharge while the other 
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half of the cycle is suction), one sine wave for each cylinder phased according to the number of cylinders 
(e.g. 120 degrees for the 3 head pump, 90 degrees for the 4 head pump). This can be viewed by opening 
the pump junctions, to see the graph on the Pump Model tab. 

Initial, steady-state flow rate is typically specified based on the nominal flow rate of the pump. Often, one 
may see a difference between this flow rate and the flow rate as displayed in Graph Results. This dif-
ference will typically derive from two sources; 1) differences between a manufacturer's time vs. flow 
curves and the nominal pump rating and, 2) differences resulting from stepwise integration of the time 
varying flow. In the case of calculating time varying flow based on an idealized sine wave, the latter will 
occur because the calculated data points are based on a different stepwise integration basis than per-
formed by AFT Impulse during the analysis. A similar result occurs based on the number of data points 
taken from a published curve. An example of this difference can be seen in the 3 Head PDP with Accu-
mulator scenario by graphing flow in the pipe after the accumulator (P2). Initial flow begins at the spe-
cified steady-state value of 100 gal/min, but decreases over time to a steady-state value slightly less than 
this (~1 gal/min). It takes a few seconds in this example for the flow to stabilize since the initial accu-
mulator pressure has been calculated based on the initial flow specified for the pump. As the integrated 
time varying flow is slightly different, system resistance is different than the initial conditions and the accu-
mulator must come to a different pressure to balance this resistance. A change in accumulator pressure 
is coupled with a net outflow or inflow of liquid in the accumulator, which takes time.

Finally, this example deals only with modeling discharge piping, but what about suction piping? In this 
example we didn't need to model suction piping to the pump since we selected the optional, 'Submerged 
Pump' modeling. We could have modeled suction piping supplying the pump and it would be subjected to 
the same time varying flow variation as the discharge. Modeling the system this way will result in the suc-
tion and discharge flows being in phase, whereas in the actual system suction and discharge flows are 
out of phase. In most situations this difference is not significant since the suction and discharge sides of 
the system are hydraulically isolated from each other by the pump itself. In other words, one can consider 
the suction and discharge sides of the piping system as two, distinct systems. In those cases where it is 
desired to model the out of phase relationship of the suction and discharge flows, the pump can be split 
in two, so to speak, a suction and discharge half. This example already includes the discharge half so 
that the suction half could be modeled as an assigned flow junction along with the suction piping. Time 
varying flow can be specified for an assigned flow junction in the same way as the pump in this example. 
One would modify the time vs. flow data to reflect the out of phase nature of the suction flow.

D. Set up the With Accumulator Scenario

Now we want to add an accumulator junction to review the effects on pressure and transients. In the 
Scenario Manager load the With Accumulator scenario

 1. Morph the J2 Branch into a Gas Accumulator. 
 a. Hold down the CTRL key on the keyboard. 
 b. While continuing to hold down the key, drag a gas accumulator junction from the Toolbox 

and drop it on the J2 Branch. 
 c. Let go of the CTRL key. The gas accumulator junction should take on the number J7. See 

Figure 4.
 2. Double-click the J7 Gas Accumulator to open the properties window.
 3. Polytropic Constant in Transient = 1.2
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 4. Initial Gas Volume = Known Volume
 5. Value = 0.2 feet3

This scenario is now completed.

Figure 4: Scenario with 3 head pump and gas accumulator junction

E. Set up the 4 Head PDP scenario

From this point we can create the 4 head scenario by cloning the 3 Head PDP scenario. 

 1. In the Scenario Manager select the 3 Head PDP scenario
 2. Right click the scenario name and select the Clone With Children menu item
 3. Name the scenario 4 Head PDP. This scenario should have the same children as the 3 Head PDP 

scenario.
 4. Double-click the 4 Head PDP scenario to load it as the current scenario
 5. Open the Pump J1 properties window
 6. Change the Number of Heads to 4
 7. The periodic flow rate for the duration of one period will be shown. Impulse will continuously 

repeat this flow rate cycle throughout the transient, using the average flow rate as the initial steady 
state flow rate.

 8. Click OK.

This scenarios are now completed. 
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 Step 7. Run the Model

Using the Scenario Manager, load the with and without accumulator scenarios and run them. This can 
also be accomplished by performing a batch run from the File menu.

 Step 8. Graph the Results

Graphs of the pressure and flow transients can be created for each scenario. The pump discharge pres-
sures are shown in Figure 5 and Figure 6. The pressures at the J2 Branch & J7 Accumulator are shown 
in Figure 7 and Figure 8. The flows after the J2 Branch & J7 Accumulator are shown in Figure 9 and Fig-
ure 10.

Figure 5: Pump discharge pressure for 3 head case
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Figure 6: Pump discharge pressure for 4 head case

Figure 7: Pressure at J2 Branch/J7 Accumulator for 3 Head case
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Figure 8: Pressure at J2 Branch for 4 head case

Figure 9: Flow after J2 Branch/J7 Accumulator for 3 Head case



Positive Displacement Pump

- 203 -

Figure 10: Flow after J2 Branch/J7 Accumulator for 4 head case
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Pipe Forces from Valve Closure 

Summary

A gravity drain system transfers water from one tank to another through a filter and a valve in the con-
necting pipeline. It is necessary to determine the transient forces that occur when the valve is partially 
closed.

Topics Covered

 l Defining force sets
 l Graphing transient forces
 l Evaluating the effect of frictional losses on transient pipe forces
 l Using the isometric pipe drawing mode
 l Generating a CAESAR II force file

Required Knowledge

This example assumes the user has already worked through the Beginner - Valve Closure example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Impulse Quick Start 
Video (English Units) on the AFT website, as it covers the majority of the topics discussed in the Valve 
Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Pipe Forces from Valve Closure - Initial.imp

 l US - Pipe Forces from Valve Closure - Final.imp

 Step 1. Open the Model File

For this example, we will be starting from a pre-built model file which has the fluid, pipes, and junction 
properties completed to save time.

ØOpen the model file listed above.

Isometric Pipe Drawing Mode

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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The previous example models were drawn using the default Pipe Drawing Mode, 2D Freeform. However, 
AFT Impulse has two additional available drawing modes, 2D Orthogonal and Isometric. Due to the 
nature of this model the Isometric mode was used to visually interpret the pipe layout and provide a better 
understanding of the system when analyzing calculated forces.

For future reference when using this feature, the Isometric drawing mode can be turned on in the Arrange 
menu under Pipe Drawing Mode. It is not recommended to switch the Pipe Drawing Mode once a model 
has been created and saved. The isometric grid can also be turned on or off from the Arrange menu. 
When drawing segmented pipes such as P5, a red-dashed preview line will show how the pipe will be 
drawn on the isometric grid. As you are drawing a pipe, you can change the preview line by clicking any 
arrow key on your keyboard or scrolling the scroll wheel on your mouse. You can hold the ALT key while 
adjusting a pipe by the endpoint to add an additional segment. This can be used with the arrow key or 
mouse scroll wheel to change between different preview line options.

Figure 1: Layout of gravity drain system in Isometric Drawing Mode with grid shown

 Step 2. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

Note: The closer computing stations are to the desired force calculation location, the more accurate 
the force calculation will be.
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 Step 3. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 10 seconds for 
the Stop Time.

 Step 4. Define the Forces Group

ØOpen the Force Definitions panel in the Forces group and define a force set by clicking New, enter-
ing the name, the start pipe, length to start node, end pipe, and the length to end node. Repeat this pro-
cess for the second force set as shown in Figure 3.

A. Force Types

The Difference force typeforce type is intended to model the specific case where all of the following cri-
teria is true:

 1. The force is between a pair of 90 degree elbows
 2. The force is an axial pipe force
 3. All pipes, fittings, and components between the elbow pair are in-line

The force equations in the Solver are specific to this geometry. The pipes and components between the 
elbow pair can be horizontal, vertical, or sloped, but the axial component of the fluid weight is not accoun-
ted for in the forces. However, elevation and hydrostatic pressure are accounted for in the pressure and 
flow solution. Furthermore, AFT Impulse is a hydraulic solver; therefore, only hydraulic forces are cal-
culated. These are forces which act on the pipe from the fluid.

Note: Pipes are assumed to be rigid bodies and AFT Impulse does not account for the effect of pipe 
deflection on forces.

Figure 2: Schematic of the Difference force type

ForceSetTypes.html
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The Point force type would be used for calculating the force at  a Dead End junction. It is calculated using 
the difference in fluid pressure and ambient pressure, multiplied by the pipe area.

The Difference Exit force type would be used between a single 90 degree elbow and a location where the 
fluid is leaving the system, such as an exit valve, exit orifice, or nozzle.

The force sets in this example will use the Difference force type to calculate the axial forces between 90 
degree elbow pairs.

B. Defining Force Sets

Generally it is best to represent each elbow with a unique junction on the Workspace (either an Elbow or 
Branch). This example assumes that the static pressure loss in the elbows is negligible, and therefore, 
they are modeled as Branch junctions which are lossless, with exception of the last elbow in Pipe P5 
which is visually depicted with a pipe segment. Using explicit junctions on the Workspace will make the 
Force Definition simple and straightforward, and will also provide an appropriate number of sections. 
However, this can increase the runtime if the pipes between the elbows have a short length compared to 
the rest of the pipes in the model. For this reason, Force Sets can also be defined using an intermediate 
computation station inside a pipe.

The first elbow pair is represented by J2 and J4 which will demonstrate the setup when using explicit junc-
tions. The second elbow pair is represented by J4 and the segment in Pipe P5 which will demonstrate the 
setup when using an intermidiate station.

Reminder: Segments are simply a visual representation of a bend that can be added to a pipe. They 
do not represent a pressure loss or elevation change.

ØCreate a force set by clicking New. Then enter the data as shown in Figure 3. Repeat this process 
for the second force set.

 l Force Set 1:
 l Name = 480 ft to 520 ft
 l Force Type = Difference
 l Start Pipe = 2
 l Length To Start Node = 0 feet
 l End Pipe = 3
 l Length To End Node = 20 feet

 l Force Set 2:
 l Name = 520 ft to 1040 ft
 l Force Type = Difference
 l Start Pipe = 4
 l Length To Start Node = 0 feet
 l End Pipe = 5
 l Length To End Node = 40 feet
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Figure 3: Completed Force Definitions panel

Note: Force sets can also be defined from the Workspace by right-clicking on the starting pipe(s) to 
automatically create a difference force set from the start node to the end node of that pipe. The 
force set can then be edited from the Force Definitions panel.

The first force set spans between the first and last computation stations that are between the J2-J4 elbow 
pair. The start corresponds to the Pipe P2 inlet, therefore, the Start Pipe is P2 and the Length to Start 
Node is 0 feet. The end corresponds to the Pipe P3 outlet, therefore, the End Pipe is P3 and the Length 
to End Node is 20 feet.

The second force set starts at J4 but ends in the middle of Pipe P5. The start corresponds to the Pipe P4 
inlet, therefore, the Start Pipe is P4 and the Length to Start Node is 0 feet. The end corresponds to the 
middle of Pipe P5 (which is 80 feet in total length), therefore, the End Pipe is P5 and the Length to End 
Node is 40 feet.

Sectioning has produced one section each in Pipes P2 and P3 for the 480 ft to 520 ft force set and then 
24 sections and 4 sections in Pipes P4 and P5, respectively, for the 520 ft to 1040 ft force set. Section 
length is 20 feet for each pipe.

In this example, the sectioning conveniently results in computing stations at the locations where we want 
to calculate forces. Where computing stations do not coincide with the desired force calculation loc-
ations, some loss in accuracy will occur. By increasing the number of sections in the controlling pipe dur-
ing sectioning, a greater number of computing stations will exist, thus reducing the distance to the 
desired force calculation locations, at the expense of longer run time.

Note: AFT Impulse will set Pipe Station Output automatically to include only those stations required by 
the force set nodes up to five stations, or all stations if more than five stations are required.

An Impulse model does not contain directional data with regard to the forces, it knows only pipe length 
and elevation. Since forces are vectors with both magnitude and direction, the user must identify the dir-
ection of the calculated forces using data in the pipe arrangement drawing that defines the geometry of 
the pipe routing. This directional information can then be entered using the Force Unit Vector columns. 
The force unit vectors will not impact Impulse's calculations, but may be useful if it is desired to export the 
Impulse force output to a pipe stress software as is discussed later.

ØClick OK to close Analysis Setup.
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 Step 5. Run the Model

Click Run Model from the Common Toolbar or from the Analysis menu. This will open the Solution Pro-
gress window. This window allows you to watch the progress of the Steady-State and Transient Solvers. 
When complete, click the Graph Results button at the bottom of the Solution Progress window.

 Step 6. Graph the Results

ØOn the Quick Access Panel, in the Parameters section, select the Forces tab. The force sets 
defined on the Force Definitions panel will appear as available forces to graph.

Check the box next to the 480 ft to 520 ft force set. This corresponds to the elevation change between the 
branch junctions of 40 feet and 0 feet specified from pipes P2 and P3. Click Generate and the following 
Force vs Time graph is displayed (Figure 4).

Figure 4: Transient force vs. time for force set 480 ft to 520 ft

Note that at time zero, which represents the initial, steady-state results, there is no force. This is the 
expected result for a system at steady-state.

Some traditional methods of analyzing force sets will not have this same result, since they do not include 
the effects of friction or momentum in their force balances. If the graph from Figure 4 were created with 
friction and momentum ignored, then the steady-state value would be calculated as approximately -2700 
lbf. Due to this effect, Impulse will always include both friction and momentum when calculating and 
graphing force sets.

Now create the same graph but for the 520 ft to 1040 ft force set. The resulting Force vs Time graph is 
shown in Figure 5.
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Figure 5: Transient force vs. time for force set 520 ft to 1040 ft

Again we see that with friction included there is no force under steady-state conditions (time zero). If fric-
tion were not included, then a steady-state force of approximately -1270 lbf would have been observed.

Note: An AFT Impulse model does not contain directional data with regard to the forces, it knows only 
pipe length and elevation. Since forces are vectors with both magnitude and direction, the user 
must identify the direction of the calculated forces using data in the pipe arrangement drawing 
that defines the geometry of the pipe routing.

In summary, there are several important points to be observed:

 1. AFT Impulse calculates transient, or time-varying hydraulic forces. This does not include constant 
loads from fluid, piping, and component weight. A comprehensive analysis of pipe loading must 
separately include these items.

 2. The Difference force type calculates the axial pipe force between a pair of 90 degree elbows.
 3. In some cases, ignoring friction and momentum force balance components will result in forces that 

do not exist in reality, since the frictional forces on the pipe exactly counterbalance the force cal-
culated from the pressure differential at the selected locations.

 Step 7. Export CAESAR II Force File

ØGo to the Output window, click on the File menu and select Export Force File and choose 
CAESAR II Force File, which will open the Export Force File window shown in Figure 6.

The force sets to include in the force file may be individually selected, and all or only intermediate data 
points may be included in the force file. For the force sets and options selected the number of data points 
that will be in the file is displayed. This number should not exceed the maximum number of data points 
allowed in CAESAR II.
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In addition, if unit vector information has been entered for the force sets in the Force Definitions panel, 
the Export Unit Vector option can be used to include this information in the exported file.

Figure 6: Export CAESAR II Force File window

Final Note on Transient Cavitation

If transient cavitation occurs, the warning shown in Figure 7 will be displayed in the Output window:

Figure 7: Force calculation cavitation warning

Calculating time varying forces requires a greater level of accuracy in the magnitude and location of pres-
sures, velocity, and frictional losses than may be determined with transient cavitation modeling. Accord-
ingly, pipe force calculations will have a usually indeterminable reduction in accuracy when cavitation 
occurs.
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Module Walk-Through Examples 
The examples in the AFT Impulse Module Walk-Through are designed to get new users trained to use 
the AFT Impulse modules correctly in the shortest amount of time.

If this is your first time using AFT Impulse, please start with the Walk-Through Examples to learn how to 
create and run AFT Impulse models. Start with the Beginner - Valve Closure model, because it provides 
the most complete, basic description on how to set up and run an AFT Impulse model. After this example, 
it is recommended that you work through the remaining Walk-Through examples.

Example Fluid Pipes Pumps Description

Pipe Sizing for 
Sand Transfer 
System - SSL

Water Slurry 8 1 Determines if the pipe size and velo-
city ratio for the system is adequate 
to prevent sand from settling out of 
the slurry and plugging the pipeline.

Positive Dis-
placement 
Pulsation 

Study - PFA

User Spe-
cified

9 - Determines the excitation fre-
quencies of the system and creates 

child scenarios for pump speeds that 
cause the system to resonate at 

these frequencies.

Pipe Sizing for Sand Transfer - SSL 

Summary

Sand is being transferred from a quarry sand pit and being transferred to receiving deposits in two dif-
ferent locations. There are two valves that control the flow to each of these deposits by changing their 
opening position (modeled as Cv). The ratio of the mixture velocity to the velocity at which the sand will 
settle out of the liquid and form a stationary bed on the bottom of the pipe (Vsm) must be kept above 1.2 
to avoid potentially plugging the pipe. Determine if the pipe size and velocity ratio is acceptable during 
the transient where one valve starts to close while the other opens further.

Note: This example can only be run if you have a license of the SSL module.

Topics Covered

 l Entering solids data
 l Reviewing calculated slurry output
 l Using Design Alerts

Required Knowledge



Module Walk-Through Examples

- 213 -

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Valve Closure example. You can also watch 
the AFT Impulse Quick Start Video (English Units) on the AFT website, as it covers the majority of the top-
ics discussed in the Valve Closure example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Pipe Sizing for Sand Transfer - SSL.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Modules Group

First the SSL Add-on Module needs to be activated for use in the model. To do this, open Analysis Setup 
from the Common Toolbar or Analysis menu. On the Modules panel, check the box next to Activate SSL. 
After the SSL module is activated,  the Settling option should being selected by default.

 Step 3. Define the Fluid Properties Group

 1. Carrier Fluid panel (Figure 1)
 a. Carrier Fluid = Basic (Water)
 b. Temperature = 70 deg. F

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
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Figure 1: Carrier Fluid panel

 2. Slurry Definition panel (Figure 2)
 a. Slurry Model = Settling Slurry - Wilson, Addie, Clift
 b. Slurry Calculation Method = Detailed
 c. Concentration Type = Volume Fraction
 d. Amount Solids Added = 20 Percent

Figure 2: Slurry Definition panel
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 3. Solids Definition panel (Figure 3)
 a. Solids Specifications = User Specified Solids Added
 b. M (Stratification Ratio Exponent) = Calculated
 c. Terminal Velocity Parameter, Vt / Vts (Xi) = 0.55
 d. Density = 2.65 S.G. water
 e. d50 = 0.0275 inches
 f. d85 = 0.04 inches

 g. Bulk Modulus = 2,320,000 psia

Figure 3: Solids Definition panel

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.
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Figure 4: Layout of pipe system for Sand Transfer to Two Locations example

Once the system is in place, enter the input data for the pipes and junctions. Double-click each pipe and 
junction and enter the following data in the properties window.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Size = 10 inch
 c. Type = STD (schedule 40)
 d. Friction Model Data Set = Standard
 e. Length = Use table below
 f. Wavespeed = Calculated Wavespeed

Pipe Length (feet)

1 10

2 400

3 5

4 85

5 400
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Pipe Length (feet)

13 5

14 100

15 700

Junction Properties

 1. Reservoir J1
 a. Name = Sand Pit
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 0 feet
 d. Liquid Surface Pressure = 0 psig
 e. Pipe Depth = 0 feet

 2. Pump J2
 a. Name = Main Slurry Pump
 b. Inlet Elevation = 4 feet
 c. Pump Model = Centrifugal (Rotodynamic)
 d. Performance Curve Used in Simulation = Standard Pump Curve
 e. Enter Curve Data =

Volumetric Head Power

gal/min feet hp

0 500 1025

4000 475 1100

7000 400 1200

9000 300 1350

 f. Curve Fit Order = 2
 g. Click Generate Curve Fit Now, then click OK

 3. Branch J3
 a. Elevation = 4 feet

 4. Valve J4
 a. Name = Valve to Deposit #1
 b. Inlet Elevation = 4 feet
 c. Loss Model tab

 i. Loss Source = User Specified
 ii. Loss Model = Cv
 iii. Cv = 500

 d. Transient tab
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 i. Transient Special Condition = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values

Time (seconds) Cv

0 500

1 500

6 300

10 300

 5. Branch J5
 a. Elevation = 20 feet

 6. Reservoir J6
 a. Name = Deposit #1
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 20 feet
 d. Liquid Surface pressure = 0 psig
 e. Pipe Depth = 0 feet

 7. Valve J7
 a. Name = Valve to Deposit #2
 b. Inlet Elevation = 4 feet
 c. Loss Model tab

 i. Loss Source = User Specified
 ii. Loss Model = Cv
 iii. Cv = 400

 d. Transient tab
 i. Transient Special Condition = None
 ii. Initiation of Transient = Time
 iii. Transient Data = Absolute Values

Time (seconds) Cv

0 400

5 500

10 500

 8. Branch J8
 a. Elevation = 30 feet

 9. Reservoir J9
 a. Name = Deposit #2
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 30 feet



Module Walk-Through Examples

- 219 -

 d. Liquid Surface pressure = 0 psig
 e. Pipe Depth = 0 feet

Design Alerts

In this system the Velocity Ratio (mixture to settling velocity ratio or Vm/Vsm) must remain greater than 
1.2 in each of the pipes to avoid the potential of the sand falling out of the slurry and plugging the pipe. 
Use the Design Alert Manager to add a Design Alert to each pipe. This will give a warning message in the 
output if the velocity ratio is below the minimum value.

ØFrom the Tools menu, select Design Alerts to open the Design Alert Manager. Click the green 
plus icon to create a new Design Alert.

 1. Name = Min Velocity Ratio (Vm/Vsm)
 2. Alert Applies To = Pipes
 3. Parameter Type = Velocity Ratio (Vm/Vsm)
 4. Alert When Values Is = Less Than or Equal To (<=)
 5. Value = 1.2
 6. Click the All button under the Pipes in Design Alert list
 7. The Design Alert Manager window should now appear as shown in Figure 5
 8. Click OK to return to the Workspace

Figure 5: Creating a minimum velocity ratio Design Alert
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Open the Pipe Properties window of any pipe and click the Design Alerts tab. Check to confirm that the 
Design Alert you created has been applied (Figure 6).

Figure 6: Design Alerts tab of the Pipe Properties window

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 5. Define the Pipe Sectioning and Output Group

ØOpen Analysis Setup and open the Sectioning panel. When the panel is first opened it will auto-
matically search for the best option for one to five sections in the controlling pipe. The results will be dis-
played in the table at the top. Select the row to use one section in the controlling pipe. 

 Step 6. Define the Transient Control Group

ØOpen the Simulation Mode/Duration panel in the Transient Control group. Enter 10 seconds for 
the Stop Time. 

All groups should now be complete and the model is ready to run. If all groups in Analysis Setup have a 
green checkmark then Click OK and proceed. Otherwise, enter the missing information.
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 Step 7. Run the Model

Click Run Model from the toolbar or from the Analysis menu. This will open the Solution Progress win-
dow. This window allows you to watch the progress of the Steady-State and Transient Solvers. When 
complete, click the Output button at the bottom of the Solution Progress window.

 Step 8. Examine the Output

In the Output window, there is a warning that the Design Alert was violated for Pipe P4. The minimum 
value for the run was 1.135 at Station 17 at 9.998 seconds as shown in the Transient Max/Min table.

Figure 7: Design Alert violation in pipe P4 station 17

There are several factors that may be contributing to this. Pipe P4 is sloped upward which increases the 
settling velocity and decreases the velocity ratio of concern. Also, all pipes in the model have a 10 inch 
diameter. However, the main pipes P1 and P2 are carrying much more flow than the others so the pres-
sure drop in these is greater. This could be reduced by increasing the size. The size cannot be increased 
too much because this would reduce the velocity ratio below the 1.2 minimum.

 Step 9. Increase the Pipe Diameter and Re-run the Model

Return to the Workspace and change pipes P1 and P2 to 14-inch diameter. Since the size of the pipes 
were changed they need to be re-sectioned by opening the Pipe Sectioning and Output group in Analysis 
Setup. Click OK to accept the results.

Re-run the model and view the output. There should not be any warnings now that the pipes were 
changed. The Graph Results window will be more useful in understanding the results.
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 Step 10. Graph the Results

 1. Change to the Graph Results window by either clicking on the Graph Results tab, from the Win-
dow menu,  or by pressing CTRL+G.

 2. On the Profile tab in the Quick Access Panel, select Pipes P1 through P5 (Figure 8). These rep-
resent the flow path to Deposit #1.

 3. Choose Velocity Ratio (Vm/Vsm) for the Parameter to graph.
 4. Check the boxes for Mx, Mn, and DA in order to display the maximum, minimum, and Design 

Alert.
 5. Click Generate.

Figure 8: Data selection to view the velocity ratio along the flow path to Deposit #1

The resulting graph is shown in Figure 9. This represents the flow path that had the velocity ratio Design 
Alert warning when 10-inch pipe was used. Now with 14-inch pipe the minimum is above the 1.2 limit 
along the entire path.
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Figure 9: Velocity ratio in the flow path to Deposit #1 is above the minimum Design Alert of 1.2 at all locations

In the Graph Parameters section on the Quick Access Panel change the parameter to Pressure Static 
and the units to psig. Click show to view the new graph (Figure 10).

You can also check the same parameters for the flow path leading to Deposit #2.

Figure 10: Static pressure along the flow path to Deposit #1

A time comparison of the velocity ratio in the critical pipes along the two flow paths is important to con-
sider.



Module Walk-Through Examples

- 224 -

 1. On the Transient Pipe tab, select Pipes P4 Inlet and P7 Inlet and add them to the Graph These 
Pipes/Stations list (Figure 11). These are the two sloped pipes which have the lowest velocity 
ratio. 

 2. Choose Velocity Ratio (Vm/Vsm) as the Parameter to graph.
 3. Check the DA box to display Design Alerts on the graph.
 4. Click Generate.

The resulting graph is shown in Figure 12. This shows that as the valve J4 closes and valve J7 opens the 
velocity ratios in the pipe immediately downstream change but stay in the acceptable range.

Figure 11: Data selection to view the velocity ratio over time
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Figure 12: The velocity ratio in the sloped pipes as the valves change position

SSL Analysis Summary

A slurry of sand and water flowing to two deposits was modeled. The velocity ratio (Vm/Vsm) was 
examined to ensure a minimum value was maintained throughout the transient to avoid the danger of the 
sand settling out of the slurry and plugging the pipe. The analysis showed that the initial pipe diameter 
selected was not adequate and the created Design Alert was violated. A larger size was selected to meet 
the system requirements over the simulation time.
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Positive Displacement Pulsation Study - PFA 

Summary

A system with positive displacement pumps has a known pulsation issue in a section of piping with a 
closed valve. This issue is caused by the system’s natural frequency matching up with certain PD pump 
frequencies, resulting in severe pressure oscillations at the closed valve. Use AFT Impulse and the PFA 
(Pulsation Frequency Analysis) module to discover the problematic pump frequencies and what the pres-
sure response at the closed valve is at these specific pump frequencies.

Note: This example can only be run if you have a license of the PFA module

Topics Covered

 l Ringing systems to find natural acoustic frequencies
 l Finding system excitation frequencies
 l Determining 'worst case' PD pump speeds at excitation frequencies
 l Calculating pressure response of system at above PD speeds

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Valve Closure example. You can also watch 
the AFT Impulse Quick Start Video (English Units) on the AFT website, as it covers the majority of the top-
ics discussed in the Valve Closure example.

This example is based on the paper by James M. Blanding and Trey Walters.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Impulse 
installation:

 l US - Positive Displacement Pulsation Study - PFA.imp

 Step 1. Start AFT Impulse

From the Start Menu choose the AFT Impulse 10 folder and select AFT Impulse 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Impulse settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/learning-center/video-tutorials/video/aft-impulse-7-quick-start-tutorial
http://www.aft.com/documents/TechnicalPapers/2016/TPS2016-PulsationAnalysis.pdf
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 Step 2. Define the Modules Panel

First the PFA add-on modules needs to be activated for use in the model. To do this, open Analysis 
Setup from the toolbar or Analysis menu. On the Modules panel, check the box next to Activate PFA. 
After the PFA module is activated,  the Use option should being selected by default.

 Step 3. Define the Fluid Properties Group

Open the Fluid panel then define the fluid:

 1. Fluid Library = User Specified Fluid
 2. Name = PFA Fluid
 3. Density = 57.3 lbm/ft3 
 4. Dynamic Viscosity = 2.3 lbm/hr-ft
 5. Bulk Modulus = 140,000 psia

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model as shown in the figure 
below.

Figure 1: Layout of PD Plunger Pulsation Study example
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The system is in place but now we need to enter the input data for the pipes and junctions. Double-click 
each pipe and junction and enter the following data in the properties window. 

Pipe Properties

 1. Pipe Material = (User Specified)
 2. Inner Diameter = Use table below
 3. Length = Use table below
 4. Wavespeed = User Specified Wavespeed

 a. Wavespeed = 3000 feet/sec
 5. Friction Model Data Set = User Specified
 6. Selection = Absolute Roughness
 7. Value = 0.0006 inches

Pipe
Inner Dia-

meter 
(inches)

Length (feet)

1 12 3

2 12 3

3 2.157 39

4 2.157 57

5 3.26 33

6 1.682 21

7 3.26 48

8 1.682 3

9 3.26 30

Junction Properties

Note: For the sake of simplicity, assigned flow junctions J1 and J2 are being used to represent the PD 
pumps. The Pulsation Setup window will be used later to place the necessary transient data in 
the assigned flow junction for the pump being analyzed.

 1. Assigned Flows J1 & J2
 a. Elevation = 0 feet
 b. Volumetric Flow Rate = 35.5 gal/min

 2. Area Changes J3 & J4
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 a. Inlet Elevation = 0 feet
 b. Type = Abrupt Transition (Cylindrical)

 3. Tee/Wye J5 & J6
 a. Elevation = 0 feet
 b. Loss Model = Simple (no loss)

 4. Dead End J7
 a. Elevation = 0 feet

 5. Area Changes J8 & J9
 a. Inlet Elevation = 0 feet
 b. Type = Conical Transition
 c. Angle (μ) = 90 degrees

 6. Spray Nozzle J10
 a. Elevation = 0 feet
 b. Loss Model = Cd Spray (Discharge Coefficient)
 c. Geometry = Spray Nozzle
 d. Exit Properties = Pressure
 e. Exit Pressure = 0 psig
 f. Cd (Discharge Coefficient) = 1

 g. Discharge Flow Area = 0.02313 inches2

ØTurn on the Show Object Status from the View menu to verify if all data is entered. If there are 
objects that are not defined, the uncompleted pipes or junctions will have their number shown in red on 
the workspace. If this happens, go back to the uncompleted pipes or junctions and enter the missing 
data. If all objects are defined, the Pipes and Junctions group in Analysis Setup will have a check mark. 

 Step 5. Define the Pulsation Setup Group

Defining the initial pulse or ring is an important step in determining the natural frequencies that different 
stations in the model will respond to. This is the numerical equivalent of hitting the system with a hammer 
to see how it responds at different frequencies. This first step does not represent a realistic operating con-
dition, but rather reveals what frequencies of real world operation may present operational problems.

Open Analysis Setup to see the Pulsation Setup group below the Transient Control group. Use the Pulsa-
tion Setup group to specify input regarding the initial pulse and other information about the pulsation 
source. There are two panels in the Pulsation Setup group: the Pulse Setup and PD Pump Settings pan-
els. The PD Pump Settings panel only requires input if the source of pulsation is a positive displacement 
pump. Because the source of pulsation in our model is a positive displacement pump, we will need to 
complete the input on both of these tabs. Enter the data below to define the Pulse Setup panel.

 1. Applied At = J2 (Assigned Flow)
 2. Start Time = 0 seconds
 3. Magnitude = Automatic (Twice Steady-State Flow)
 4. Peak = 71.00 gal/min
 5. Cutoff Frequency = PD Pump Characteristics
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 6. Filter Type = Chebyshev
 7. Order = 10
 8. Ripples Allowed = 1 dB
 9. Pulsation Source = Positive Displacement (PD) Pump

 10. Number of Heads = 3
 11. Pump Speed = 250 RPM
 12. Speed Buffer = 15 Percent (%)

Figure 2: Pulsation Setup window with Input

Now that all required input has been entered in the Pulse Setup panel, enter the following information on 
the PD Pump Settings panel (see Figure 3).

 1. Minimum Pump Speed = 125 RPM
 2. Bore Diameter = 3 inches
 3. Stroke = 2.04 inches
 4. Rod Length = 10 inches
 5. Clearance = 70 Percent (%)
 6. Suction Pressure = 50 psig
 7. Discharge Pressure = 6000 psig
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Figure 3: PD Pump Settings tab with Input

 Step 6. Define the Pipe Sectioning and Output Group

Open the Sectioning panel in Analysis Setup. While using the AFT Impulse PFA module, the pulsation 
setup needs to be completed prior to sectioning the pipes in the model. To section the model’s pipes for 
the simulation, complete the following:

 1. Select the significant pipes that should consider wavespeed variance. In this example we will con-
sider the variance in all modeled pipes, except for Pipe P8. You can see that this pipe has been 
excluded in Figure 4. Pipe P8 is excluded because it represents a flow meter and not an actual 
pipe. Units such as flow meters and dampeners may be better modeled with a pipe than with a 
junction if they have significant length and associated acoustic interaction aspects in the physical 
system. Ensure that the box next to each pipe is selected under Consider Variances, except for 
Pipe P8.

 2. Click Update Results and select one section in the controlling pipe by clicking on one section in 
the table under Search Results. This window is displayed in Figure 4.

 3. Select Show Pulsation Graphs located at the bottom left of the Sectioning panel. A graph of the 
pulse will appear (see Figure 5). You can also view graphs for the FFT of the Pulse, the LPF of the 
Pulse FFT, and the FFT of the LPF in the Graph Parameter graph that appears. The LPF of Pulse 
is shown in Figure 6. After you are done viewing these graphs, click Close to return to the Section 
Pipes window.

 4. Click OK to save and close Analysis Setup.
 5. Click OK for the pop-up window notifying you that the forcing function has been placed on J2 (the 

junction that was selected in the Pulsation Setup window) as transient data.
 6. Open J2 to verify that the numerical ring has been applied to the transient (see Figure 7 for the 

transient input). This transient is a brief jump in flow rate at junction J2.
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Figure 4: Section Pipes window
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Figure 5: Graph of Pulse in this example
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Figure 6: Graph of LPF of Pulse



Positive Displacement Pulsation Study - PFA

- 235 -

Figure 7: Assigned Flow Properties with Transient from Pulsation Setup. The Show Graph button under the 
Transient Data table can be selected to view the graph of this data

 Step 7. Run the Model

Click Run Model from the toolbar or from the Analysis menu. This will open the Solution Progress win-
dow. This window allows you to watch the progress of the Steady-State and Transient Solvers. When 
complete, click the Graph Results button at the bottom of the Solution Progress window.

 Step 8. Examine the Results

 1. View the Frequency Response Function
 a. On the Graph Control tab in the Quick Access Panel, click the Frequency tab to begin gen-

erating an Acoustical Frequency Analysis graph
 b. We need to determine which frequencies excite the pump speeds within the pump speed 

range we have specified. For the purposes of this example, we will graph the Excitation 
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Frequency graph for 10 different pipe stations. Note that it is the engineer's responsibility to 
evaluate all pipe stations that could be excited by various frequencies and to perform the 
necessary analysis.

 c. On the Graph Results tab, select the Frequency tab and select the inlet and outlet stations 
for the following pipes: 1, 2, 3, 5, and 6 (see Figure 8).

Figure 8: Graph Parameters selected for Excitation Frequency Analysis graph

 d. Click Generate. The resulting graph (shown in Figure 9) represents the frequencies that 
are excited by the pulse defined in the Pulsation Setup window.
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Figure 9: Excitation Frequency Analysis graph

 e. From the graph in Figure 9, we see that there are several frequencies that produce a large 
pressure magnitude. Points on the plot with a large response magnitude are easily iden-
tified by finding local maxima on the graph. These maxima are the acoustic natural fre-
quencies that are potentially the most damaging when excited by the identified pump 
speeds.

 f. Note that the graph in Figure 9 can quickly be changed to display the magnitude on a log-
arithmic scale in order to allow for easier viewing of the magnitude behavior changes with a 
changing frequency. To view the Excitation Frequency Analysis graph with the magnitude 
displayed on a logarithmic scale, generate the frequency graph as discussed above. Right-
click on the y-axis and select the box next to Logarithmic. See Figure 10 for an image of the 
graph in Figure 9 with the amplitude changed to be displayed on a logarithmic scale.
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Figure 10: Excitation Frequency Analysis Graph with Magnitude on Logarithmic Scale

 2. Choose excitation frequencies to evaluate
 a. The identified frequencies can now be evaluated to determine pump speeds that would 

cause them to be excited, making them potentially problematic. Follow the steps below to 
select and evaluate the excitation frequencies.

 b. Left-click near the frequency of about 32.59 Hz and drag the mouse over the peak on the 
graph near this frequency. This will highlight and flag the local maximum. Figure 11 shows 
the frequency graph after the dialog flag appears.

Figure 11: Excitation Frequency Analysis with Dialog Flag
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 c. Right-click on the dialog flag that appears on the peak of this frequency as shown in Figure 
12.

Figure 12: Right Click on the Dialog flag to evaluate the frequency

 d. Select Evaluate Excitation Frequency to add this frequency to the Pump RPM Evaluation 
panel, which is labeled with Excitation Frequencies and Pump Speeds (RPM) (see Figure 
13)

Figure 13: Pump RPM Evaluation panel

 e. Repeat steps a through c for the local maxima at the frequencies of 28.85 Hz and 7.104 Hz. 
Figure 14 shows the Pump RPM Evaluation Panel with the excitation pump speeds dis-
played.
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Figure 14: Pump RPM Evaluation Panel with Excitation Frequencies and their Harmonic Multiples Displayed

 f. When choosing low or high frequencies on the graph, it is possible to select a frequency 
which is excited in the system but does not have a pump speed within the minimum and 
maximum pump speeds for the analysis. The minimum pump speed is defined directly in 
the PD Pump Settings in the Pulsation Setup window, while the maximum is calculated 
using the Pump Speed and Speed Buffer defined under Pulsation Source in Pulsation 
Setup. For example, try selecting the largest maxima, which occurs at 6.1 Hz. The mes-
sage in Figure 15 appears. 

Figure 15: Message Indicating No Excitation Pump Speeds Between the Minimum and Maximum Pump 
Speeds Exist

 3. Create child scenarios and determine the pressure response of the system at excited fre-
quencies
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 a. In the Pump RPM Evaluation panel, corresponding pump speeds can be selected for 
study. At these speeds, the pressure response is important to characterize. By default, all 
speeds in the Pump RPM Evaluation panel are pre-selected. Clicking a speed harmonic 
multiple will toggle it on or off. Speeds that are toggled off will appear with the number in 
italic font. Scenarios can then be created that will use the information from the PD Pump 
Settings to create a child Pump Speed scenario that will have the Flow vs. Time profile at 
the selected speed (RPM) that will excite the evaluated frequencies.

 b. We will create child scenarios for all pump speeds in the Pump RPM Evaluation panel. To 
do this, ensure that all pump speeds are selected (not italicized).

 c. Click Create Scenarios Based On Selected Pump Speeds…
 d. A dialog box will appear stating that the scenarios will be created based on the selected 

speeds in the Pump RPM Evaluation panel. Click Yes to continue creating the child scen-
arios.

 e. Load the  130.4 RPM (32.6 Hz) scenario.
 f. The scenario will now have different transient information in J2, modeling the pump per-

formance at 130.4 RPM. Go to the Workspace and open the Properties window for J2. On 
the Transient tab click Show Graph under the Transient Data table to verify the Pump Flow 
Forcing Function has been applied, as shown in Figure 16.

Figure 16: New Assigned Flow transient representing the PD Pump operating at 130.4 RPM

Run the 130.4 RPM (32.6 Hz) scenario to see the pressure response. Often, the most noticeable pres-
sure response will occur in stagnant branched lines. For the purposes of this example, we will evaluate 
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the pressure responses through Pipe P6. However, engineers must ensure that all pipes that could exper-
ience significant pressure responses are analyzed.

 1. To create a pressure profile graph in Pipe P6, go to the Graph Results tab and  select Profile for 
the graph type

 2. Check the box for Pipe P6
 3. Select Pressure Static for the Parameter
 4. Use psia for the units
 5. Click Generate
 6. Right-click on the y-axis and adjust the scale by unchecking the Auto Scale box, then changing 

the Minimum to 3800 and the Major Val to 200

Figure 17 shows the profile plot for Pipe P6 at a pump speed of 130.4 RPM. 

Figure 17: Max/Min Pressure Profile of Pipe P6 for 130.4 RPM

The pressure vs. time can be displayed for any pipe station. Plot the pressure vs. time for pipe P6 by fol-
lowing the directions below:

 1. In the Quick Access Panel, select Transient Pipe for the graph type
 2. Expand the pipe station menu for Pipe P6
 3. Add the outlet and inlet of Pipe P6 to the Graph These Pipes/Stations list
 4. Select Pressure Static for the Parameter
 5. Use psia for the units
 6. Set the Time Frame to User Specified with a Start Time of 0 and a Stop Time of 2 seconds
 7. Click Generate
 8. Right-click on the y-axis and uncheck the Auto Scale option. Set the Minimum to 3800, the Max-

imum to 4200, and the Major Val to 100  (see Figure 18)
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Figure 18: Pressure Oscillations at Inlet and Outlet of Pipe P6 for 130.4 RPM

After looking at these graphs, go to the Output tab, which should open to the Warnings tab. The PFA 
module will check the Peak-to-Peak pressures and compare them to the permissible values in the API-
674 standard. If the limits from the standard are violated in the model, a warning will appear. In this case, 
the the Peak-to-Peak pressures exceed the allowable limits. See Figure 19. Additionally, the vapor pres-
sure margin is checked. This is the margin between the minimum pressure and 10% over the vapor pres-
sure, per the API-674 standard. For a full summary, click on the Pulsation Summary tab, as is shown in 
Figure 20.

Figure 19: Warnings section the Output window with information about API-674 being exceeded
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Figure 20: Pulsation Summary in the Output window

For the purposes of this example, we will repeat these steps for the pump speed of 217.3 RPMbecause 
this pump speed causes the largest pressure oscillations. We will show these graphs here. Though not 
shown, multi-scenario graphing was used to determine the pump speed that caused the maximum oscil-
lations. When performing an analysis on your system, all pump speeds that excite the system should be 
evaluated.

Figure 21 shows the Max/Min Pressure Profile for P6 for the pump speed of 217.3 RPM. The y-axis has 
been adjusted to scale from 6000 to 7000, with a Major Val of 200.

Figure 21: Max/Min Pressure Profile of Pipe P6 for 217.3 RPM

Notice the large difference between the maximum and minimum pressures at the end of the pipe, located 
next to the Dead End junction.
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Figure 22 shows the Max/Min Pressure Profile for P6 for the pump speed of 217.3 RPM. The y-axis has 
been adjusted to scale from 6000 to 6800, with a Major Val of 100.

Figure 22: Pressure Oscillations at Inlet and Outlet of Pipe P6 for 217.3 RPM

The large pressure oscillation in Pipe P6 can be seen in Figure 22. It is important to note that the inlet of 
Pipe P6 does not exhibit as large of a response as the outlet does. This oscillation, if allowed to continue, 
can lead to mechanical and support fatigue and thus failure.

Return to the Output tab of the Graph results window for the scenario with the pump speed of 217.3 
RPM, and make note of the message in red at the bottom right of the Graph Results screen that states 
that Warnings Exist. This scenario also violates API-674 pulsation and pressure limits similar to the 130.4 
RPM scenario.

PFA Analysis Summary

AFT Impulse and the PFA (Pulsation Frequency Analysis) module were used to discover the problematic 
pump frequencies occurring in a system with a known pulsation issue. The software was used to identify 
these frequencies, and after the frequencies were identified, a corresponding pump operating speed was 
examined to find the pressure response of the system. Using graphing features, the pressure response 
was plotted and studied. The steps followed lead to the successful pulsation analysis of the system.
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